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Câteva precizări

Această carte se adresează atât copiilor, cât şi adulţilor.
Totodată, ea se adresează atât celor care nu au lucrat niciodată la
calculator, cât şi celor care sunt cât de cât familiarizaţi cu
computerul.

Reţine:

• Nu este obligatoriu să parcurgi capitolele în ordinea în
care apar ele în carte. Consultă cuprinsul, frunzăreşte cartea şi
citeşte în ce ordine doreşti.

De exemplu, poţi citi mai întâi
subcapitolele:

� Ce este calculatorul
� Din ce este alcătuit calculatorul
� Cum intră datele în calculator
� Tastatura
� Mouse-ul
� Monitorul
� Cum funcţionează calculatorul
� Tipurile de componente soft
� Ce este un fişier
� Să deschidem Word-ul
� Ce este Internetul
� Cum te conectezi la Internet

Apoi, pe măsură ce asimilezi cunoştinţe, poţi să citeşti sub-
capitolele care la început probabil ţi se par mai grele.

• Citeşte cartea stând în faţa calculatorului şi lucrând
efectiv cu acesta.

• Dacă nu te interesează pronunţia englezească a
cuvintelor, treci peste ea.

• Dacă nu înţelegi ceva, treci peste pasajul respectiv şi
mergi mai departe. Vei vedea că, lucrând, vei înţelege tot mai mult.

Succes!

7

Doi „şoricei“...
pe o perniţă (engl.

mouse-pad = perniţă
pentru mouse)



/ʌ/ – asemănător cu „a“ din limba română,
ca în cuvântul „cap“, dar mai scurt.

/ə/ – asemănător cu „ă“ din limba română, ca
în cuvântul „masă“, dar mai scurt.

/æ/ – un sunet intermediar între „a“ şi „e“ care
nu apare în limba română; se obţine
deschizând gura pentru „a“ şi pronunţând
sunetul „e“.

/ɔ/ – un sunet scurt, necunoscut în limba
română; se pronunţă cu gura deschisă şi
mai în fundul gurii, ca un sunet
intermediar între „o“ şi „a“; se obţine
deschizând gura pentru „a“ şi pronunţând
sunetul „o“.

/j/ – asemănător cu „i“ semivocalic din limba
română, cel aflat la iniţiala cuvântului
„iunie“.

/w/ – asemănător cu „u“ semivocalic din
limba română, ca „u“ din „uite“.

/ʒ/ – identic cu „j“ românesc ca în „joc“,
„ajutor“.

/dʒ/ – asemănător cu „gi“ din „gingie“ sau „ge“
din „geam“.

/tʃ/ – se aseamănă cu „ci“ sau „ce“ din „cine“,
„cinci“, „ceaţă“. Se pronunţă cu o uşoară
aspiraţie.

/ʃ/ – identic cu „ş“ din limba română.

/θ/ – se aseamănă cu un „s“ din limba
română, articulat însă cu vârful limbii
între dinţi.

/ð/ – este perechea sonoră a lui /θ/; se
aseamănă cu un „z“ din limba română,
pronunţat însă cu vârful limbii între dinţi.

/ŋ/ – poate fi considerat asemănător lui „n“
din limba română în cuvintele în care este
urmat de „c“ sau de „g“: „bancă“.

/ː/ arată că vocala după care apare se
pronunţă prelungit. Vocalele lungi se
pronunţă cu gura mai închisă dacât
vocalele scurte. /ɑː/ este „a“ lung, /əː/ este
„ă“ lung etc.

/i/ se pronunţă aproximativ ca i din cuvântul
„aspri“. /iː/ este i lung.

/ı/ şi /ʊ/ sunt respectiv un „i“ scurt şi un „u“
scurt, pronunţaţi într-un mod mult mai
relaxat decât în cazul lui „i“ sau „u“ din
limba română.

Atenţie:

/t/ şi /d/ se pronunţă sprijinind vârful limbii
de gingii, nu – ca în limba română – de
dinţi.

/r/ se pronunţă ca un „r“ în articularea căruia
vârful limbii nu atinge cerul gurii sau
gingiile (nu vibrează).

După /p/, /t/, /k/ în anumite poziţii apare o
aspiraţie uşoară, notată cu /ʰ/: cat /kʰæt/
(pisică). Aceasta nu se indică în carte.

Poţi întâlni în transcrierea fonetică uneori
formele accentuate, alteori formele
neaccentuate ale unor cuvinte precum
she /ʃiː/, /ʃi/ (ea); he /hiː/, /hi/ (el); shall /ʃæl/,
/ʃəl/ (auxiliar pentru formarea viitorului); I
am /ai æm/, /ai əm/, /aim/ (eu sunt).

/r/ mut de la sfârşitul unui cuvânt se
pronunţă dacă următorul cuvânt începe
cu vocală.
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Simbolurile Alfabetului Fonetic
Internaţional folosite în cartea de faţă

Aceste litere specializate se folosesc în carte pentru redarea pronunţiei cuvintelor
englezeşti de care ai nevoie când lucrezi la calculator. Dacă nu te interesează pronunţia
acestor cuvinte, sari peste ceea ce este cuprins între bare oblice.

Un o după o literă arată că pronunţarea acelei litere este opţională.
Exemplu: /meməori/; unii vorbitori pronunţă /meməri/, iar alţii /memri/.
Un r ne arată că unii vorbitori pronunţă sunetul r în acel loc, iar alţii îl omit.
Accentul este redat prin sublinierea vocalei accentuate. Unele cuvinte au două accente.



1. Ţi-e frică de calculator?

Ai lucrat pe un calculator PC vreodată? (PC /piː siː/ = personal
computer /pəːrsnəl kəmpjuːtər/ calculator personal.)

Dacă da, ţi-a fost teamă de el? Acum te simţi mai relaxat?
Dacă abia acum începi să lucrezi, te simţi încordat şi eziţi să

atingi tastatura sau mouse-ul?
Ei bine, nu te teme!
În primul rând, nu poţi să-l

strici, decât dacă-l loveşti cu
ciocanul, dacă torni apă peste el,
dacă îl arunci de la etaj sau ceva
asemănător. În cel mai rău caz,
poţi să ştergi o parte din infor-
maţia de pe el, dar, dacă respecţi
indicaţiile instructorului sau
dacă citeşti cu atenţie această
carte, nu vei ajunge în situaţia
asta. Chiar şi în cazul în care
pierzi informaţii din calculator,
sunt şanse să le recuperezi – iar
în ultimă instanţă vor trebui reinstalate programele.

În al doilea rând, să nu crezi că îţi va face el ţie vreun rău. Nu
te va răni şi nu te va pune în vreo situaţie dificilă, cum ar fi, într-
o situaţie de inferioritate. (Mulţi oameni se tem să nu se arate mai
puţin deştepţi decât calculatorul.) El nu este mai inteligent decât
tine. De fapt, nu este inteligent deloc. Dacă nu ar fi utilizatorul,
deci, dacă nu ai fi tu să-l foloseşti, ar sta într-un colţ ca o mobilă
inutilă şi nu tocmai arătoasă. Numai tu poţi să-i dai viaţă, stră-
lucire şi frumuseţe, numai tu îl poţi face să prelucreze inteligent
informaţiile cu care îl hrăneşti, astfel încât să te ajute în ceea ce
faci.

În al treilea rând, ai încredere în miile şi zecile de mii de oa-
meni care au lucrat zeci de ani pentru ca acest instrument să
devină „prietenul“ tău. Calculatorul pe care îl foloseşti tu este prie-
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Configuraţia minimală a unui PC
(calculator personal): unitate de bază,

monitor, tastatură, mouse



tenos cu utilizatorul său (engl. user-friendly /juːzər frendli/) pentru că
aşa a fost proiectat să fie. Cele mai multe dintre comenzile pe care
poţi să i le dai sunt uşor de localizat şi de lansat. Cu două-trei
apăsări pe butonul mouse-ului (sau folosind câteva taste), poţi să
trimiţi un document de sute de pagini la o imprimantă sau poţi să
te conectezi la Internet şi să primeşti informaţii preţioase din toate
colţurile lumii.

Deviza celor care creează programele pentru ca tu să le rulezi
pe calculatorul tău este „simplitate, simplitate, simplitate“. Se
spune că programatorii americani ţin pe birou o foaie cu literele
KISS, prescurtare de la „Keep it simple, stupid! /kiːp ıt sımpl
stjuːpıd/ – Păstrează treaba simplă, prostuţule!“

Nu uita: şi tu poţi să urmezi această regulă. În tot ce faci,
păstrează simplitatea ca regulă de bază. Fă-te uşor de înţeles şi de
calculator, şi de ceilalţi.

Ciberfobia

Când teama de calculator ia forme exagerate, ea devine un fel
de boală, numită ciberfobie (engl. cyberphobia /saıbəfəʊbiə/). În nici
un caz nu trebuie să ajungem acolo, pentru că nu avem nici un
motiv real. Poţi să lucrezi cu calculatorul, chiar dacă înţelegi
numai aproximativ ce se petrece dincolo de ecranul monitorului.

Să ne învingem teama de la început.
Să ne apropiem cu încredere de calculator.
Să nu uităm nici o clipă că el este prietenul nostru.
Calculatorul este o unealtă în slujba scopurilor şi intereselor

utilizatorului său. Aşa cum este stiloul cu care scrii.
Cunoştinţele sau descoperirile informaticii au dus la crearea

şi perfecţionarea calculatorului (computerului). Iată de ce putem
spune că, învăţând despre calculator (computer), facem primii
paşi înspre domeniul mare şi fascinant al informaticii. Dar nu e
nevoie să devii informatician pentru a lucra la calculator. Calcu-
latorul este necesar în mai toate domeniile de activitate.
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Calculator, computer sau ordinator?

Să lămurim o problemă de terminologie. În limba română,
folosim calculator, computer şi ordinator.

Calculator este format pe teren românesc, din verbul a calcu-
la plus sufixul -tor (după modelul a munci – muncitor, a căuta –
căutător). Este un termen polisemantic (adică are două sau mai
multe sensuri), deoarece el denumeşte nu numai

• aparatul zis şi PC /piː siː/– pe care îl vom studia în cartea de
faţă, ci şi:

• calculatorul de buzunar sau de birou folosit numai pentru
calcule matematice,

• o persoană specializată în calcule,
• un tabel cuprinzând rezultatele unor calcule, folosit pentru

simplificarea operaţiilor matematice.
Computer /kəmpjuːtər/ calculator este împrumutat din engleză.
Ordinator este împrumutat din franceză (fr. ordinateur). Este

mai rar întâlnit în conversaţie. (Am auzit de curând, în mod
repetat şi cuvântul ordenador, proaspăt importat din Spania.)

Considerăm că termenul cel mai răspândit la noi este cel
format pe teren românesc – calculator – şi de aceea îl folosim pe
acesta.

La ce se folosesc calculatoarele

Calculatoarele se folosesc aproape peste tot!
Cu ajutorul calculatoarelor,
• magazinele ţin socoteala produselor din stoc, emit docu-

mentele de mişcare a mărfurilor şi chitanţele produselor vândute,
confirmă valabilitatea cardurilor bancare şi realizează plata prin
card (fără folosirea sumelor în numerar), determină necesarul de
produse de achiziţionat pentru vânzare;

• băncile gestionează tranzacţiile financiare şi păstrează
legăturile interbancare şi legăturile cu clienţii;

• se coordonează zborurile avioanelor, se conduc avioanele
(chiar şi când nu sunt puse pe pilot-automat), se urmăresc tra-
seele trenurilor şi ale vapoarelor, se emit biletele de călătorie;
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• oamenii trimit nave în cosmos şi adună informaţii despre
planetele sistemului nostru solar, despre soare şi alte stele, despre
asteroizi, comete, meteoriţi;

• se realizează, se supraveghează, se întreţin şi se contro-
lează reţelele de telecomunicaţii din întreaga lume, inclusiv teleco-
municaţiile prin satelit;

• meteorologii culeg şi interpretează datele necesare pentru
realizarea buletinelor meteorologice;

• staţiile de urmărire şi cercetare a cutremurelor înregis-
trează şi interpretează date legate de mişcările seismice;

• posturile de televiziune realizează şi difuzează emisiunile
lor;

• editurile şi tipografiile prelucrează manuscrisele, inte-
grând textele şi imaginile pentru publicarea de cărţi, reviste,
pliante etc.;

• studiourile cinematografice montează şi îmbunătăţesc
(editează) filmele lor;

• contabilii şi inspectorii financiari îşi îndeplinesc munca
lor de zi cu zi, legată de controlul activităţii şi îndeplinirea obliga-
ţiilor financiare legale ale firmelor şi persoanelor fizice;

• angajaţii serviciilor de marketing ale diverselor firme fac
studii de piaţă şi păstrează nemijlocit legătura cu clienţii.

Lista de mai sus este, desigur, incompletă. Tu cu ce ai putea
s-o îmbogăţeşti?

La ce putem folosi un calculator acasă

Ce facem acasă cu calculatorul? Putem:
• să scriem scrisori, rapoarte, memorii de activitate,

curriculum vitae, povestea vieţii noastre;
• să ne conectăm la Internet pentru a obţine informaţii în

orice domeniu de activitate;
• să trimitem şi să primim mesaje prin poşta electronică, o

modalitate foarte modernă de comunicare personală;
• să dialogăm, prin text sau prin voce, cu alte persoane,

indiferent de locul unde s-ar afla ele, la preţul unei convorbiri
telefonice locale;

• să învăţăm interactiv limbi străine sau să ne pregătim
pentru diverse examene;
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• să consultăm dicţionare sau enciclopedii pregătite special
pentru folosire pe calculator;

• să jucăm nenumărate jocuri – fie local, pe calculatorul
nostru, fie prin Internet;

• să preluăm, să afişăm, să îmbunătăţim (să edităm) şi să
imprimăm fotografiile făcute cu un aparat foto digital;

• să vedem filme în format DVD /diː viː diː/;
• să realizăm propriile noastre filme, folosind un aparat de

filmat digital şi programe de prelucrare a filmelor;
• să ascultăm muzică, să compunem propriile noastre

piese, să descărcăm melodii de pe Internet;
• să supraveghem în permanenţă, chiar şi de la distanţă,

casa noastră, camera copiilor sau un laborator pe care ni l-am
amenajat acasă;

• şi multe altele.

Câte tipuri de calculatoare există

Calculatoarele sunt proiectate fie pentru a fi folosite în
organizaţii şi firme mari, fie pentru uz individual şi firme mici. Ele
sunt de variate forme, capacităţi şi mărimi.

Pentru organizaţii şi marile firme, se folosesc supercomputere,
computere mainframe, sisteme multiuser, servere etc. Acestea sunt
calculatoare voluminoase, extrem de rapide, care prelucrează can-
tităţi enorme de date ştiinţifice (de ordinul a mii de miliarde de
operaţii pe secundă). Mii sau chiar zeci de mii de oameni pot
utiliza un supercomputer sau un computer mainframe, conectân-
du-se la ele printr-un terminal (un calculator cu dotare minimală,
cu tastatură şi monitor; un cititor de carduri; un cititor de bare
etc.) Sistemele multiuser pot fi folosite de mii de persoane, iar
serverele de zeci sau sute de persoane. Preţurile acestor calcu-
latoare ultraperformante sunt pe măsură: de la 5000-150000 de
dolari pentru un server, până la aproape 100 milioane de dolari
pentru un supercomputer.

Pentru uz individual (sau pentru firmele mici), avem de ales
între staţii profesionale, calculatoare personale de birou (engl.
desktop computers /desktɔp kəmpjuːtərz/), calculatoare personale
portabile (de tip laptop /læptɔp/ calculator portabil, pe care îl poţi ţine
în poală când îl foloseşti), agende electronice etc.
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Între acestea, cele mai puternice (şi mai scumpe) sunt staţiile
profesionale. Acestea sunt instrumente de lucru extrem de
eficiente pentru ingineri, contabili, arhitecţi, artişti plastici.

Cel mai des întâlnit este calculatorul personal de birou, numit
şi PC /piː siː/. Acesta formează obiectul cărţii de faţă.

Ce îţi aduce această carte

Dacă nu ştii nimic sau dacă ştii prea puţine despre calcu-
latoare, atunci această carte este pentru tine. Citeşte-o cu încre-
dere. Lucrează în paralel pe calculator.

O să afli ce este calculatorul, cum funcţionează el şi cum îţi
poate fi de folos. Nu te teme. Calculatorul e un instrument mult
mai uşor de mânuit decât multe altele. E mai ascultător decât un
câine. Şi îţi dă multe satisfacţii la care nici nu te poţi gândi la
început.
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Calculatorul personal de birou (engl. desktop computer), numit şi PC



O să folosesc cât se poate de puţine noţiuni de strictă specia-
litate. Când le voi introduce, le voi explica pe îndelete, astfel încât
să le înţelegi foarte bine din capul locului. Dacă totuşi nu înţelegi
ceva, nu te bloca – treci mai departe. Eu voi repeta explicaţiile
importante ori de câte ori va fi necesar, iar când vei căpăta o pri-
vire de ansamblu – şi după multe ore de „butonare“ – vei înţelege
şi amănuntele mai dificile.

Vei găsi în carte informaţii despre:
• componentele vizibile ale calculatorului – hardware

/hɑːrdweər/ componentele hard;
• componentele invizibile ale calculatorului – software

/sɔftweər/ componentele soft;
• ce e şi cum funcţionează Internetul;
• ce este poşta electronică.
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Calculatorul portabil, numit şi laptop
(engl. laptop computer = calculator de ţinut în poală)



Această carte te va învăţa, pas cu pas, să foloseşti:
• sistemul de operare Windows 98 /wındəʊz naınti eıt/;
• sistemul de operare Windows XP /wındəʊz eks piː/;
• sistemul de operare Microsoft Vista /maıkrəsɔft vıstə/;
• aplicaţia (programul) de prelucrare de texte Microsoft

Word /maıkrəsɔft wəːrd/;
• aplicaţia (programul) pentru realizarea de prezentări

(necesare la ţinerea unor conferinţe, în procesul de predare-
învăţare etc.) Microsoft Power Point /maıkrəsɔft paʊər pɔınt/;

• aplicaţia de navigare pe pagini de web (zisă şi browser
/braʊzər/ explorator de pagini de web) Internet Explorer /ıntərnet
ıksplɔːrər/;

• aplicaţia pentru folosirea poştei electronice Outlook
Express /aʊtlʊk ıkspres/;

• serviciul de poştă electronică gratuit oferit de Yahoo!
/jəhuː/ şi Hotmail /hɔtmeil/;

• programul utilitar de dial-up /daıəl ʌp/ conectare la Internet
prin telefon numit Dial-Up Networking /daıəl ʌp netwəːrkıŋ/;

• programele de chat /ʧæt/ discuţii prin calculator în timp
real, folosind fie texte, fie viul grai, numite Yahoo! Messenger /jəhuː
mesnʤər/ şi Hotmail Messenger /hɔtmeil mesnʤər/.

„Butonează“!...
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2. Calculatorul – privire de ansamblu

Aşază-te la calculator

Aşază-te la calculator. Nu-ţi fie teamă. Nu muşcă. E proiectat
să fie prietenos şi ospitalier cu utilizatorul. Utilizatorul eşti tu. El
e unealta ta. O unealtă complicată, cât o uzină. E uzina ta. Gata
să execute comenzile tale. Acelea pe care le înţelege. Singur îţi va
spune ce comenzi poate executa.

Ţine spatele drept, capul sus. Sprijină braţele confortabil pe
marginea mesei (biroului, pupitrului). Ai grijă ca ecranul monito-
rului să fie la înălţimea ochilor tăi. Dacă e prea sus, ia un scaun
mai înalt. Dacă e prea jos, pune nişte cărţi sub monitor. E bine
să-ţi sprijini şi picioarele pe ceva (stinghia biroului, o pernuţă).
Fă-te cât mai comod. În faţa calculatorului trebuie să te simţi ca
la tine acasă.

Stai la o distanţă potrivită faţă de monitor. La vreo 40-50 cm.
Nu-ţi apropia ochii prea mult – devine obositor şi chiar dăunător.

Nu aduce mâncare sau băutură lângă calculator. Ţi-e foame?
Ţi-e sete? Ia o pauză, ridică-te de la masă (birou), mănâncă-ţi
sandvişul în altă cameră, pe hol, pe balcon, în curte... Dacă torni
coca-cola sau dacă laşi să cadă firimituri pe tastatură – e pri-
mejdios. Iar dacă te înveţi să mănânci lucrând la calculator, te
îngraşi în scurt timp.

Fă pauze! Nu lungi, dar dese. La fiecare 25 de minute de
lucru, ia o pauză de cinci minute. Ridică-te în picioare, întinde-te,
fă mişcări uşoare de gimnastică sau plimbă-te puţin. Odihneşte-ţi
ochii privind cerul, florile, un copac...

Aeriseşte cât mai des.
Şi fii cât poţi de calm şi relaxat. Eşti printre prieteni.
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Câteva reguli de comportare

Eşti pe cale să devii expert în calculatoare. Sigur, drumul e
lung, dar aceştia sunt primii paşi. Încă de la început aplică urmă-
toarele reguli:

• Respectă munca ta şi a celorlalţi.
• Nu folosi programe-pirat, ci cumpără-le cu forme legale de

la producători sau distribuitori.
• Nu crea şi nu răspândi viruşi informatici (programe ce

atacă componentele calculatorului).
• Nu încerca să „furi“ sau să descifrezi parolele celorlalţi.
• Nu pătrunde în calculatoarele altora, fie prin acces direct,

fie prin reţea.
• Nu căuta să-ţi demonstrezi „profesionalismul“ atacând

serverele de pe Internet.
• Foloseşte mereu un limbaj urban, civilizat, chiar în

mesajele pentru cunoscuţi.
• Nu te da drept altcineva (nu fura identitatea altora).
• Comportă-te în lumea calculatoarelor cu sinceritate,

căldură şi entuziasm.
• Fii un prieten de nădejde.
• Nu trage foloase necuvenite din munca de utilizator al

calculatorului.
• Nu face pe grozavul faţă de cei ce încă nu pot folosi calcu-

latorul.
• Fii de bună credinţă în lumea calculatoarelor.
• Nu-i dezamăgi şi nu-i trăda pe cei ce au încredere în tine.
• Ajută-i din toată inima şi cu modestie pe cei ce vor să

înveţe să lucreze la calculator.
• Împărtăşeşte tot ce ştii celor ce vor să afle informaţii

despre un program sau o procedură de lucru – fără să aştepţi ceva
în schimb.
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Ce este calculatorul

Calculatorul este un aparat care prelucrează informaţii. O
listă de instrucţiuni numită program îi spune calculatorului, clipă
de clipă, ce să facă.

Informaţiile sunt noţiuni sau idei care se pot transmite între
două persoane într-o formă pe care ambele o pot înţelege. Ştiinţa
numită informatică studiază prelucrarea şi transmiterea infor-
maţiei. Calculatoarele transpun în practică rezultatele cercetării
informatice şi ajută ele însele, ca instrumente de lucru, la dezvol-
tarea acestei ştiinţe (ca şi la dezvoltarea tuturor celorlalte ştiinţe).

E bine să facem o distincţie între date (informaţia nepre-
lucrată) şi informaţie (prelucrată). Calculatorul preia date şi oferă
informaţie sub forma de prezentare dorită de noi (utilizatorii). El
face patru operaţiuni de bază:

• preluare (de date),
• prelucrare (de date),
• prezentare (de informaţii) şi
• stocare (de date sau informaţii).
De exemplu, când scrii o compunere pe calculator, cele patru

operaţii se traduc astfel:
• apeşi pe tastele corespunzătoare literelor din care sunt

formate cuvintele pe care doreşti să le introduci în compunere =
preluare de date;

• indici cu mouse-ul (sau prin combinaţii de taste – vom
vedea mai târziu) comenzile pentru formatarea (îmbunătăţirea
aspectului) textului introdus (alegi un anumit tip de literă, sub-
liniezi nişte cuvinte, stabileşti mărimea literelor şi a marginii albe
etc.) = prelucrare de date;

• vezi textul pe ecranul monitorului sau îl imprimi cu aju-
torul imprimantei = prezentare de informaţii;

• dai un nume compunerii pentru a o transforma într-un
document (numit fişier) pe care îl înregistrezi pe discul dur sau pe
o dischetă pentru a putea folosi compunerea şi altă dată (poate
vrei să mai lucrezi asupra ei – să scoţi greşelile, să-i dai o altă
înfăţişare sau s-o îmbogăţeşti – sau pur şi simplu s-o imprimi din
nou) = stocare de informaţii.
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N. B. Discul dur şi discheta sunt medii de înregistrare de date
folosite de calculator. Discul dur are capacitate foarte mare de
stocare, în timp ce discheta, sora sa mai mică, are o capacitate
foarte mică. Având o capacitate atât de mică, te-ai putea întreba
de ce mai folosim dischetele? Le folosim pentru preluarea rapidă
de pe un calculator a unor fişiere de mărime mică sau medie şi
mutarea lor pe alt calculator.

Din ce este alcătuit calculatorul

Te afli la birou. Ai
în faţă monitorul. Între
tine şi monitor este
tastatura. La dreapta
ta, pe un suport pătrat
şi plat, din pâslă sau
din plastic, ai la înde-
mână... un fel de şori-
cel cuminte şi ascul-
tător, cu butoane şi o
codiţă lungă – mouse-
ul, cu care îi poţi
indica calculatorului
ce comandă vrei să
execute. Lângă monitor

sau pe o masă alăturată este imprimanta.
De la fiecare dintre acestea (tastatură,

mouse, monitor, imprimantă) porneşte câte
un cablu (mai gros sau mai subţire) care face
legătura cu o cutie de metal. Această cutie
are pe o latură (latura din faţă) câteva
butoane, beculeţe şi deschizături orizontale.
Pe latura opusă (latura din spate) sunt un fel
de prize cu aspecte diverse, în care intră (la

care se conectează) capetele cablurilor amintite. Cutia e aşezată
fie lângă monitor, pe masa de lucru, fie sub masă.

Dacă ne-am imagina că aceste cabluri sunt raze, cutia de care
se leagă ele ar fi soarele. După cum soarele este piesa centrală a
sistemului solar, cutia de care vorbim este piesa centrală în tot
ansamblul descris mai sus. Se şi numeşte unitate centrală – cele-
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lalte fiind numite unităţi periferice, adică de la margine. Unitatea
centrală se mai cheamă şi unitatea de bază – celelalte fiind unităţi

ajutătoare. Toate formează un
sistem, şi, pentru că unitatea de
bază este chiar unitatea care
uneşte şi controlează tot ansam-
blul, ea se mai numeşte şi
unitate de sistem.

Unitatea de bază adăpos-
teşte:

• microprocesorul – creierul
sistemului (cel care face toate
calculele necesare prelucrării
datelor),

•placa de bază (sau placa-mamă) – un fel de coloană verte-
brală; de ea se pot prinde alte plăci (numite plăci de extensie),
necesare pentru a face legătura între microprocesor şi unităţile
periferice,

precum şi alte „organe“:
• memoria primară (memoria de lucru),

• memoria secundară (discul dur pe care se stochează
programe, date şi informaţii),

• unitatea de citire/scriere a dischetelor,
• unitatea de citire(/scriere) a CD-urilor şi/sau a DVD-urilor
• etc.

Când vorbim de plăci – placa-mamă, plăci de extensie – ne
referim la nişte bucăţi din plastic sau din fibră de sticlă (ce pot
avea rame de metal) de diverse mărimi, pe care se văd imprimate
circuite electrice.
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La modelele mai vechi, microprocesorul este sudat în placa de
bază. La modelele mai noi, microprocesorul este înglobat într-o
placă mai mică, numită placă-fiică. Placa-fiică se fixează printr-un
fel de ştecăr cu multe picioruşe într-o priză din placa de bază.
Această priză se numeşte slot. Slotul pentru placa-fiică este deose-
bit de sloturile pentru memoriile primare (de lucru) şi de sloturile
pentru plăcile de extensie.

Cum intră datele în calculator

Ştim că o funcţie importantă a calculatorului este preluarea
de date (informaţii neprelucrate). Ea se mai numeşte intrare de
date sau introducere de date sau input (input /ınpʊt/ introducere/
preluare de date).

În funcţie de natura lor, datele ce urmează a fi prelucrate de
calculator se introduc cu ajutorul mai multor periferice.

Astfel, textele se introduc prin tastarea caracterelor ce le
compun pe tastatura conectată la unitatea de bază.

Muzica, vorbirea sunt preluate de un microfon conectat la
placa de extensie numită placa de sunet, montată în carcasa
unităţii de bază.

Desenele, fotografiile, paginile tipărite sau scrise de mână se
preiau cu ajutorul unui scanner (scanner /skænər/ instrument de
citit rând cu rând, de baleiat).
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Transmisiile fax sunt preluate prin modemul conectat pe de o
parte la calculator şi pe de altă parte la reţeaua telefonică.

Prin placa de reţea,
calculatorul nostru poate
prelua de pe alte calcu-
latoare, care se află în
aceeaşi reţea, date deja
prelucrate sau doar intro-
duse şi care aşteaptă să
fie prelucrate mai de-
parte.

Depinzând de felul în
care este conectat la In-
ternet, calculatorul nos-
tru poate primi informaţii
fie prin modem, fie prin
placa de reţea.

Tastatura, scannerul, microfonul sunt periferice specializate
pe input /ınpʊt/ introducere, preluare de date. Modemul şi placa de
reţea sunt periferice atât de input, cât şi de output /aʊtpʊt/ livrare
de date/ieşire de date, pentru că prin ele calculatorul nostru
poate şi să primească, dar şi să ofere, date de prelucrat sau
informaţii gata prelucrate.

Tastatura

Să privim mai îndeaproape tastatura. Tastele sunt aranjate,
în general, ca la maşina de scris. Faţă de aceasta, însă, tastatura
calculatorului dispune şi de taste suplimentare – unele pentru
introducerea cifrelor (vezi grupajul de taste din partea dreaptă),
altele (tastele funcţionale – primul rând de taste de sus) pentru
transmiterea unor comenzi. De exemplu, dacă apăsăm tasta F1,
putem obţine informaţii ajutătoare despre programul în care
lucrăm. Există 12 taste funcţionale (F1, F2, ..., F12), fiecăreia
putând să-i fie asociată o comandă.

Tastele speciale notate cu Ctrl = control /kəntrəʊl/ şi Alt se
folosesc în combinaţie cu alte taste pentru a se transmite diferite
comenzi calculatorului (când nu se foloseşte mouse-ul). Astfel, în
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cele mai multe programe, apăsând pe tasta Ctrl şi pe tasta P, se
transmite la imprimantă documentul afişat pe monitorul calcu-
latorului. Iar eu în acest moment, dacă apăs pe tasta Alt şi apoi
pe tasta A, obţin litera ă, pe care nu o am scrisă pe nicio tastă.
Alte calculatoare pot avea alte combinaţii de taste pentru trans-
miterea diferitelor comenzi sau scrierea literelor mai deosebite ale
alfabetului.

Ce se întâmplă când apăsăm pe tasta literei A? Pe ecranul
calculatorului (presupunem că ne aflăm într-un program de pro-
cesare de text) apare litera a (adică a mic de tipar). Dacă dorim să
scriem A (adică A mare de tipar), trebuie să apăsăm concomitent
pe tasta A şi pe tasta specială inscripţionată Shift /ʃıft/ schimbă/
schimbare. Dacă dorim să scriem numai cu litere mari de tipar,
atunci apăsăm o dată pe tasta inscripţionată Caps Lock /kæps lɔk/
fixează pe majuscule. Se va aprinde un LED (o luminiţă aflată în
colţul din dreapta sus a tastaturii). După aceea, orice text vom
tasta, va apărea scris pe ecran cu litere mari de tipar. Când nu
mai avem nevoie să scriem cu litere mari, apăsăm din nou pe tasta
Caps Lock /kæps lɔk/. Luminiţa se va stinge şi din nou putem scrie
cu litere mici de tipar.

O tastă lungă, ca o bară de aproximativ 10 cm, se află în
partea de jos a tastaturii. Dacă apăsăm pe ea, introducem un
spaţiu alb, adică o pauză între cuvinte.

Tastatura şi mouse-ul reprezintă minimum necesar dintre
toate perifericele de input /ınpʊt/ introducere, preluare de date
posibile.
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Mouse-ul

Şi mouse-ul merită o
descriere ceva mai amănun-
ţită, fiind un periferic im-
portant. El este folosit în
primul rând ca indicator, dar
are şi funcţie de input.

Mouse-ul este un aparat
mic, de formă ovală, care are
ca piesă de bază o bilă, pe care
noi o putem face să se rotească
prin frecare cu o suprafaţă plană (masa de lucru sau un suport
special de plastic sau de pâslă). Pe lângă bilă, mouse-ul are unul,
două sau trei butoane. Bila controlează un vârf de săgeată, numit
indicator, pe care îl vedem pe ecranul monitorului. Împingând
mouse-ul încoace şi încolo pe masa de lucru, mutăm indicatorul
dintr-un loc într-altul pe ecran, până ajunge acolo unde ne
interesează să ajungă. De obicei ne plasăm peste numele unei
comenzi. Odată ajuns indicatorul pe numele unei comenzi dintr-
un program, apăsăm pe butonul mouse-ului. (Dacă mouse-ul are
mai mult de un buton, de obicei apăsăm pe butonul din stânga.)
Atunci, mouse-ul scoate un mic chiţăit (poate de aceea i se şi
spune mouse /maʊs/ şoricel), numit clic (în engleză se numeşte
click /klık/ pocnet uşor), iar calculatorul execută comanda pe care
am indicat-o noi prin indicator. În felul acesta suntem scutiţi de
tastarea comenzilor de fiecare dată: cu un simplu clic, obligăm
calculatorul să execute comenzi ce pot fi uneori foarte complicate.

Indicatorul mouse-ului este util şi pentru alte operaţiuni
necesare în relaţia noastră cu calculatorul. Ne vom referi la ele
când vom vorbi de programele în care putem lucra pe calculator.
Aş menţiona aici, însă, folosirea mouse-ului pentru trasarea unor
linii sau desene în programele de grafică. În acest caz, mouse-ul
este într-adevăr un periferic de input (şi nu doar un indicator de
comenzi; oricum, şi transmiterea unei comenzi este input).
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Perifericele de output

Am aflat cum se introduc datele (cu ajutorul tastaturii,
mouse-ului, scannerului, microfonului etc). Ele se prelucrează
spre a fi transformate în informaţii. Prelucrarea o face micro-
procesorul prin piesa sa de bază, unitatea centrală de prelucrare
(CPU /siː piː juː/ = central procesing unit /sentrəol prəʊsesıŋ juːnıt/),
ajutată de memorie, sub comanda programelor. Odată prelucrate,
ce se întâmplă cu informaţiile?

Acestea vor fi prezentate pe ecranul monitorului, imprimate la
imprimantă, redate prin difuzoare, dacă este vorba de sunete (mu-
zică sau vorbire), trimise la un fax prin intermediul modemului,
trimise spre un alt calculator prin intermediul plăcii de reţea etc.

Monitoarele, difuzoarele, imprimantele sunt periferice de
output /aʊtpʊt/ livrare de date/ieşire de date. Despre modem şi
placa de reţea am văzut că sunt periferice atât de input, cât şi de
output.

Monitorul

Monitorul seamănă cu un televizor, având un ecran şi câteva
butoane pentru reglarea strălucirii, poziţiei etc.
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Monitoarele sunt:
• cu tub catodic; acestea formează imaginea prin proiectarea

unei raze de lumină foarte subţiri pe un strat de substanţe
fotosensibile (sensibile la lumină), prezent pe spatele ecranului;

• cu cristale lichide (LCD); acestea sunt plate şi utilizează
numeroase diode din cristale lichide pentru afişarea imaginii.

Monitoarele cu cristale lichide s-au folosit iniţial la calcula-
toarele portabile, dar acum se folosesc şi ca monitoare de birou.
Sunt mult mai uşoare decât monitoarele cu tub catodic, dar sunt
şi mai scumpe. Totuşi, ele au înlocuit deja monitoarele cu tub
catodic.

Ca periferic de output, monitorul este esenţial pentru calcu-
lator. Într-o configuraţie minimală, calculatorul trebuie să fie
format din sistemul de bază, monitor, tastatură şi mouse – şi
cablurile de legătură dintre ele.

27

Monitor cu cristale lichide (monitor de laptop = calculator portabil)



Imprimanta

Imprimanta (componentă de output) este aparatul care
imprimă pe hârtie ceea ce vedem pe ecranul monitorului unui PC
/piː siː/. Dintre tipurile mai frecvente de imprimante amintim:

a. imprimantele matriceale; ele folosesc un sistem de ace
pentru a imprima literele pe hârtie; între ace şi hârtie se interpune
o panglică îmbibată cu cerneală; calitatea documentelor produse
cu imprimanta matriceală lasă de dorit, de aceea acest tip de
imprimantă se foloseşte tot mai puţin;

b. imprimantele cu jet de cerneală; acestea „aruncă“ pe hârtie
numeroase punctuleţe pentru a crea imaginea literelor sau dese-

nelor ce apar pe ecranul monitorului; imaginile pot fi imprimate în
alb-negru sau color; este tipul de imprimantă cel mai popular şi
mai des întâlnit în zilele noastre;

c. imprimantele cu laser; acestea folosesc o rază laser pentru
a crea pe un cilindru rotitor imaginea a ceea ce trebuie imprimat,
desenată ca un tipar de încărcături electrice; acestea atrag parti-
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culele de toner (un praf negru special fabricat pentru a fi folosit în
imprimantele laser) pe care apoi le transferă pe hârtie. Acolo parti-
culele se fixează printr-un proces de încălzire (hârtia cu particu-
lele de toner pe ea trece printr-un cuptor); imprimantele cu laser
pot fi alb-negru (mai ieftine) sau color (foarte scumpe);

d. imprimantele multifuncţionale sunt aparate care acţionează
nu numai ca imprimantă, ci şi ca scanner, copiator (tip xerox) şi
fax; preţul unei astfel de imprimante este ridicat, dar e mai mic
decât preţurile tuturor acestor aparate (imprimantă, scanner,
copiator, fax) la un loc.

Să deschidem unitatea de bază

Să deschidem cutia unităţii de bază. Avem grijă să scoatem
mai întâi calculatorul din priză. Chiar şi aşa, nu vom avea voie să
atingem componentele electronice cu mâna şi trebuie să fixăm la
încheietura mâinii o bandă care se continuă cu un fir metalic ce
are la capăt un cleştişor; vom prinde cleştişorul de un obiect
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metalic, pentru evitarea descărcărilor electrice ce pot pune în peri-
col circuitele. Cu o şurubelniţă mică în cruce (Phillips), desfacem
4-6 şuruburi şi apoi cu grijă scoatem unul dintre pereţii cutiei. Ce
vedem înăuntru?

Precum am amintit mai sus, unitatea componentă principală
este placa de bază (motherboard /mʌðər bɔːrd/ placa-mamă). Aceas-
ta este o bucată mare de plastic sau de fibră de sticlă pe care se
văd imprimate mii de circuite electrice. Placa de bază reprezintă
cadrul fizic şi electric pentru cele mai importante componente ale
calculatorului.

Printre aceste componente, circuitele integrate sunt funda-
mentale. Un circuit integrat, numit şi cip (chip /tʃıp/ ţandără,
aşchie; circuit integrat), face munca a mii sau milioane de tran-
zistori. Ce este tranzistorul? Tranzistorul este asemenea unui co-
mutator cu două poziţii: închis (corespunzând cifrei 0) şi deschis
(corespunzând cifrei 1). Cea mai mare parte din activitatea com-
puterului se reduce la folosirea acestor comutatoare (tranzistori)
pentru a configura şi dirija informaţia în diferite feluri, după cum
cer instrucţiunile din program.

Unele circuite integrate sunt sudate în placa de bază, iar
altele sunt înfipte printr-un număr de picioruşe în orificii practi-
cate în placa de bază. Ce sunt şi ce fac circuitele integrate? Ne
vom ocupa de cele mai importante dintre ele.

Microprocesorul, care include unitatea centrală de prelucrare,
(CPU /siː piː juː/ = central procesing unit /sentrəl prəʊsesıŋ juːnıt/) este
cel mai important circuit integrat (cip) al calculatorului. Este
supranumit „creierul calculatorului“.

Unitatea centrală de prelucrare (procesare), (CPU /siː piː juː/),
controlează toate activităţile calculatorului, efectuează toate
calculele, execută toate instrucţiunile. Părţile sale de bază sunt:

• unitatea de control;
• unitatea aritmetică şi logică (ALU /eı el ju:/ = arithmetic

and logical unit /ərıθmətık ənd lɔʤıkl ju:nıt/);
• unitatea de aducere şi decodare a instrucţiunilor (numită

uneori unitatea de intrare-ieşire).
Pe lângă acestea, CPU /siː piː juː/ dispune şi de o unitate de

memorie RAM /ræm/ = random access memory /rændəm ækses
meməori/) memorie volatilă cu acces direct/memorie de lucru.
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Cum funcţionează un CPU

Unitatea de aducere şi decodare a instrucţiunilor aduce din
memorie instrucţiunea ce urmează a fi executată şi, împreună cu
unitatea de control, o decodează – adică determină ce îi spune
programul calculatorului să facă.

Apoi, unitatea aritmetică şi logică (ALU /eı el ju:/) execută ceea
ce cere instrucţiunea şi înregistrează rezultatul în memorie (sau
într-un registru intern – o locaţie de înregistrare temporară).

Acest ciclu de patru paşi – aducerea instrucţiunii din me-
morie, decodarea ei, executarea ei şi înregistrarea rezultatului – se
numeşte ciclu de procesare. Unitatea centrală de procesare din
calculatoarele moderne poate executa milioane de cicluri de proce-
sare în fiecare secundă.

Ciclurile de procesare se execută într-un anumit ritm, impus
de un alt cip: ceasul de sistem. Acesta nu măsoară timpul real, ci
are mai degrabă rolul unei inimi – sau al unei tobe. În ritmul
impus de această „tobă“ trebuie ca CPU /siː piː juː/ să execute ciclul
de procesare.

Pentru a măsura timpul real şi a afişa cât e ceasul şi în ce zi
a calendarului ne aflăm, calculatorul dispune de alt cip: a nu se
confunda cu ceasul de sistem (cu „toba“).

Să nu uităm... memoriile!

Tot în placa de bază sunt sudate sau înfipte plăcuţele de
memorie ale calculatorului. Sunt mai multe feluri de memorie,
care se grupează în două categorii: memorie volatilă şi memorie
non-volatilă (permanentă). Memoria volatilă (care zboară!) dispare
când se întrerupe curentul electric din calculator şi datele cu-
prinse în această memorie se pierd. Memoria non-volatilă (care nu
zboară!) rămâne înscrisă în cip, chiar dacă se întrerupe curentul
electric, iar datele cuprinse în ea se pot folosi când se deschide din
nou calculatorul.

Memoria ROM /rɔm/ = read only memory /riːd əʊnli meməori/
memorie care poate fi numai citită, dar nu modificată este un tip de
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memorie non-volatilă, care cuprinde instrucţiunile de bază
necesare pentru pornirea calculatorului.

Memoria RAM /ræm/ = random access memory /rændəm ækses
meməori/ memorie cu acces direct/memorie de lucru este un tip de
memorie volatilă de care calculatorul are nevoie pentru a lansa în
execuţie programele în cadrul cărora lucrează. Memoria RAM
/ræm/ este extrem de dinamică şi fără ea CPU /siː piː juː/ nu poate
lucra.

Memoria cache /kæʃ/ este un tip de memorie şi mai rapid decât
memoria RAM /ræm/. Acest tip de memorie se poate afla chiar pe
cipul CPU /siː piː juː/, şi se numeşte cache primar, sau poate exista
ca un cip separat plasat lângă CPU /siː piː juː/, situaţie în care se
numeşte cache secundar. Memoria cache /kæʃ/ ajută CPU /siː piː juː/
să lucreze la viteze foarte mari.

Plăcile de extensie

Pe lângă aceste circuite integrate, în placa de bază sunt
practicate grupuri de orificii, dispuse în rânduri lungi, aliniate, în

care se pot înfige picioruşele mai multor plăci de extensie. Acestea
formează sloturi (sau mufe) pentru plăcile de extensie. Plăcile de
extensie sunt tot plăcuţe de plastic sau fibră de sticlă cuprinzând
circuite integrate. Ele au o latură îngustă la vedere, adică în
exteriorul cutiei sistemului de bază, care prezintă unul sau mai
multe porturi. Plăcile de extensie fac legătura între placa de bază
şi diferite unităţi periferice, ca de exemplu monitoare (dacă placa
de extensie este placă video), difuzoare sau instrumente muzicale
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digitale (dacă placa de extensie este o placă audio) etc. sau leagă
calculatorul în reţea (dacă placa de extensie este o placă de reţea).

Mai modern, chiar unitatea centrală de procesare, în loc să fie
sudată în placa de bază, este plasată într-o placă separată, nu-
mită daughterboard /dɔːtər bɔːrd/ placă-fiică. Această placă se înfige
într-un slot special practicat în placa de bază.

Ce mai ascunde cutia magică

Pe lângă placa de bază, oare ce mai găsim în cutia unităţii de
sistem a calculatorului?

• Unitatea de alimentare cu curent electric transformă
curentul de la reţea din curent alternativ în curent continuu şi
coboară tensiunea de la 220 de volţi la tensiunea joasă pe care o
poate suporta placa de bază.

• Unitatea de răcire se compune dintr-unul sau mai multe
ventilatoare ce menţin o temperatură potrivită pentru funcţio-
narea calculatorului.

• Un difuzor – nu de mare fidelitate – se mai găseşte pe placa
de bază. Pentru redarea de calitate a muzicii sunt necesare
difuzoare externe, care necesită şi introducerea unei plăci de
sunet într-un slot de extensie.

• Unul sau mai multe discuri dure sunt plasate în unitatea
de bază a calculatorului. Ce este un disc dur (numit în engleză
hard disk /hɑːrd dısk/)? Vei afla în continuare. Discul dur este
descris printre alte componente de stocare.

Componentele de stocare (înmagazinare) a
datelor

Componentele de stocare a datelor pot fi interne (situate în
carcasa unităţii de sistem) sau externe (conectate prin cablu de
unitatea de sistem). Ce sunt ele?

Atât datele pe care le prelucrează calculatorul, cât şi pro-
gramele care controlează activitatea sa se înregistrează pe suport
magnetic (exemplu – discul dur şi discheta) sau optic (CD-ROM-ul

33



şi DVD-ul) şi sunt citite (preluate) la momentul potrivit de pe
acestea.

Discul dur

Cea mai importantă componentă de stocare este discul dur
(hard disk /hɑːrd dısk/). Acesta poate fi intern sau extern.

Discul dur se prezintă ca o cutie metalică închisă etanş
(pentru evitarea contactului cu praful). În această cutie se află
două sau mai multe platane (discuri subţiri) rotunde, aşezate
distanţat pe un ax comun, în jurul căruia se rotesc cu viteză.
Pentru fiecare dintre aceste platane există câte un cap de citire/
scriere fixat pe o tijă, care se mişcă independent de platanul său,
înspre centrul sau marginea platanului. Dacă ai văzut braţul unui
pick-up în funcţiune, mişcându-se pe o placă de vinilin pentru
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redarea unui cântec, atunci
poţi să-ţi imaginezi cam
cum arată platanul cu
capul său de citire/scriere.
Braţul pick-up-ului însă se
termină cu un ac ce atinge
efectiv placa şi se lasă
condus de şanţurile ei sub
formă de spirală. Capul de
citire/scriere nu atinge
platanul, ci se află la o
depărtare foarte mică de
suprafaţa acestuia (distan-

ţa aceasta este de trei sute de ori mai mică decât grosimea unui
fir de păr din capul tău).

Platanul este acoperit cu particule foarte fine dintr-un mate-
rial sensibil la câmpul magnetic, iar capul de citire/scriere este de
fapt un electromagnet. Pentru scrierea datelor, acest electro-
magnet transformă impulsurile electrice în câmp magnetic de
diferite valori. Particulele care trec pe sub el se aranjează conform
acestor valori în diferite modele. La citire, electromagnetul re-
cunoaşte aceste modele şi reface impulsurile electrice iniţiale.

Pe discul dur se înregistrează programele ce vor fi folosite în
calculator, precum şi documentele realizate de utilizator. Este
bine ca nu mai mult de o treime din capacitatea discului dur să
fie afectată programelor, iar restul să rămână liberă pentru
înregistrarea datelor prelucrate de aceste programe.

Capacitatea de înmagazinare a discului dur se măsoară în
zilele noastre în GB (gigaocteţi): 1 GB are 1.024 megaocteţi (MB);
1 MB are 1.024 kiloocteţi (KB); 1 KB = 1024 octeţi; un octet (B) are
opt biţi (b); iar un bit este o valoare de 1 sau de 0. Desigur, cu cât
capacitatea discului dur e mai mare, cu atât mai bine.

Laptop-ul pe care scriu eu prima formă a acestei lucrări are
un disc dur de 20 GB, pe care l-am împărţit în trei secţiuni,
numite partiţii sau discuri dure virtuale (aparente). Discurile dure
se notează cu literele mari ale alfabetului, începând cu C. După
aceste litere se pun două puncte – C:. Cele trei discuri dure
virtuale ale laptop-ului meu se numesc C:, D: şi E:.

Poate că tu ai un calculator cu un disc dur mult mai încăpă-
tor (discurile dure de peste 150 de GB pentru PC-urile de birou au
devenit ceva normal) şi fără nicio partiţie, purtând eticheta C:.
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Într-un PC /piː siː/ calculator personal se pot introduce discuri
dure suplimentare, pentru sporirea capacităţii de stocare. De
asemenea, se pot conecta discuri dure externe, care se vor
comporta la fel de bine ca şi cele interne, dar ne vor ocupa câte un
port.

Discheta

Când am privit unitatea de bază, am văzut că pe partea din
faţă are o deschizătură de aproape nouă centimetri. Prin această
deschizătură se introduce discheta în unitatea de citire/scriere a
dischetei.

Ce sunt discheta şi unitatea de citire/scriere a ei?
Discheta (floppy disk /flɔpi dısk/ = floppy /flɔpi/) se aseamănă

unui platan din discul dur, fiind realizată în acelaşi fel, numai că
ea nu este închisă într-o cutie metalică, ci într-o carcasă subţire
de plastic.

Pe o parte a acestei carcase se observă două dispozitive meta-
lice. Acestea sunt folosite de unitatea de citire/scriere a dischetei.
Unul, cel din centrul dischetei, este utilizat pentru a pune în miş-
care discul magnetic subţire din interior. Celălalt, prins la margi-
nea dischetei, este un închizător care acoperă fereastra prin care
capul de citire/scriere va acţiona asupra discului.

Într-un colţ al dischetei se observă un butonaş care acoperă
o ferestruică pătrată (cu latura de câţiva milimetri). Dacă împin-
gem butonaşul în sus şi ferestruica devine vizibilă, atunci dis-
cheta este „protejată la scriere“. Asta înseamnă că nu se pot şterge
datele de pe ea şi că nu se pot scrie date noi. Discheta oferă numai
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acces la datele de pe ea (le putem copia pe discul dur şi le putem
modifica acolo). Dacă acoperim ferestruica, atunci discheta devine
disponibilă şi pentru scriere, nu numai pentru citire.

Ce capacitate are discheta? Comparativ cu discul dur, dische-
ta are o capacitate foarte scăzută: 1,44 MB (megaocteţi; un
megaoctet are 1024 de octeţi). Dacă documentul depăşeşte ca
mărime pragul de 1,44 MB, el trebuie transferat altminteri (se
poate copia pe un memory stick sau pe un disc optic, sau se poate
transmite prin reţea sau prin Internet).

Unitatea de citire/scriere a dischetei (floppy disk drive /flɔpi
dısk draıv/) acceptă discheta introdusă numai într-o anume poziţie
(şi anume cu partea fără dispozitive metalice în sus, şi cu partea
de care este prins închizătorul metalic îndreptată înspre calcu-
lator). El dispune de capul de citire/scriere şi de motoraşul care
antrenează discul magnetic din interiorul dischetei.
Calculatoarele de astăzi nici nu mai au unitate de citire/scriere a
dischetelor, acestea fiind considerate depăşite.

Unitatea de citire/scriere a dischetei este desemnată cu litera
A: (să ne amintim că primul disc dur al PC-ului este desemnat cu
litera C:; litera B: se folosea înainte şi ea pentru dischete).

Discurile optice: CD-ROM-urile şi DVD-urile

Tot medii de stocare sunt şi discurile optice – ca şi dischetele
şi discurile dure. Dar pe ele informaţia nu este înregistrată mag-
netic.

Discurile optice sunt fabri-
cate din plastic. Datele sunt in-
scripţionate pe una dintre feţe
sub forma unor adâncituri
microscopice. Pentru citirea in-
formaţiei de pe ele, se foloseşte o
rază laser. Adânciturile absorb
lumina laserului în anumite
zone, ceea ce se traduce pentru
calculator cu un semnal însem-
nând 0. Zonele plate (fără adân-
cituri) reflectă lumina, ceea ce se

traduce printr-un semnal însem-
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nând 1. Prin combinaţia celor două cifre se descifrează milioanele
de octeţi de informaţie stocaţi pe CD sau pe DVD /diː viː diː/. De
regulă, capacitatea unui CD-ROM este de 700 MB (adică ceva mai
mult de 700 milioane de octeţi). Capacitatea unui DVD-ROM este
mult mai mare: pe el se poate stoca un întreg film realizat cu
aparat de filmat digital (8 GB, adică peste 8 miliarde de octeţi).

ROM, precum am mai spus, este prescurtarea îmbinării de
cuvinte englezeşti read only memory /riːd əʊnli meməori/ memorie
care poate fi doar citită (nu şi scrisă sau modificată).

CD este prescurtarea subs-
tantivului compus englez com-
pact disc /kɔmpækt dısk/ disc
compact. Producătorii de soft-
ware /sɔftweər/ componentele soft,
de regulă, îşi vând programele pe
CD-ROM-uri, de aceea este
foarte important să avem un
cititor de CD-ROM instalat în
calculatorul nostru.

DVD /diː viː diː/ este pre-
scurtarea denumirilor englezeşti
digital video disc /dıʤıtl vıdiəʊ
dısk/ disc video digital şi digital

versatile disc /dıʤıtl vəːrsətaıl dısk/ disc digital versatil (care poate fi
folosit pentru o mulţime de scopuri). Producătorii de software
/sɔftweər/ componentele soft nu l-au adoptat încă, pentru că acest
format nu este complet standardizat. Probabil că în viitorul
apropiat, având o capacitate mai mare, DVD-ROM-urile vor
înlocui totuşi CD-ROM-urile. Ca şi dischetele, CD-urile şi DVD-
urile au nevoie de o unitate de citire.

Ce sunt discurile CD-R şi CD-RW

Există unităţi care pot nu numai să citească un CD, ci şi să
„scrie“ (adică să înregistreze informaţia) pe un disc numit CD-R (în
engleză compact disc-recordable /kɔmpækt dısk rıkɔːrdəbl/ disc com-
pact ce poate fi înregistrat) sau pe un disc CD-RW (compact disc
read-write /kɔmpækt dısk riːd raıt/ disc compact pentru scris şi citit).
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Care este diferenţa dintre un
CD-R şi un CD-RW? În timp ce
un CD-R poate fi folosit pentru a
se scrie pe el o singură dată (şi
astfel devine un CD-ROM), un
CD-RW poate fi scris, şters şi
rescris de mai multe ori.

Cum se poate scrie pe un
CD, dacă nu practicăm adân-
citurile infinitezimale de care am
amintit la CD-ROM? CD-R-urile
sunt acoperite cu o vopsea
sensibilă la căldură. Când raza
laser atinge această vopsea, ea

îşi schimbă culoarea în acel loc. La citire, lumina va fi absorbită
în loc să fie reflectată – ceea ce trimite un tip de semnal. Mai ţii
minte care? Unde vopseaua nu şi-a schimbat culoarea, primim un
alt tip de semnal. Şi uite aşa, dintr-o mulţime impresionantă de
semnale de tip 0 şi 1, calculatorul recompune informaţia stocată
pe disc.

Observă că în limba engleză traducerea discului dur este orto-
grafiată hard disk (cu -k final), iar a discului optic – optical disc
(cu -c final). De multe ori şi englezii încurcă cele două grafii, dar e
bine să respecţi regula, dacă vei folosi aceste cuvinte în scris.

Domeniu vast

Domeniul dispozitive-
lor de stocare este mult
mai larg şi se dezvoltă pe
zi ce trece. Un dispozitiv
cât o brichetă sau un
nasture de palton se
foloseşte acum conectat la
portul USB /juː es biː/
pentru a stoca până la 2
GB de date (USB storage
device /juː es biː stɔːrıʤ
dıvaıs/ dispozitiv de stocare
conectat la portul USB
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numit şi memory stick /meməori
stık/ beţigaşul de memorie). Există
instalaţii complicate pentru stoca-
rea de date identice pe discuri
diferite (pentru a nu se pierde în
cazul defectării calculatorului sau
a unei părţi din el). Stocarea se
mai poate face pe benzi magnetice.
Descrierea tuturor acestora însă
depăşeşte cadrul cărţii de faţă.

Adăugarea altor componente

Sistemul nostru (unitatea de bază plus unităţile periferice) se
poate îmbogăţi prin adăugarea altor unităţi periferice sau prin
introducerea de componente în unitatea de bază. Putem folosi:

• un scanner – pentru preluare de imagini;
• un microfon – pentru preluare de sunete;
• un aparat foto digital – pentru preluare de fotografii;
• o cameră video digitală – pentru preluare de imagini video

în timp real sau pentru realizare de filme;
• un joystick – o manşă cu care putem controla diverse

elemente de pe ecran (un fel de mouse mai sofisticat folosit pentru
jocuri electronice sau pentru proiectarea asistată de calculator);

• difuzoare – pentru redarea sunetelor;
• un plotter – pentru transpunerea unor proiecte complicate

pe hârtie sau pe calc;
• un proiector – pentru redarea filmelor (sau a unor prezen-

tări în cadrul conferinţelor) pe un ecran mare, ca în sala de
cinematograf;

• un modem – prin care folosim reţeaua telefonică pentru a
primi sau trimite faxuri sau pentru a ne conecta la Internet prin
metoda dial-up /daıəl ʌp/ conectare prin telefon;

• o placă de reţea – placă de extensie prin care ne putem
conecta la o reţea de calculatoare şi, prin această reţea, la
Internet;

• memorii suplimentare – pentru sporirea vitezei de lucru a
calculatorului;
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• discuri dure suplimentare – pentru mărirea memoriei se-
cundare, adică a capacităţii de stocare (reamintesc că discurile
dure pot fi interne – adică fixate în interiorul unităţii de bază – sau
externe – adică legate prin cablu de unitatea de bază);

• o unitate de înregistrare de date sau informaţii pe bandă
magnetică – pentru stocarea datelor;

• o unitate de stocare USB – acel dispozitiv ca un nasture
care poate fi folosit ca un disc dur, după cum am arătat mai sus;

• un dispozitiv de citire a codurilor de bare – folosit în mai
toate magazinele la casă;

• un dispozitiv de citire şi verificare a cardurilor bancare şi
de efectuare a plăţilor prin card;

• o gospodină electronică, totdeauna frumoasă, veselă şi
odihnită, care îţi prepară cele mai gustoase mâncăruri, deretică
prin casă, face cumpărăturile şi îţi spune poveşti la culcare (asta
ia-o fireşte ca pe o glumă azi; dar poate fi o realitate mâine!).

Cum funcţionează calculatorul

În primul rând, calculatorul funcţionează cu electricitate. De
la unitatea centrală porneşte un cablu electric care se termină cu
un ştecăr. Introducem ştecărul în priză şi apăsăm pe comutatorul
de pornire aflat pe latura din faţă a unităţii de bază.

Monitorul, imprimanta, scannerul, modemul şi alte compo-
nente au şi ele o legătură la o priză electrică. Monitorul poate fi
alimentat uneori prin unitatea de bază. Tastatura, mouse-ul şi
alte câteva componente nu au cablu electric; ele se alimentează
întotdeauna prin unitatea de bază.

În al doilea rând, calculatorul funcţionează pe baza unor
programe. Ce înseamnă asta? Dacă ne uităm doar la componen-
tele prezentate până acum, vedem numai o parte a calculatorului.
Adică vedem... partea ce se poate vedea. Această parte se numeşte
hardware /hɑːrdweər/ componentele hard sau partea hard /hɑːrd/
hard/tare (partea materială).

Dacă am încerca să folosim numai componentele hard, am
vedea că ele sunt inutile. Chiar alimentate cu electricitate, unita-
tea de sistem, monitorul, imprimanta, tastatura, mouse-ul nu ar
face decât să aştepte la nesfârşit, eventual clipind din unele
luminiţe şi atât.
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Partea care leagă toate componentele una de alta şi le face să
colaboreze pentru a răspunde cerinţelor utilizatorului – adică ale
tale – este partea nevăzută a calculatorului, la fel de importantă
ca şi partea văzută. Aceasta se numeşte software /sɔftweər/ compo-
nentele soft sau partea soft/moale.

Sigur că imediat te poţi gândi că şi tu ai două părţi: trupul
(partea materială, vizibilă) şi sufletul (partea spirituală, invizibilă).
Împreună, formează fiinţa ta. Dar comparaţia e dusă mult prea
departe. Calculatoarele nu au o parte spirituală. Ele nu au viaţă,
nu gândesc, nu simt, nu comunică – decât într-un sens cu totul
metaforic.

Componentele soft sunt de fapt programe scrise de un progra-
mator sau de echipe numeroase de programatori. Un program este
o listă de instrucţiuni redactată într-o formă ce poate fi tradusă în
semnale electrice, astfel încât în final aceste semnale să pună în
mişcare componentele hard.

Pentru atingerea scopului propus, programul împarte opera-
ţiile calculatorului în paşi foarte mici şi foarte simpli, care repre-
zintă de fapt operaţii matematice (adunare, scădere, înmulţire,
împărţire etc.) sau operaţii logice (comparaţii de date având ca
rezultat valorile adevărat sau fals). Calculatorul parcurge aceşti
paşi extrem de rapid şi de aceea poate veni cu soluţiile mult mai
repede decât un om, chiar de-ar fi un mare matematician. Viteza
uriaşă de calcul şi lipsa erorilor dau forţa calculatorului.

Doar două cifre: 0 şi 1

Ca să îndeplinească toate sarcinile complicate pe care i le cere
omul, calculatorul are la dispoziţie doar două cifre! Adică 0 (zero)
şi 1 (unu). Milioanele de calcule pe care le face calculatorul în mai
puţin de o clipire din ochi se realizează cu aceste două cifre.
Calculatoarele lucrează în baza de numeraţie 2.

Noi cu ce bază de numeraţie lucrăm în mod obişnuit? Câte
cifre folosim? Numără-le: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9. Sunt zece cifre.
Deci omul lucrează în activitatea zilnică cu baza de numeraţie 10.

De ce foloseşte calculatorul numai 0 şi 1? Pentru că acestea
sunt uşor de reprezentat prin prezenţa sau absenţa unei încăr-
cături electrice. În circuitul integrat (numit şi cip) care formează
piesa de bază a sistemului sunt introduse numeroase punctişoare
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cu rol de tranzistori în care poate fi captată o încărcătură elec-
trică. Fiecare punct va fi fie aprins (reprezentând cifra 1), fie stins
(reprezentând cifra 0). Prin gruparea acestor puncte se pot repre-
zenta diverse numere. Stingând sau aprinzând unul din punctele
din grup, modificăm numărul (îl facem mai mare sau mai mic).

Condus de program, calculatorul acţionează asupra acestor
tranzistori miniaturali ca asupra unor întrerupătoare, aprinzân-
du-le şi stingându-le probabil de mii de miliarde de ori, pentru a
atinge rezultatele aşteptate. Apoi, el afişează aceste rezultate sau
le stochează (înregistrează) pe discul dur.

Să ne jucăm de-a calculatorul...

Dacă vrei să ne jucăm de-a calculatorul, hai să vedem dacă şi
noi putem folosi baza de numeraţie 2.

În baza de numeraţie zece, notăm o mulţime de zece obiecte
scriind (ghici!): 10. Dacă avem o mulţime cu 11 obiecte, scriem 11,
adică o grupă de zece şi o unitate.

În baza de numeraţie doi, trebuie să formăm grupe de câte
două obiecte. O grupă de două obiecte o vom nota astfel: 10. Deci
folosim tot două cifre (unu şi zero), semnificaţia fiind însă alta;
citim: avem o grupă de două obiecte şi nicio unitate în afara
acestei grupe.

Să presupunem că dorim să reprezentăm în baza doi o
mulţime de trei obiecte. Atunci formăm o grupă de două obiecte şi
ne mai rămâne un obiect; notăm: 11, adică grupa de două obiecte
plus obiectul rămas în afara grupei.

Dar dacă avem o mulţime de patru obiecte? Atunci avem două
grupe de câte două obiecte şi niciun obiect în afara acestor grupe.
Cum am spus că notăm o grupă de două obiecte? Cu 10. Dar o
grupă de două grupe? Trebuie să trecem peste ordin şi vom scrie
100. (Tot aşa procedăm în sistemul de numeraţie zece, când avem
zece grupe de câte zece obiecte).
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...şi de-a programatorul!

Numerele exprimate în baza de numeraţie 2 ajung să fie scrise
ca şiruri lungi de cifre. Programatorii s-au îngrozit şi ei de această
invazie de 0 şi de 1. Aşa că au decis să folosească în activitatea lor
numere exprimate într-o bază de numeraţie care să aibă ceva
de-a face şi cu baza de numeraţie a calculatorului şi cu cea a
omului. E vorba de baza 16. Ce are ea comun cu baza 2? 16 este
o putere a lui 2 (16 = 2 x 2 x 2 x 2). Ce are comun cu baza 10?
Numerele se scriu cu înşiruiri de cifre cu o lungime rezonabilă, iar
numerele scrise în baza 16 sunt mai scurte decât cele scrise în
baza 10.

Dacă baza de numeraţie 2 are două cifre, iar baza de
numeraţie 10 are zece cifre, câte cifre ne trebuie pentru a folosi
baza de numeraţie 16? Desigur, 16. Acestea sunt cifrele folosite în
baza 16:

0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, A, B, C, D, E.
Numerele scrise în baza 16 se mai numesc şi numere

hexadecimale.
Tabelul de mai jos cuprinde mai multe numere exprimate în

bazele de numeraţie 10, 2 şi 16.
Ca să nu se facă o confuzie cu numerele din baza de

numeraţie 10, se foloseşte adesea notaţia hex în faţa numerelor
hexadecimale, sau se pune notaţia 0x în faţa lor: hex 1B = 0x1B
este un număr hexadecimal care în baza de numeraţie 10 se scrie
27.

Baza 10 Baza 2 Baza 16

0 0 0
1 1 1
2 10 2
3 11 3
4 100 4
5 101 5
6 110 6
7 111 7
8 1000 8
9 1001 9
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10 1010 A
11 1011 B
12 1100 C
13 1101 D
14 1110 E
15 1111 F
16 10000 10
17 10001 11
18 10010 12
19 10011 13
20 10100 14
21 10101 15
22 10110 16
23 10111 17
24 11000 18
Poţi să continui chiar tu acest tabel (pe o foaie separată de

hârtie)?

Analog şi digital

Toţi vorbim de era digitală, de aparatul de fotografiat sau de
filmat digital...

Antonimul (opusul) lui digital este analog.
Digital înseamnă numeric, adică exprimat numeric. Analog

înseamnă asemănător, similar, comparabil.
Un aparat de fotografiat clasic realizează fotografiile prin im-

presionarea filmului (care este acoperit de material fotosensibil) de
către lumina care cade pe el.

Imaginea cuprinde părţi mai luminate şi părţi mai întunecate,
cu diferite nuanţe. Trecerile de la zonele întunecate la cele lumi-
noase şi invers se fac continuu, fără salturi sau segmentări.
Informaţia adusă de lumină pe peliculă este preluată şi exprimată
în mod analog.

La aparatul digital, însă, imaginea nu se mai proiectează pe
film, ci pe un fel de ecran din interiorul aparatului. Acest ecran
este împărţit în milioane de punctişoare foarte fine. Lumina
pătrunsă prin aparat la declanşarea butonului impresionează
acest ecran, activând fiecare dintre punctişoarele amintite. Infor-
maţia privind poziţia, culoarea, intensitatea luminii căzute asupra
fiecărui punctişor se exprimă apoi în numere formate ca şiruri de
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0 şi 1 (folosite, desigur, de mai multe ori). Spunem că puncti-
şoarele capătă o expresie numerică sau digitală.

Totalitatea numerelor ce exprimă punctişoarele din care este
alcătuită o fotografie constituie un fişier de tip imagine. Acestui
fişier i se dă o denumire (exemplu, „foto24.jpg“).

Fişierul se stochează în memoria aparatului foto digital – de
obicei, un disc magnetic. De pe acest disc, fişierul se poate copia
pe calculator. Când deschidem fişierul respectiv, pe ecranul
calculatorului va apărea din nou imaginea. Cum? Calculatorul va
folosi informaţiile numerice din fişier (combinaţiile de 0 şi 1). El va
retraduce informaţia numerică în punctişoarele de culori şi inten-
sităţi diferite. Aşa se reface imaginea pe monitor şi se poate apoi
imprima pe hârtie foto.

Toate procesele ce se desfăşoară în calculator au caracter
digital – toate datele (informaţiile) se exprimă numeric şi sub
această formă se preiau, se prelucrează sau se stochează.

Unitatea de bază şi unităţile periferice;
porturile

Precum am arătat deja, calculatorul
este un sistem în care intră o unitate de
bază şi mai multe unităţi conectate la uni-
tatea de bază. Unităţile conectate la uni-
tatea de bază se numesc unităţi periferice.

Unitatea de bază sau unitatea de
sistem este o cutie metalică.

Reamintesc că, pe latura din faţă a
acesteia, se observă comutatorul de pornire
a calculatorului, precum şi semnalele
luminoase care ne arată dacă sistemul este
în funcţiune. Tot aici se văd două des-
chizături orizontale de mărimi inegale. Cea
mai mică reprezintă partea din faţă a
cititorului de dischete. Deschizătura mai
lungă aparţine cititorului de discuri optice de
tip CD-ROM sau cititorului de discuri optice
de tip DVD /diː viː diː/.
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Pe latura din spate, se observă mai
mulţi conectori, de diverse forme. Tot de
partea din spate este legat cordonul cu
ştecăr la capăt pentru conectare la priza
electrică a sistemului.

Conectorii se numesc porturi sau
interfeţe. Un conector este locul unde se
produce un schimb de informaţii între
sistemul de bază şi o unitate periferică, cum
ar fi o imprimantă sau un monitor. Acest
schimb se aseamănă schimburilor de
mărfuri dintr-un port maritim sau fluvial,
de aceea locul unde se face conectarea
perifericelor se numeşte port.

Dintre porturi, amintim:
• portul USB (Universal Serial Bus

/juːnıvəːrsl sıəriəl bʌs/ magistrala serială
universală), prin care se pot conecta la
unitatea de bază mai multe tipuri de unităţi
periferice (imprimantă, mouse, tastatură
etc.). Mai mult, prin intermediul unui hub

USB /juː es biː/ (o cutiuţă care are o ieşire către calculator şi de la
două până la 127 de ieşiri către unităţile periferice), se pot conecta
la acelaşi port USB /juː es biː/ mai multe periferice deodată (până la
127);

• portul serial, prin care datele curg înspre şi dinspre unita-
tea de bază sub forma unei serii de impulsuri electrice, impuls
după impuls, sau, mai bine spus, bit după bit, alcătuind serii de
biţi; portul serial este lent – şi de aceea el e folosit pentru periferice
care nu cer o viteză foarte mare de transfer a datelor. Unul dintre
acestea este modemul – un instrument prin care calculatorul se
poate conecta la reţeaua telefonică. Alte periferice care se pot
conecta la calculator prin portul serial sunt scannerele, impri-
mantele etc.;

• portul paralel, care are opt fire şi acceptă transferul în-
tr-un sens sau în celălalt a opt biţi deodată (un octet); fiind un
port mult mai rapid, e folosit adesea pentru imprimante;

• portul PS/2 a fost inventat de IBM pentru conectarea
mouse-ului; funcţionează ca un port serial şi are o formă rotundă,
cu 6 fire;

47

Unitatea de bază privită
din spate



• portul SCSI (pronunţă /skʌzi/) este un tip de port paralel,
transferând câte un octet (byte) deodată şi nu câte un bit; la portul
SCSI se pot cupla până la opt unităţi periferice, legate în serie
unul de altul;

• portul FireWire, numit şi portul 1294, este cel mai rapid
dintre porturi, fiind folosit pentru descărcarea filmelor de pe
camerele de filmat digitale;

• portul IrDA, care permite conectarea fără fir (prin unde
infraroşii) a unor mouse-uri, tastaturi, imprimante special
construite pentru a fi folosite fără cabluri;

• portul VGA, pentru conectarea monitorului;
• portul RJ-11, pentru conectarea calculatorului (de fapt, a

modemului încorporat în calculator) la linia telefonică;
• portul RJ-45, pentru conectarea calculatorului (de fapt, a

plăcii de reţea) la reţeaua de calculatoare;
• portul minipriza stereo, pentru conectarea unui microfon,

a unui difuzor sau a unor căşti audio;
• etc.
Desigur, nu toate calculatoarele PC /piː siː/ au toate aceste

porturi; dar, cu cât un calculator are mai multe porturi, cu atât
poate controla mai multe componente periferice.

Memoria de lucru RAM

Când deschidem calculatorul (apăsând pe comutatorul
amintit), se lansează în execuţie un set de programe. Aceasta
înseamnă că ele sunt copiate de pe discul dur în memoria de lucru
(memoria primară) a calculatorului. Memoria de lucru cea mai
importantă este memoria RAM /ræm/ – care înseamnă memorie cu
acces direct. Fiecare instrucţiune din program are o „adresă“ pre-
cisă la care se află în memoria RAM /ræm/, astfel încât micro-
procesorul s-o poată accesa direct (nu după ce citeşte alte instruc-
ţiuni) atunci când are nevoie de ea.

Programele lansate în execuţie la deschiderea calculatorului
verifică funcţionalitatea fiecărei componente hard şi copiază în
memoria RAM /ræm/ aşa-zisele „drivere“ – progrămele ultraspe-
cializate care fac posibilă folosirea de către calculator a diferitelor
mărci de imprimantă, mouse, scanner, monitor etc. După ce
constată că totul e în ordine, calculatorul afişează pe ecranul
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monitorului interfaţa cu utilizatorul – adică ecranul de pornire.
Apoi aşteaptă ca tu, utilizatorule, să foloseşti această interfaţă ca
să-i spui ce să facă el în continuare pentru tine.

Gândăceii din programe

Calculatorul nu e infailibil – nu din vina lui, ci pentru că
oamenii mai fac şi greşeli. De – oameni suntem! Mai devreme sau
mai târziu, o eroare de program se face simţită. Erorile din pro-
gram se numesc pe englezeşte bugs /bʌgz/, adică gândăcei. Cel mai
adesea, când o astfel de eroare iese la suprafaţă, programul res-
pectiv se blochează – îngheaţă – şi nu mai primeşte nicio coman-
dă.

Nu te speria! Nu e vina ta, utilizatorule!
Ce vei face în aceste cazuri? Soluţia generală este „salutul cu

trei degete“. De fapt, e o combinaţie de taste: Ctrl + Alt + Delete
(uneori tasta Delete /dıliːt/ elimină este marcată Del). Apeşi
simultan pe toate acestea şi fie primeşti o fereastră de la care poţi
închide programul care nu mai răspunde la comenzi, fie întregul
sistem se închide şi se deschide singur (se „restartează“). Când
redeschizi programul cu probleme, acesta funcţionează din nou
(până la noua întâlnire cu eroarea respectivă).

De ce apar erori în programe? Programele pot avea sute de mii
sau milioane de instrucţiuni. Instrucţiunile sunt scrise pe bucăţi
de către zeci, sute şi uneori mii de oameni. Undeva, la îmbinarea
acestor bucăţi, se pot ivi neconcordanţe. Deşi există unelte soft de
căutare a acestor neconcordanţe în vederea rezolvării lor, unele
scapă. Şi ajung în aplicaţia ce rulează pe calculatorul tău.

Versiunile – ediţii revizuite şi adăugite

Producătorii de programe primesc de la utilizatori informaţii
în legătură cu comportamentul programelor lor. De asemenea, ei
înşişi le testează mereu. Ei îmbunătăţesc programele, creând
versiuni noi, mai bogate în comenzi (care aduc noi servicii pentru
utilizator) şi mai sărace în... gândăcei. Există „versiuni majore“
care înglobează modificări foarte importante, notate cu cifre,
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precum: 1.0 sau 2.0 sau 3.0 etc. Între acestea există sub-versiuni
sau versiuni intermediare. În cazul versiunilor intermediare, mo-
dificările survenite au fost mai puţine şi/sau de mai mică
importanţă. Ele se notează cu cifre precum: 1.1, 1.2, 1.3...; 2.1,
2.2, 2.3 etc.

Nu închide calculatorul de la comutator!

Când ţi-ai terminat treaba, vrei să închizi calculatorul, nu-i
aşa? Ei bine, nu apăsa pe comutator ca la radio sau la televizor!

Calculatorul are o închidere soft, care precedă închiderea
hard. Închiderea soft poate chiar să execute şi închiderea hard.

Trebuie să cauţi comanda shut down /ʃʌt daʊn/ închide-te şi
s-o lansezi în execuţie. Calculatorul se va pregăti pentru închi-
dere: va închide pe rând, într-o ordine de el ştiută, toate progra-
mele, te va întreba dacă vrei să înregistreze pe discul dur ceea ce
ai uitat tu să-i ceri să înregistreze etc. În final, fie va acţiona chiar
el butonul de deconectare de la reţea, fie va afişa un mesaj prin
care îţi va spune că ai voie să apeşi pe comutator. Abia când vezi
mesajul poţi să-l închizi!
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3. Componentele software

Spuneam că, dacă nu ar exista feluritele programe de calcu-
lator, toate componentele fizice nu ar avea niciun rost pe lume.
Programele animează componentele hard şi le pun să colaboreze
pentru atingerea ţelurilor tale, ale utilizatorului.

Tipurile de componente soft

Componentele soft (programele) se împart în patru mari clase:
• sisteme de operare – componentele soft de bază ale calcu-

latoarelor;
• sisteme de operare a reţelelor de calculatoare – componen-

te soft care mijlocesc şi controlează colaborarea între calculatoa-
rele din reţelele de calculatoare sau între diferite reţele de calcula-
toare;

• aplicaţii – programe specializate, care rezolvă probleme
specifice dintr-un anumit domeniu de activitate – cum ar fi pro-
grame de grafică, de tehnoredactare, de prognoză meteo etc.;

• drivere – programe strict specializate pe tipuri şi mărci de
componente periferice (cum ar fi driver de cutare sau cutare mar-
că şi model de scanner, driver de imprimantă, driver de inscriptor
de DVD-uri etc).

În cartea de faţă vom vorbi mai pe larg de sisteme de operare
şi de aplicaţii.

Sistemul de operare controlează componentele hard şi oferă
utilizatorului calea de acces către acestea şi către aplicaţiile soft.

Aplicaţiile soft sunt programe specializate pe o sferă de activi-
tate. De exemplu,

• aplicaţia soft numită Photoshop /fəʊtəʃɔp/ este instrumen-
tul de lucru al graficienilor;

• aplicaţia soft numită QuarkXPress /kwɔːrkekspres/ este in-
strumentul tehnoredactorilor de ziare, reviste şi cărţi;

• Microsoft Word /maıkrəsɔft wəːrd/ este o răspândită aplicaţie
soft pentru prelucrarea de texte;
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• Oracle /ɔrəkl/ se foloseşte pentru crearea şi gestionarea
bazelor de date;

• CAD /kæd/ este instrumentul inginerilor proiectanţi etc.
Sistemele de operare sunt relativ puţine la număr. Aplicaţiile

soft, mai simple sau mai complexe, sunt extrem de numeroase (de
ordinul miilor sau zecilor de mii). Softul de sistem se livrează de
obicei împreună cu calculatorul. Aplicaţiile soft de obicei se
cumpără (fie prin descărcare de pe Internet, fie stocate pe unul
sau mai multe CD-uri) şi se instalează pe calculator separat sau
se pot crea de către programatori ca aplicaţii strict specializate
pentru uzul unei singure firme sau chiar al unei singure
persoane.

Sistemul de operare

Sistemul de operare face legătura între toate componentele
hard (microprocesor şi CPU /siː piː juː/ unitatea centrală de prelu-
crare, discurile dure, cititoarele de dischetă şi CD, monitor, tasta-
tură, mouse, imprimantă etc.), le pune să lucreze unele cu altele
şi cu utilizatorul. Tot sistemul de operare oferă mediul în care se
deschid şi rulează aplicaţiile. Aplicaţiile au acces la componentele
computerului prin medierea sistemului de operare.

Sistemul de operare ordonează sarcinile (calculele) pe care
trebuie să le îndeplinească microprocesorul – prin componenta sa
de bază numită unitatea centrală de prelucrare (CPU /siː piː juː/ =
central procesing unit /sentrəl prəʊsesıŋ juːnıt/). E un fel de moară,
iar aplicaţiile sunt clienţii veniţi să-şi macine grâul. Sistemul de
operare este morarul, care are un fel ciudat de a se comporta cu
clienţii. Anume, el nu-i permite nici unui client să-şi macine toţi
sacii deodată: fiecare macină câte puţin, îşi ia făina şi se duce
după alt sac de grâu, lăsând loc şi altora, până îi vine din nou
rândul. În felul acesta, sistemul de operare îl satisface pe utili-
zator, care are de cele mai multe ori impresia că numeroase opera-
ţiuni din aplicaţii diferite se execută simultan. (Dar se întâmplă să
i se pară şi că orice program „merge“ prea încet!)

O altă analogie (dacă n-ai văzut cum se macină la moară):
Închipuie-ţi că în anul 2020 eşti de serviciu la turnul de

control al aeroportului internaţional „Henri Coandă“ din Bucureşti
şi dirijezi traficul aerian. Sute de avioane şi elicoptere vin şi
pleacă, aşteaptă să aterizeze sau să decoleze, unele transportă
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pasageri, altele mărfuri, unele sunt cât un bloc de 10 etaje, altele
cât un TIR, unele trebuie să aterizeze de urgenţă, pentru că au o
defecţiune la bord, altele trebuie să plece cu persoane ultra-
importante la întâlniri internaţionale sau la meciuri de fotbal... Iar
tu trebuie să faci faţă tuturor acestor solicitări, să dai undă verde
unuia, să ceri altora să aştepte şi să faci totul fără să se producă
vreo catastrofă.

Rolul tău sau al echipei tale de la turnul de control ar fi
similar cu rolul sistemului de operare dintr-un PC /piː siː/. Şi în
calculator avem de-a face cu un trafic ameţitor: electronii zboară
încolo şi încoace prin circuitele integrate, la viteze incredibil de
mari, conduşi spre destinaţii precise de sistemul de operare.

Sistemul de operare, mai pe scurt, mediază (mijloceşte) între
utilizator, componentele hard şi aplicaţiile soft. Cea mai importan-
tă parte a lui se numeşte nucleu sau kernel (kernel /kəːrnl/ sâm-
bure, miez; nucleu). O altă denumire a nucleului (kernel-ului) este
programul supraveghetor (supervisor program /suːpərvaızər

prəʊgræm/). Această parte a sistemului de operare coordonează
activitatea perifericelor şi operaţiile executate de microprocesor
(CPU /siː piː juː/).

Când deschidem calculatorul, programul supraveghetor este
copiat în memoria RAM /ræm/ (memoria de lucru a procesorului) şi
va rămâne în această memorie pe toată durata funcţionării PC-
ului. De aceea spunem că programul supraveghetor (nucleul sau
kernel-ul) este rezident în memorie. Părţile mai rar folosite ale
programului de operare, numite nerezidente în memorie, rămân în
aşteptare pe discul dur şi sunt copiate în memoria RAM /ræm/
numai când este nevoie de ele.

Niciodată împreună în acelaşi timp

Sunt mai multe tipuri de sisteme de operare. Pe un calculator
nu pot rula două sisteme de operare diferite în acelaşi timp (dar
pot rula în intervale diferite). Dintre cele mai cunoscute sisteme de
operare, amintim:

• DOS /dɔs/ = disk operating system /dısk ɔpəreıtıŋ sıstəm/
sistemul de operare a discului;

• Unix /juːnıks/;
• Linux /lınıks/;
• Macintosh OS X /mækıntɔʃ əʊ es ten/;
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• Windows 95 /wındəʊz naınti faıv/;
• Windows 98 /wındəʊz naınti eıt/;
• Windows 2000 /wındəʊz tuː θauznd/;
• Windows NT Workstation /wındəʊz en tiː wəːrksteiʃn/;
• Windows XP /wındəʊz eks piː/;
• Windows Vista /wındəʊz vıstə/.
Ne vom ocupa îndeaproape de trei sisteme de operare:

Windows 98 /wındəʊz naınti eıt/ şi Windows XP /wındəʊz eks piː/ – mai
răspândite în ţara noastră – şi Windows Vista /wındəʊz vıstə/, cel
mai nou sistem de operare al companiei Microsoft.

O menţiune specială merită sistemul de operare Linux /lınıks/.
Spre deosebire de toate celelalte din lista de mai sus, acesta nu
este produs de o firmă anume. Dimpotrivă, prima lui formă a fost
creată de un student finlandez (Linus Torvalds), cu scopul decla-
rat de a pune gratuit la îndemâna tuturor iubitorilor de calcula-
toare un sistem de operare robust şi eficient. Apoi, mii de alţi pro-
gramatori au contribuit la îmbogăţirea acestui sistem de operare.
Şi tu vei putea contribui, dacă vei vrea, la dezvoltarea Linux-ului.

Mai mult, toate aplicaţiile care rulează pe platforma Linux
(platformă se numeşte combinaţia dintre un anumit tip de pro-
cesor şi un anumit sistem de operare) se pot obţine gratuit şi pot
fi folosite sub licenţa GNU (fără plată). Aceasta, în timp ce licenţele
pentru aplicaţiile scrise pentru celelalte sisteme de operare costă
zeci, sute, sau chiar mii de euro.

Interfaţa cu utilizatorul

Te uiţi la ecranul monitorului şi vrei să comunici cu calcu-
latorul, să interacţionezi cu el. Sistemul de operare îţi oferă calea
prin care poţi comunica, numită interfaţa cu utilizatorul (user
interface /juːzər ıntərfeıs/). Există trei tipuri de interfaţă cu utiliza-
torul: interfaţa linie de comandă, interfaţa cu listă de comenzi şi
interfaţa grafică.

Interfaţa linie de comandă

Interfaţa linie de comandă (engl. CLI /siː el aı/ = command line
interface /kəmænd laın ıntərfeıs/) afişează pe ecranul monocolor (de
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obicei cu fundal negru) un cursor şi aşteaptă să introduci tu
comanda. Comanda trebuie s-o scrii ca pe o serie de cuvinte-cheie
care urmează o sintaxă (un ansamblu de reguli de îmbinare) foarte
strictă. De exemplu, în sistemul de operare MS-DOS /em es dɔs/ =
Microsoft Disk Operating System /maıkrəsɔft dısk ɔpəreıtıŋ sıstəm/
sistemul Microsoft de operare a discului – cursorul de comandă cel
mai des folosit este:

C:\>
(C: desemnează primul disc dur al sistemului.)
Iată un exemplu de comandă pe care poţi s-o dai calculatoru-

lui prin CLI /siː el aı/:

copy a:doc01.txt c:docmeu.txt

După ce o scrii, apeşi pe tasta Enter /entər/ intră/rând nou,
care te plasează la început de rând; atunci calculatorul citeşte şi
execută comanda.

Ce i-ai cerut să facă? I-ai spus să copieze documentul cu
numele doc01.txt de pe dischetă (numită „A:“) pe discul dur („C:“),
schimbându-i totodată şi numele în docmeu.txt. După ce execută
comanda, calculatorul îţi afişează din nou cursorul şi aşteaptă
comanda următoare.

Dezavantajul acestei interfeţe este că trebuie să înveţi pe de
rost sute de comenzi, să nu baţi greşit nicio literă şi să nu modifici
ordinea elementelor din comandă (sintaxa comenzii).
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1 file(s) copied; liniuţa de pe ultimul rând este cursorul interfeţei linie de

comandă.



Avantajul este că, odată memorate comenzile, comunicarea
cu calculatorul este foarte rapidă. Degetele tale conduc toate ope-
raţiunile pas cu pas, ai controlul deplin şi direct al întregii situaţii.

Interfaţa cu liste de comenzi (meniuri)

În cazul interfeţei cu liste de comenzi (menu-driven interface
/menjuː drıvn ıntərfeıs/), nu mai eşti nevoit să introduci comenzile
manual: le alegi dintr-o listă de comenzi posibile.

Iată un exemplu de listă de comenzi:

Meniul principal

1. Adaugă o înregistrare nouă
2. Modifică o înregistrare existentă
3. Şterge o înregistrare existentă
4. Imprimă o înregistrare
5. Trimite prin e-mail o înregistrare
6. Trimite prin fax o înregistrare
7. Ieşire din program

Ce alegi să faci?

(1, 2, 3, 4, 5, 6, sau 7):_
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Interfaţa cu liste de comenzi: citeşti comenzile şi apeşi pe numărul
comenzii dorite; fie va fi executată comanda, după care revine pe ecran meniul,
fie va fi afişat un alt meniu (sub-meniu) din care să alegi comanda următoare.



În cazul de faţă ţi se cere să scrii numărul comenzii dorite şi
să apeşi pe tasta Enter /entər/ intră/rând nou.

În alte cazuri, poţi să alegi comanda prin folosirea tastelor cu
săgeţi sau prin indicarea ei cu ajutorul mouse-ului.

Interfaţa grafică (GUI)

Cea mai răspândită şi îndrăgită interfaţă cu utilizatorul este
cea grafică sau GUI /gʊ ı/ = graphical user interface /græfikəl juːzər

ıntərfeıs/. În GUI /gʊ ı/, după ce sistemul de operare s-a lansat şi a
fost copiat în memoria RAM /ræm/ = random access memory
/rændəm ækses meməori/ memorie volatilă cu acces direct/memorie de
lucru, pe ecran apare o imagine numită metaforic mediu în-
conjurător de tip birou de lucru (desktop environment /desktɔp
ınvaıərənmənt/). (Cu un neologism la îndemână, numim acest ecran
desktop.) În cadrul acestei imagini, apar pe un fond colorat mici
desene, numite iconiţe sau icon-uri. Iconiţele (icon-urile) reprezintă
programe, documente cu date prelucrate sau de prelucrat, alte
calculatoare din reţea etc. Alegând cu mouse-ul o iconiţă, prin
simpla apăsare pe buton putem porni un program sau deschide
un document (sau şi una şi alta).

Programele rulează în cadrul unor dreptunghiuri de mărime
variabilă, pe care le numim ferestre. Se pot deschide mai multe
programe în acelaşi timp, fiecare în fereastra sa. Una dintre
ferestre este activă – adică este cea în care lucrăm în clipa de faţă,
celelalte rulând în fundal şi aşteptând să le activăm pe rând. Cum
le activăm? Printr-un clic de mouse în cadrul lor.
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Desktopul sistemului de operare Windows 98

Interfaţa grafică a sistemului de operare Windows (vezi
imaginea de la pag. 61) produs de compania Microsoft prezintă la
baza ecranului o bară, numită bara de funcţiuni a ecranului.

Pe această bară apar butoane cu iconiţe pe ele, reprezentând
programe (aplicaţii) pe care le putem deschide cu un clic de
mouse. Tot aici se ivesc butoane noi corespunzând documentelor
deschise de aplicaţiile în execuţie.

Deasupra barei de funcţiuni, pe cuprinsul ecranului, adică pe
desktop /desktɔp/ biroul virtual reprezentat de ecran, vedem iconiţe
cu titluri ca: My Computer /maı kəmpjuːtər/ calculatorul meu, My
Documents /maı dɔkjəmənts/ documentele mele, Network Neighbor-
hood /netwəːrk neibərhʊd/ vecinii din reţea, Internet Explorer /ıntərnet
ıksplɔːrər/, Recycle Bin /riːsaıkl bın/ coşul de gunoi şi altele.

Iconiţa „My Computer“ („Calculatorul meu“)

Poziţionez indicatorul controlat de mouse pe iconiţa (icon-ul)
My Computer /maı kəmpjuːtər/ calculatorul meu şi apăs de două ori
pe butonul din stânga al mouse-ului. Ce se întâmplă? Se deschide
o fereastră cu alte iconiţe pe care le pot accesa cu mouse-ul.

Iconiţele grupate sub My Computer /maı kəmpjuːtər/ calculatorul
meu (vezi imaginea de la pag. 62) reprezintă toate mediile (adică
tipurile de suport material) de memorie secundară (de stocare) la
care are acces calculatorul meu, plus alte câteva grupuri de
documente – Printers /prıntərz/ imprimante, Control Panel /kəntrəul
pænl/ tabloul de control/comandă, Dial-Up Networking /daıəl ʌp
netwəːrkıŋ/ accesare de reţele prin telefon etc.

De exemplu – mediile de stocare de pe calculatorul pe care
scriu această carte sunt:

• discheta aflată în unitatea de citire/scriere de dischete,
care e notată convenţional cu litera A urmată de două puncte (A:);

• discul dur C:, căruia i-am dat eu denumirea „WIN98“; pe
acest disc se află sistemul de operare al calculatorului meu,
precum şi aplicaţiile pe care le-am instalat; îţi aminteşti că primul
disc dur este totdeauna notat cu litera C (C:)?;
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• discul dur D: (l-am numit „DATE“), unde stochez fişierele
pe care le creez pe calculator (îmi place să le ţin separat de
sistemul de operare şi de aplicaţii);

• discul dur E: (l-am numit „BACKUP“), unde copiez fişiere
care mi se par mie mai importante; e mai bine să le am în dublu
exemplar – în cazul în care discul dur D: se strică, le recuperez de
pe discul E:;

• CD-ROM-ul aflat în unitatea de citire de CD-ROM-uri
(notată cu litera F:); iconiţa CD-ROM-ului este un disc ce acoperă
parţial o unitate de citire de CD-ROM-uri – unitate care arată ca
o cutiuţă plată, cu o deschizătură în partea din faţă.

Accesarea informaţiilor de pe dischetă

Să facem clic pe iconiţa numită „31/2 Floppy (A:)“, care
reprezintă unitatea de citire/scriere a dischetei. Dacă am o
dischetă introdusă în unitate, se va deschide o fereastră care îmi
va dezvălui ce este pe acea dischetă. Dacă nu am o dischetă în
unitate, fereastra care se va deschide va fi goală.

Întâmplător, am o dischetă în unitate. Ce se află înregistrat pe
ea? Trei fişiere, fiecare cu câte un nume şi o extensie. Numele este
separat de extensie printr-un punct.

Ce este un fişier

Un fişier este un corp de date care formează un tot unitar şi
care se stochează laolaltă, fiind identificat prin secvenţa
nume–punct–extensie.

• Primul fişier, doc01.txt, are numele doc01 şi extensia txt.
Citind extensia, atât eu, cât şi calculatorul ştim că avem de-a face
cu un fişier de tip text (txt = text). E vorba de un text simplu, cu
minimum de prelucrare.

• Al doilea fişier, Inreg.exe, este o aplicaţie. De unde ştim?
De la extensia exe, care indică un fişier executabil, adică un pro-
gram. Acest program mă ajută să înregistrez date într-o bază de
date.
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• Al treilea fişier, ana8.jpg este una dintre fotografiile ce o
înfăţişează pe prietena noastră de familie Ana-Maria. De unde
ştiu? Sigur, îmi pot da seama după nume (ana8 – a opta fotografie
a Anei); dar extensia este de fapt cea care îmi arată tipul fişierului.
JPG /dʒeı piː dʒiː/ este un format grafic standard realizat de Joint
Picture Expert Group /ʤɔınt pıkʧər ekspəːrt gruːp/ (JPEG), o organi-
zaţie de profesionişti în grafică. Există multe alte formate în care
se pot realiza fişiere cu conţinut grafic; iată câteva extensii: pcx, tif,
bmp etc.

Acum putem să mergem mai departe – să selectăm unul
dintre cele trei fişiere şi să vedem ce se va întâmpla când execu-
tăm dublu clic pe el. Ai puţină imaginaţie? Tu ce crezi că se va
întâmpla?

Dacă am face dublu clic pe doc01.txt, ar trebui ca, la această
comandă a noastră, sistemul de operare Windows 98 /wındəʊz
naınti eıt/ să lanseze în memoria RAM /ræm/ memorie volatilă cu
acces direct/memorie de lucru o aplicaţie soft care să ştie să pre-
lucreze texte. Acea aplicaţie soft, după instalare în RAM /ræm/, va
acţiona asupra fişierului doc01.txt şi îl va deschide, adică îl va
copia în RAM /ræm/ şi îl va afişa pe ecran. Odată afişat, putem
folosi aplicaţia de prelucrare de text deja deschisă pentru a
continua să scriem în fişierul doc01.txt, pentru a şterge cuvinte de
acolo sau pentru a corecta eventualele greşeli de ortografie.

Dacă vom face dublu clic pe Inreg.exe, atunci sistemul de ope-
rare va lansa în execuţie aplicaţia Inreg şi ne va facilita activitatea
de adăugare de noi date sau de modificare a celor deja existente
în baza de date.

Dacă vom face dublu clic pe ana8.jpg, ce se va întâmpla? Hai
să încercăm. Selectăm fişierul (când e selectat, apare umbrit pe
ecran). Dublu clic şi... Windows 98 /wındəʊz naınti eıt/ deschide
aplicaţia Microsoft Photo Editor /maıkrəsɔft fəʊtəʊ edıtər/ editorul de
fotografii Microsoft (adică o copiază în memoria RAM /ræm/ şi îi
creează o fereastră în care să se afişeze pe ecran). La rândul ei,
aplicaţia Microsoft Photo Editor /maıkrəsɔft fəʊtəʊ edıtər/, tot cu
ajutorul sistemului de operare Windows 98 /wındəʊz naınti eıt/,
deschide fişierul ana8.jpg (adică îl copiază în memoria RAM /ræm/
şi îl afişează pe ecran în cadrul propriei sale ferestre).
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Ce este un dosar (sau folder)

Am aflat ce este un fişier. Am aflat că fişierele pot fi înregis-
trate (se spune mai des „salvate“) pe o dischetă sau pe discul dur.
Tot înregistrând fişiere pe discul dur, destul de repede ne putem
trezi în situaţia să nu mai ştim dintr-o privire ce cuprinde fiecare
fişier.

Calculatorul ne oferă şi aici o mână de ajutor. Putem crea
dosare în care să grupăm fişierele înrudite. Un exemplu: ne place
opera marelui poet Petre Ghelmez şi în fiecare zi ne facem timp să
alcătuim un fişier cu câte o poezie a lui. Vrem să avem un loc pe
discul dur unde să grupăm aceste fişiere, pentru a nu le amesteca
cu restul fişierelor noastre.

Vom crea un dosar (numit şi folder) cu numele Ghelmez. Cum
procedăm?

Ne aflăm în faţa ecranului de pornire (numit desktop) oferit ca
interfaţă de Windows 98 /wındəʊz naınti eıt/. Poziţionăm indicatorul
mouse-ului oriunde pe desktop (dar nu pe vreo iconiţă sau pe bara
de jos a ecranului). Apăsăm pe butonul mouse-ului din partea
dreaptă (nu pe cel pe care am tot apăsat până acum, ci pe cel din
partea opusă). Apare o listă de comenzi (un meniu). Alegem New
/njuː/ nou – se deschide altă listă.

Aici alegem Folder /fəʊldər/
dosar. Cum am apăsat pe
Folder, meniul dispare, iar pe
desktop apare o iconiţă nouă
(care este chiar desenul unui
dosar) cu denumirea New
Folder /njuː fəʊldər/ dosar nou.
Cele două cuvinte – New
Folder – apar pe un fond
albastru. Aceasta înseamnă că
sunt selectate. Dacă intro-
ducem un cuvânt cu ajutorul
tastaturii, cuvintele selectate
vor dispărea şi în locul lor va
apărea cuvântul scris de noi.
Acela e denumirea dosarului.
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Apăsăm pe butonul din dreapta
al mouse-ului, apoi pe New şi se iveşte

acest meniu.



Să scriem numele
folderului nostru:
Ghelmez.

Acum avem folderul
Ghelmez pe desktop.
Vom putea salva în
acest folder fişierele care
cuprind poezii de Petre
Ghelmez.

Poate vrem să
mergem cu organizarea
mai departe. Vrem să
grupăm poeziile despre
copilărie ale lui Ghelmez
într-un folder numit
Copilăria, cele despre
toamnă în folderul
Toamna etc. Aceste
foldere noi, le vom crea în interiorul folderului denumit Ghelmez.
Fiind în interiorul unui alt folder, ele se vor numi sub-foldere.

Iată cum procedăm. Deschidem folderul Ghelmez de pe
desktop (dublu clic pe el). Se deschide o fereastră care ne arată
conţinutul dosarului Ghelmez (dosarul e gol deocamdată). Plasăm
pointer-ul (indicatorul mouse-ului) în interiorul acestei ferestre.
Alegem iarăşi New > Folder şi scriem numele: Copilăria. Repetăm
operaţiunea pentru a crea sub-folderul Toamna. Aşa putem crea
câte sub-foldere ne sunt necesare.

Iată meniul Dumneavoastră! Ce doriţi să
comandaţi?

Există şi alte modalităţi de a deschide aplicaţiile soft pentru a
lucra cu ele? Poate că nu apar iconiţele lor pe biroul virtual
(desktop) reprezentat de ecran şi poate că nu avem fişiere create
în acele programe, deci nu avem pe ce să facem dublu clic.

Pentru această situaţie, avem acces la nişte liste, numite
meniuri (ca lista de bucate de la restaurant). Să ne uităm la bara
din josul ecranului. Ce vedem chiar la capătul din stânga? Un
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buton dreptunghiular, pe care se află logo-ul sistemului de ope-
rare Windows /wındəʊz/ (un steag fluturând în vânt, alcătuit din
ferestre colorate) urmat de cuvântul Start /stɑːrt/ începe/început.

Păi să începem! Facem clic (o dată) pe butonul Start /stɑːrt/.
Imediat se lansează meniul principal. E o listă de alte meniuri
(numite sub-meniuri). Să alegem sub-meniul Programs
/prəʊgræmz/ programe. Vom vedea lista de programe (aplicaţii soft)
instalate pe calculatorul nostru. Programele care apar în această
listă sunt aplicaţii care nu fac parte din sistemul de operare, ci au
fost cumpărate şi instalate separat. Unele denumiri însă nu sunt
programe, ci tot sub-meniuri. De exemplu, sub-meniul
Accessories /əksesəoriz/ accesorii. Acesta cuprinde mai multe
aplicaţii şi sub-meniuri ce listează încă nişte aplicaţii. Toate apli-
caţiile listate sub Accessories /əksesəoriz/ vin odată cu („calcula-
toriştii“ spun: „sunt împachetate cu“ sau „integrate în“) sistemul
de operare (numai că ele sunt nerezidente, întrucât sunt lansate
în memoria RAM /ræm/ numai la nevoie). Aplicaţiile împachetate cu
sistemul de operare se numesc şi utilitare.

Câteva aplicaţii instalate odată cu Windows 98

Aplicaţiile pe care le găsim în sub-meniul Accessories
/əksesəoriz/ accesorii, precum şi aplicaţiile din sub-meniurile acestui
sub-meniu se oferă de către distribuitorii calculatoarelor echipate
cu sistemul de operare Windows 98 /wındəʊz naınti eıt/. Pentru ele
nu se plăteşte nimic în plus – adică nimic peste costul
calculatorului şi al sistemului de operare.

Enumerăm câteva dintre aceste aplicaţii utilitare – pentru a
afla ce putem face cu ele:

• Imaging /ımıʤıŋ/ lucru cu imagini – pentru afişare şi pre-
lucrare de fotografii sau desene,

• Notepad /nəʊtpæd/ carneţel de notiţe – pentru fişiere ce
cuprind texte scurte, prelucrate sumar (ca nişte bileţele),

• Paint /peınt/ pictează – pentru realizarea de desene cu
ajutorul mouse-ului şi al unor procedee specifice acestui program,

• Wordpad /wəːrdpæd/ carneţelul aplicaţiei Microsoft Word
/maıkrəsɔft wəːrd/ – pentru fişiere-text ce cuprind texte (mai) lungi, cu
o prelucrare mai avansată (Wordpad /wəːrdpæd/ cuprinde funcţiile
de bază ale aplicaţiei Microsoft Word /maıkrəsɔft wəːrd/ – aceasta din
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urmă fiind o aplicaţie mult mai complexă şi realizând o prelucrare
foarte avansată de texte, dar care se cumpără şi se instalează
separat de sistemul de operare).

Uneltele de întreţinere şi control al
sistemului (calculatorului)

Un sub-meniu important aflat în Accessories /əksesəoriz/ acce-
sorii este System Tools /sıstəm tuːlz/ uneltele sistemului. Să des-
chidem acest sub-meniu. Îţi mai aminteşti cum ajungi la el?
Schema următoare te va ajuta:

Start > Programs > Accessories > System Tools

Adică: mergi la meniul principal Start /stɑːrt/ începe sau înce-
put, alege sub-meniul Programs /prəʊgræmz/, apoi alege sub-me-
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Un document scris în WordPad. Şi aici, ca şi în Microsoft Word, avem
posibilitatea să scriem cu litere româneşti – cu ă, â, î, ţ, ş. Acestea se numesc
litere cu diacritice. Ori de câte ori scrieţi în limba română, folosiţi literele cu

diacritice, din respect faţă de limbă şi faţă de cititor.



niul Accessories /əksesəoriz/ accesorii, apoi alege sub-meniul
System Tools /sıstəm tuːlz/.

Iată câteva dintre uneltele pe care le avem la dispoziţie pentru
buna întreţinere a sistemului:

• Disk Cleanup /dısk kliːnʌp/ curăţarea discului/discurilor –
pentru ştergerea fişierelor temporare şi a altor fişiere considerate
nefolositoare (şi eliberarea spaţiului de stocare pentru fişiere
folositoare);

• Disk Defragmenter /dısk dıfrægməntər/ defragmentarea
discului/discurilor – pentru scrierea mai compactă a informaţiilor
pe discurile dure sau pe dischete şi pregătirea de porţiuni con-
tinue de spaţiu neutilizat pentru mai buna dispunere a fişierelor
pe discuri sau dischete;

• Maintenance Wizard /meıntənəns vızərd/ vrăjitorul care
întreţine calculatorul – pentru programarea rulării utilitarelor de
întreţinere a calculatorului;

• ScanDisk /scændısk/ verificator de discuri – pentru verifica-
rea discurilor dure şi a dischetelor şi corectarea eventualelor
defecte,

• Scheduled Tasks /ʃedjuːld (skedjuːld) tɑːsks/ sarcini programa-
te – pentru a-i spune sistemului de operare când şi ce prelucrări
de date să execute automat, fără intervenţia utilizatorului;

• System Information /sıstəm ınfərmeıʃn/ informaţii despre
sistem – pentru obţinerea de date despre componentele hard şi
soft ale calculatorului

• etc.
E bine să nu folosim aceste utilitare (uneltele sistemului)

înainte de a deveni mai familiari cu calculatorul şi de a înţelege
bine la ce foloseşte fiecare dintre ele.

Tabloul de control

Pentru informaţii mai amănunţite şi pentru controlul direct al
componentelor calculatorului, sistemul de operare ne pune la
îndemână sub-meniul Control Panel /kəntrəul pænl/ tabloul de
control/comandă.

Câteva utilităţi importante aflate aici sunt:
• Add New Hardware /æd njuː hɑːrdweər/ adaugă noi compo-

nente hard – pentru instalarea unei componente hard nou
cumpărate;
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• Add/Remove Programs /æd/rımuːv prəʊgræmz/ adaugă sau
îndepărtează aplicaţii – pentru instalarea unei componente soft
nou cumpărate sau pentru dezinstalarea unei componente soft
instalate deja;

• Date/Time /deıt/taım/ data şi ora – pentru afişarea şi
modificarea informaţiilor privind în ce dată suntem şi cât e ceasul;

• Display /dıspleı/ monitorul – pentru controlul asupra cu-
lorii, luminozităţii şi dimensiunilor ecranului afişat de monitor;

• Fonts /fɔnts/ fonturi/tipuri de literă – pentru a vedea de ce
tipuri de litere dispune sistemul;

• Keyboard /kiːbɔːrd/ tastatură – pentru informaţii despre
tastatură şi control asupra ei;

• Mouse /maʊs/ şoarece – pentru controlul asupra mouse-
ului (dacă eşti stângaci, aici poţi să schimbi funcţiile butoanelor,
astfel încât să poţi folosi în mod comod mouse-ul cu mâna stângă)

• etc.

Cum strigăm Ajutor! astfel încât să ne audă
calculatorul

Pentru a înţelege mai bine cum funcţionează sistemul de
operare şi utilitarele sale, putem folosi programul utilitar Help
/help/ ajutor. Unde îl găsim? Aici:

Start > Help.

Deci, ajutorul este destul de aproape: doar la două clicuri
depărtare!

Help /help/ ajutor are trei meniuri principale:
Contents /kəntents/ cuprins, tablă de materii – care cuprinde un

manual, organizat pe capitole şi subcapitole, pe care îl putem citi
pe ecran;

Index /ındeks/ index – care ne cere să introducem noţiunea
care ne interesează şi să apăsăm pe butonul Display /dıspleı/
afişează pe ecran;

Search /səːrʧ/ caută – care ne permite să descoperim para-
grafele din manual în care se vorbeşte de problema noastră.
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Utilitarul Help (Ajutor) ne ajută să răsfoim manualul utilizatorului pentru a lucra
mai bine cu sistemul de operare. Dacă pe calculatorul tău apare în limba română

– cu atât mai bine. Dacă apare în engleză, ajută-te de un dicţionar
englez-român. Calculatoarele vorbitoare de limba engleză din ţara noastră sunt
deocamdată mult mai numeroase decât cele de română. Situaţia se va schimba,

desigur, în următorii ani, dar tot e bine să ne exersăm puţin engleza.



Să ne jucăm cu fişierele şi cu folderele

În acest moment, ai o idee despre ce înseamnă sistemul de
operare, ce înseamnă fişierele şi ce înseamnă folderele.

Ai învăţat să creezi un folder, dar nu ai învăţat încă să creezi
un fişier. O să creezi fişiere când vom lucra cu aplicaţiile. Deocam-
dată să examinăm în continuare sistemul de operare şi să vedem
ce facilităţi ne oferă în joaca noastră de-a (sau munca noastră cu)
folderele şi fişierele.

Poţi să vezi ce foldere şi ce fişiere ai pe toate mediile de stocare
(dischetă, discuri dure, CD-ROM).

Poţi să ştergi un fişier sau un folder.
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Poţi să copiezi – sau să muţi – un fişier sau un folder de pe un
mediu de stocare pe altul: fie de pe o dischetă pe un disc dur, fie
de pe un disc dur pe o dischetă, fie de pe un disc dur pe alt disc
dur, fie de pe un CD-ROM pe o dischetă (dacă încape) sau pe un
disc dur.

Gândeşte-te: poţi să copiezi un fişier sau un folder de pe
discul dur pe un CD-ROM? Nu! CD-ROM-ul nu poate fi schimbat,
odată inscripţionat. Nu poţi nici să adaugi ceva pe el, nici să
modifici vreun fişier de pe el. Sigla ROM din CD-ROM ne spune
acest lucru: Read Only Memory /riːd əʊnli meməori/ memorie
(secundară) care poate fi doar citită (nu şi scrisă sau modificată).

Putem copia un fişier sau un folder pe un CD-R – adică CD
înregistrabil? Da, dar nu folosind doar sistemul de operare, ci folo-
sind aplicaţia care vine împreună cu inscriptorul de CD.

Cum vedem ce foldere şi ce fişiere avem pe
mediile de stocare

E simplu: deschidem ferestre spre ele! Ştim că se află în
folderul My Computer /maı kəmpjuːtər/ calculatorul meu. Dublu click
pe My Computer /maı kəmpjuːtər/. Apoi dublu click pe dischetă – A:,
pe discul dur C:, pe discul dur D:, pe discul dur E: sau pe CD-
ROM – F:.

Dacă dorim să examinăm conţinutul unui folder de pe un
mediu de stocare – acelaşi dublu clic – şi se deschide fereastra ce
dezvăluie conţinutul folderului.

Datele principale ale unei ferestre

Să examinăm îndeaproape o fereastră din acestea. Ce elemen-
te cuprinde ea? Să deschidem fereastra în care putem examina
conţinutul discului dur DATE.

În colţul din stânga sus, apare denumirea discului dur, ce are
după ea o linie aplecată spre stânga: D:\.

D:\ este „rădăcina discului dur „D:“. Spunem că în acest mo-
ment ne aflăm în rădăcina discului dur D:.
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Când nu ne aflăm în rădăcină, atunci ne aflăm într-un folder
sau sub-folder. În acest caz, după bara oblică apar numele
folderului şi/sau sub-folderului/(sub-folderelor). Această notaţie se
numeşte Path /pɑːθ/ calea către un fişier.

De exemplu:

C:\Poezii\Ghelmez\Toamna\

e calea către fişierele ce cuprind poezii despre toamnă scrise de
Petre Ghelmez (aşa cum le-am organizat eu pe calculator).

În colţul din dreapta sus al ferestrei, apar trei butonaşe.
Primul butonaş e marcat cu o linie orizontală. Acesta este

butonul de “minimizare”, adică de făcut fereastra mică. Dacă
apeşi pe el, fereastra dispare de pe ecran, deşi rămâne deschisă şi
e gata să reapară. De unde ştii că e încă deschisă? Uită-te la baza
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Aceasta este fereastra prin care pot vedea conţinutul discului dur D: de pe
calculatorul meu. Este posibil ca tu să ai un singur disc dur, numit C:,

iar D: să fie atribuit CD-ROM-ului.



ecranului, pe bara de funcţiuni. Vezi un buton cu iconiţa discului
dur şi cu inscripţia D:\. E fereastra noastră, refugiată la baza
ecranului. Dacă facem clic pe acel buton, fereastra lui D:\ reapare
pe ecran.

Al doilea butonaş este marcat cu un pătrat. E chiar desenul
unei ferestre ca şi aceasta pe care o examinăm. Dacă apăsăm pe
ea, atunci se întâmplă două lucruri: în primul rând, fereastra D:\
va ocupa tot ecranul; în al doilea rând, pe acest butonaş nu mai
apare desenul unei singure ferestre, ci desenul a două ferestre,
una în spatele celeilalte. E butonul de „maximizare“ (mărire până
la cele mai mari dimensiuni posibile: tot ecranul).

Al treilea butonaş are un semn X. Dacă apeşi pe el, îi pui
cruce ferestrei. Adică dispare, se închide, pleacă. Şi va trebui s-o
rechemăm din My Computer /maı kəmpjuːtər/.

Pune indicatorul mouse-ului, pe rând, pe fiecare dintre aceste
trei butonaşe. Apar descrierile lor: Minimize /mınımaız/ minimi-
zează, Maximize /mæksımaız/ maximizează, Close /kləʊz/ închide.

Să de-maximizăm fereastra (adică să n-o mai lăsăm să se
afişeze pe tot ecranul): apăsăm pe butonaşul al doilea.

Să ne uităm în colţul din dreapta jos. Acolo apar trei linii
oblice. Dacă prindem cu indicatorul mouse-ului acel colţ şi ţinem
butonul mouse-ului apăsat, putem mări sau micşora fereastra
după dorinţă (numai să nu dorim să ieşim cu ea în afara
ecranului!). Când maximizăm fereastra, această opţiune dispare.

Sub bara de sus a ferestrei pe care apar celei trei butonaşe
prezentate, se află un rând de butoane. Ele sunt titlurile urmă-
toarelor meniuri:

• File /faıl/ lucru cu fişierele/fişier
• Edit /edıt/ editare/editează
• View /vjuː/ vedere/vezi/înfăţişare
• Go /gəʊ/ du-te
• Favorites /feıvəorəts/ preferate
• Help /help/ ajutor
Meniurile îţi oferă posibilitatea de a alege între diferite co-

menzi. Important e să reţii următoarele:
Selectând File > New /njuː/ nou > Folder, creezi un folder nou

în D:\.
Dar un folder nou în rădăcina discului D: creezi şi dacă poziţi-

onezi indicatorul mouse-ului în această fereastră (ai grijă să nu
atingi un folder sau un fişier existent), apeşi pe butonul din dreap-
ta mouse-ului, iar din meniul ce apare alegi New > Folder.
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Selectând View /vjuː/ > Large Icons /lɑːrʤ aıkɔnz/ iconiţe mari,
vei vedea fişierele sau folderele din D:\ ca pe nişte iconiţe mai
mari.

Selectând View /vjuː/ > Little Icons /lıtl aıkɔnz/ iconiţe mici, vei
vedea fişierele sau folderele din D:\ ca pe nişte iconiţe mai mici.

Selectând View /vjuː/ > List /lıst/ listă/listează sau View /vjuː/ >
Details /diːteılz/ detalii – vezi şi tu ce se întâmplă!

Cum ştergem un fişier sau un folder

Uită-te pe desktop. Vezi coşul de gunoi? E desenat pe ecran.
Se numeşte Recycle Bin /riːsaıkl bın/, pe limba noastră, coşul pen-
tru reciclare. Nu are loc nicio reciclare, e doar o metaforă. Ce
arunci acolo, dispare de pe calculator. Nu se reciclează, adică nu
reintră în procesul de producţie. Ce se va refolosi, însă, e spaţiul
rămas liber pe discul dur după ştergerea unui fişier sau a unui
folder.

E drept că nu totdeauna ce aruncăm în coş dispare imediat –
şi deci spaţiul nu va fi încă eliberat. Când ştergem un fişier relativ
mic, coşul de gunoi îl păstrează până îi dăm noi comanda să-l
şteargă de tot. Dar, când punem în el un fişier (foarte) mare,
ţâşneşte cu zgomot, chiar din mijlocul ecranului nostru, o feres-
truică de avertizare. Ea ne spune că fişierul este prea mare pentru
coşul de gunoi – şi ne întreabă dacă vrem să-l ştergem de tot.

E bine să ne gândim de două ori înainte de a şterge ceva de
tot. Poate am vrut să ştergem altceva şi aruncăm un fişier
important la coşul de gunoi. Câtă vreme acel fişier important este
încă în coşul de gunoi, nimic nu e pierdut. Îl scoatem de acolo şi
îl punem din nou pe discul dur sau pe desktop. Dar dacă l-am
şters de tot – e o mare problemă. Trebuie să luăm totul de la înce-
put (să recreăm fişierul) – ca la Cooperativa Munca în Zadar (o
unitate „productivă“ afiliată la Tăierea Frunzei la Câini).

Aruncăm, scoatem... Cum facem aceste operaţii? Cum
ştergem ceva de pe desktop, de pe dischetă sau de pe discul dur?
Cum recuperăm acel document din coşul de gunoi?

O să vezi că rareori la calculatoare un lucru se face într-un
singur fel. De cele mai multe ori, acelaşi lucru se poate face în mai
multe feluri.
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Prima metodă de a şterge un fişier

Iată, am pe desktop un fişier de care nu mai am nevoie. Se
numeşte Intrusul.doc. Să dăm intrusul pe uşă afară. Va ieşi prin
mijlocirea coşului de gunoi. Paşii sunt următorii:

Venim cu indicatorul asupra iconiţei Intrusul.doc.
Îl selectăm, adică apăsăm pe butonul din stânga: dacă s-a

albăstrit, înseamnă că a fost selectat. (Atenţie: nu apăsăm de două
ori rapid pe buton, adică nu facem „dublu clic“, pentru că atunci
se deschide fişierul.)

Ţinem butonul apăsat şi mişcăm de mouse. Vom vedea că,
atâta timp cât butonul rămâne apăsat, când mişcăm mouse-ul se
mişcă odată cu indicatorul de pe ecran şi o copie a iconiţei
fişierului selectat. Aşa cărăm Intrusul.doc spre coşul de gunoi.
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Când Intrusul.doc ajunge pe iconiţa coşului de gunoi, eliberăm
butonul mouse-ului. Ţâşneşte atunci o fereastră de avertizare,
care ne întreabă cu severitate:

Are you sure you want to send Intrusul.doc to the Recycle
Bin?

/ɑː juː ʃʊə juː wɔnt tə send Intrusul.doc tə ðə riːsaıkl bın/

Eşti sigur că vrei să trimiţi Intrusul.doc la coşul de gunoi?

E momentul să ne gândim puţin. Să citim neapărat numele
fişierului – să nu fi selectat alt fişier din greşeală! Nu; e bine.
Suntem siguri. Apăsăm pe butonul Yes /jes/ da al ferestrei de aver-
tizare.

Ce se întâmplă? Intrusul.doc a dispărut de pe desktop, iar coşul
de gunoi şi-a schimbat forma. Înainte arăta că e gol. Acum arată
că e plin.
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Vrem să vedem cum stă Intrusul.doc în coşul de gunoi? Dublu
clic pe coş – şi se deschide fereastra în care apare, cuminte, fişi-
erul proaspăt aruncat.

Vrem să aruncăm un folder, fie el şi plin cu fişiere, la coşul de
gunoi? Procedăm exact la fel: îl selectăm, îl târâm până deasupra
coşului şi îi dăm drumul. Iarăşi apare fereastra de avertizare:

Are you sure you want to remove the folder Folder cu intruşi
and move all its contents to the Recycle Bin?

/ɑː juː ʃʊə juː wɔnt tə rımuːv ðə fəʊldə Folder cu intruşi ənd muːv ɔːl its
kəntents tə ðə riːsaıkl bın/

Eşti sigur că vrei să îndepărtezi folderul Folder cu intruşi şi să
muţi tot conţinutul lui în coşul de gunoi?

Apeşi pe Yes /jes/ – şi ai scăpat de un folder întreg plin de fişie-
re de care nu mai ai nevoie. Ai făcut în acest fel spaţiu pe discul
dur pentru alte fişiere – pentru cele utile.

Ca să ştergem de tot fişierele aruncate în coş, trebuie să golim
coşul. Ca să golim coşul,

• fie facem dublu clic pe coş, selectăm meniul File /faıl/ fişier
şi selectăm comanda Empty Recycle Bin /empti riːsaıkl bın/,

• fie selectăm coşul, apăsăm pe butonul din dreapta al
mouse-ului şi selectăm aceeaşi comandă din meniul ce apare pe
ecran.

În ambele cazuri vedem o fereastră ce ne cere confirmarea
pentru golirea coşului – ceea ce reprezintă ştergerea definitivă a
fişierelor şi folderelor aflate în coş:

Are you sure you want to delete these 2 items?

/ɑː juː ʃʊə juː wɔnt tə dıliːt ðiːz tuː aitəmz/

Eşti sigur că vrei să ştergi aceste două obiecte?

Confirmăm apăsând pe Yes /jes/ da. Iconiţa reprezintă acum
un coş gol.

Dacă fişierul de şters e pe discul dur, şi nu pe desktop?
Deschidem fereastra discului dur căutat – să zicem discul C:.
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A doua metodă de a şterge un fişier sau un
folder

Selectăm folderul sau fişierul de şters. Apăsăm pe butonul din
dreapta al mouse-ului. Din meniul ce apare, selectăm Delete /dıliːt/
elimină/şterge – tastă marcată uneori Del.

Cum ştergem mai multe fişiere sau/şi
foldere deodată

Selectăm primul fişier (folder). Apoi, ţinem apăsată tasta Ctrl
= control /kəntrəʊl/ control. Continuăm să facem clic pe celelalte
fişiere sau foldere pe care dorim să le ştergem. Lăsăm liberă tasta
Ctrl. Punem indicatorul mouse-ului pe unul dintre fişierele
(folderele) selectate. Fie îl tragem către coşul de gunoi – şi toate
cele selectate vor merge odată cu el; fie apăsăm pe butonul din
dreapta al mouse-ului şi alegem Delete /dıliːt/ elimină/şterge.

Prima metodă de a copia un fişier sau un
folder de pe un mediu (suport) de stocare pe alt
mediu de stocare

Vrem să copiem un fişier de pe dischetă pe discul dur D:. Des-
chidem două ferestre (normale, nu maximizate): una pentru dis-
chetă, alta pentru D:. Agăţăm cu mouse-ul fişierul sau folderul pe
care dorim să-l copiem şi îl tragem în fereastra lui D:. Acum avem
fişierul sau folderul şi colo şi colo.

Alte metode de copiere

Selectăm fişierul. Apăsăm pe butonul din dreapta mouse-ului.
Din meniul ce se deschide, selectăm comanda Copy /kɔpi/ copiază.
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Facem clic în interiorul ferestrei discului D:. Apăsăm din nou pe
butonul din dreapta mouse-ului. Selectăm Paste /peıst/ inserează
/lipeşte. Asta e.

De fapt, Copy and Paste /kɔpi ənd peıst/ copiază şi inserează se
mai poate rezolva într-un fel. (Asta ar fi a treia metodă!) Selectează
fişierul din A: (de pe dischetă). Alege File > Copy. Clic pe fereastra
lui D:. Alege pe fereastra lui D: File > Paste.

Şi mai e o metodă (a patra?!): combinaţii de taste. Selectezi.
Cu Ctrl + C (adică ţii apăsat pe Ctrl şi apeşi scurt pe C) copiezi.
Clic pe fereastra lui D: (ca s-o activezi). Cu Ctrl + V inserezi.

Sunt mai multe modalităţi de a-i dicta calculatorului ce să
facă. Alege-o pe aceea care îţi vine la îndemână în clipa respectivă.

Mutarea fişierelor (dosarelor) de pe un mediu
de stocare pe altul

Mutarea e un fel de copiere la care fişierul sau dosarul trece
cu totul pe noul mediu de stocare (dispare de pe primul mediu, de
unde e mutat).

O putem face prin deplasarea cu mouse-ul dintr-un loc în
altul. Dar, dacă vrem s-o facem aşa, procedăm din două mişcări.
Întâi copiem fişierul (dosarul). După aceea, ducem la coşul de
gunoi fişierul (dosarul) de pe primul mediu de stocare (exemplarul
original).

Dacă însă aplicăm metoda cu meniuri, e mai simplu. Proce-
dăm ca şi la copiere, dar, în loc să alegem comanda Copy /kɔpi/
copiază, alegem comanda Cut /kʌt/ taie.

Dacă preferăm metoda combinaţiei de taste (că ajunge să te
doară încheietura mâinii tot lucrând cu mouse-ul), în loc de Ctrl
+ C copiază, alegem Ctrl + X taie. Apoi Ctrl + V lipeşte / inserează
în fereastra de destinaţie (nu uita s-o activezi cu un clic de mouse
în interiorul ei).

Cum instalăm un periferic

Ai cumpărat o imprimantă nouă. E ultimul răcnet în materie.
Calculatorul n-a auzit de acest model (deşi mai mult ca sigur că a
auzit de marcă, sau măcar de producător). Nu poate lucra cu
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imprimanta până nu instalează driverul realizat de producător
special pentru acel model de imprimantă.

Odată cu imprimanta, primeşti şi un CD (sau o dischetă) cu
driverul ei.

Trebuie să conectezi imprimanta la unitatea de bază printr-un
port potrivit. Apoi dai drumul calculatorului. Mai mult ca sigur, el
va „simţi“ că are un organ nou în „corp“. O fereastră de avertizare
îţi va spune că a descoperit o nouă piesă hard şi că încearcă s-o
instaleze – s-o integreze în sistem. Se va uita întâi în sertarele sale
cu drivere. Dacă va găsi driverul potrivit, îl va instala şi apoi va
comunica cu imprimanta. Îţi va spune şi ţie că totul e în ordine şi
va deschide interfaţa către tine, să te apuci de lucru.

Dacă nu va găsi driverul potrivit, îţi va cere discul fabrican-
tului. Atunci introduci fie discheta, fie CD-ul în unitatea respec-
tivă şi apeşi pe tasta Enter /entər/ intră/rând nou. Calculatorul va
copia driverul şi va termina instalarea imprimantei. Apoi, im-
primanta şi calculatorul se comportă de parcă ar fi fost împreună
dintotdeauna.

Dacă, pentru un motiv sau altul, nu se poate face instalarea,
iarăşi îţi apare o fereastră de avertizare, care îţi va spune acest
lucru. Atunci, mergi tu frumos la Start > Settings > Control
Panel. Din folderul Control Panel /kəntrəul pænl/ tabloul de
control/comandă, selectează Add New Hardware /æd njuː hɑːrdweər/
adaugă noi componente hard. Dublu clic – şi urmează instruc-
ţiunile din fereastra ce se va deschide. Cu puţin noroc, totul va fi
OK.

Dacă nu va fi OK, du imprimanta înapoi şi cere una în bună
stare de funcţionare. Imprimanta aceasta are un defect de fabri-
caţie.

Instalarea de aplicaţii (programe)

Ca şi componentele hard periferice, şi componentele soft
numite aplicaţii sunt instalate de către sistemul de operare.

Producătorii de programe (aplicaţii) realizează de obicei
acelaşi program în mai multe versiuni, fiecare versiune fiind
adaptată pentru câte un anumit sistem de operare.

Ce înseamnă să instalăm un program (o componentă soft)?
Programul (aplicaţia) vine sub forma unui kit de instalare – de

obicei, un CD-ROM, pe care îl introducem în cititorul de CD-ROM.
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Imediat ce îl introducem, calculatorul îl „simte“. Se lansează un
utilitar – Windows Install /wındəʊz ınstɔːl/ – care pas cu pas va
instala programul. În decursul instalării, de multe ori îţi cere şi ţie
să intervii. Te poate întreba cum te cheamă, unde lucrezi, dacă
vrei să foloseşti o parolă etc. De cele mai multe ori îţi cere un
număr – un cod care identifică exemplarul respectiv de CD-ROM.
Aceasta pentru a se împiedica furtul aplicaţiei – sau instalarea sa
ilegală.

În decursul procesului de instalare a unei aplicaţii, utilitarul
de instalare copiază pe discul dur fişierele necesare executării
programului. Apoi adaugă în sub-meniul Programs /prəʊgræmz/
programe numele noii aplicaţii şi iconiţa ei specifică. Dacă doreşti,
îţi pune iconiţa şi pe desktop, ca s-o poţi folosi pentru lansarea
programului în mod direct, adică fără să mai selectezi Start >
Programs şi apoi numele aplicaţiei.

Dacă introducem CD-ROM-ul unei aplicaţii şi nu se lansează
utilitarul de instalare, atunci putem noi să-l lansăm. Pentru
aceasta, avem câteva posibilităţi de acţiune. Putem

• fie să mergem la Start > Settings > Control Panel şi să
facem dublu clic pe Install/Remove Programs /ınstɔːl/rımuːv
prəʊgræmz/ instalează/îndepărtează programe; când se deschide
acest utilitar, apăsăm pe Install /ınstɔːl/ instalează; calculatorul
caută singur programul de instalat, întâi pe dischetă, apoi, dacă
nu-l găseşte acolo, pe CD-ROM; apoi selectează un executabil
(adică un fişier cu extensia exe /iː eks iː/) care se numeşte Setup
/set ʌp/ sau Install /ınstɔːl/;

• fie să selectăm Start > Run, apoi să deschidem Browse
/braʊz/ caută/răsfoieşte şi să selectăm noi executabilul Setup.exe
/set ʌp iː eks iː/ sau Install.exe /ınstɔːl iː eks iː/ (sau un alt nume care
cuprinde cuvintele setup sau install);

• fie să deschidem fereastra de CD-ROM (My Computer >
F:) şi să facem dublu clic pe Setup.exe /set ʌp iː eks iː/, sau pe
Install.exe /ınstɔːl iː eks iː/.

De acolo mai departe, utilitarul de instalare preia controlul şi
îşi face treaba.
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Windows XP

Toate cele învăţate despre Windows 98 /wındəʊz naınti eıt/ te
ajută să înţelegi Windows XP /wındəʊz eks piː/, sistemul de operare
cel mai recent lansat de Microsoft.

Fiind mai nou, sistemul de operare Windows XP /wındəʊz eks
piː/ este mult mai stabil, mai robust, decât celelalte sisteme de
operare de tip Windows. După instalarea componentelor noi hard
sau soft, sau după schimbarea unor setări, nu mai e nevoie să
reporneşti sistemul. Sunt aduse numeroase îmbunătăţiri şi, de-
sigur, când ai de ales între această platformă şi alte platforme
Windows, atunci nu greşeşti dacă optezi pentru Windows XP
/wındəʊz eks piː/.

Windows XP /wındəʊz eks piː/ are un design mult mai frumos.
Iconiţele sunt desenate mai atrăgător. Unele comenzi sunt dis-
puse puţin diferit.
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Folosesc Start > Run pentru a cere calculatorului să instaleze aplicaţia
pentru crearea de pagini web numită Dreamweaver.
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Deşi înfăţişarea ecranului de pornire şi a ferestrelor diferă
puţin, principiile rămân aceleaşi ca şi la celelalte versiuni de
Windows.

Cum închizi calculatorul?

Start > Shut Down va deschide... „fereastra de închidere a
calculatorului“. Chiar aşa se cheamă fereastra: Shut Down
Windows /ʃʌt daʊn wındəʊz/ închide platforma Windows. Această
fereastră de dialog te întreabă:

What do you want your computer to do?
/wɔt duː juː wɔnt jɔːr kəmpjuːtər tə duː/
Ce vrei să execute calculatorul tău?
Şi îţi oferă patru opţiuni. Dintre acestea, două sunt mai des

folosite:
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Aruncăm o ocheadă pe discul dur C: al unei platforme Windows XP.



• Shut down /ʃʌt daʊn/ închide-te; – dacă o alegi pe aceasta,
calculatorul se va închide sau îţi va spune când ai voie să închizi
tu comutatorul de reţea.

• Restart /ristɑːrt/ reporneşte; – dacă o alegi pe aceasta,
calculatorul se va închide şi se va redeschide. Comanda Restart
/ristɑːrt/ e utilă în diverse cazuri – de exemplu, după ce am instalat
unul sau mai multe aplicaţii noi, după ce am schimbat anumite
setări pentru ca acestea să aibă efect (în special la Windows 98
/wındəʊz naınti eıt/) sau când vreo aplicaţie se blochează şi vrem să
luăm totul de la capăt ca să evităm manifestările neplăcute ale
unei erori de program (gândăcel...).

Repet: nu închide calculatorul fără să foloseşti comanda shut
down /ʃʌt daʊn/ închide-te!
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Prin fereastra de închidere a calculatorului ne luăm rămas bun
de la calculator până la viitoarea şedinţă de lucru. Nu închide calculatorul prin

scoaterea din priză sau prin apăsarea comutatorului ca la pornire!
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4. Microsoft Office

Ansambluri de aplicaţii pentru birouri

Produsele soft /sɔft/ cele mai utile sunt aşa numitele Office
Applications /ɔfıs æplıkeıʃnz/ – ansambluri de aplicaţii pentru bi-
rouri. Se numesc aşa pentru că ele răspund tuturor nevoilor pe
care un funcţionar le are în munca sa de birou. Ele se vând fie
individual – cumperi doar o componentă a pachetului de aplicaţii
–, fie ca suită pentru birouri – cumperi un pachet care include
toate aplicaţiile respective.

Un ansamblu de aplicaţii pentru birouri cuprinde de obicei:
• un program de prelucrare de texte – care te ajută să creezi,

să corectezi, să formatezi (să dai un format atrăgător) şi să
imprimi lucrări cu aspect grafic impecabil;

• un program tabelar – care te ajută să creezi tabele cuprin-
zând informaţii sistematizate; prin încorporarea unor formule în
pătrăţelele tabelelor, poţi crea tabele active, la care schimbarea
unei valori într-un pătrăţel atrage actualizarea valorilor din alte
pătrăţele;

• un program de prezentare grafică – pentru a crea
„diapozitive“ cuprinzând texte şi desene, pe care să le poţi proiecta
pe un ecran, unul după altul, ca suport grafic pentru o cuvântare
sau o conferinţă;

• un program de baze de date – ca să înregistrezi informa-
ţiile într-o formă bine structurată şi să le poţi extrage şi oferi în-
tr-o formă semnificativă;

• un program pentru navigare pe Internet,
• un program de poştă electronică,
• un program pentru realizarea de pagini de web.
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Ansamblul de aplicaţii pentru birouri folosit
pe platformele Windows

Pentru platformele Windows 98 /wındəʊz naınti eıt/, Windows
XP /wındəʊz eks piː/, Windows Vista /wındəʊz vıstə/, ca şi pentru alte
platforme Windows, există ansamblul de aplicaţii pentru birouri
numit Microsoft Office /maıkrəsɔft ɔfıs/. Acesta cunoaşte mai multe
versiuni – Office 97 /ɔfıs naınti sevn/, Office 2000 /ɔfıs tuː θauznd/,
Office 2003 /ɔfıs tuː θauznd ənd θriː), Office 2007 /ɔfıs tuː θauznd ənd
sevn). Microsoft Office cuprinde:

Microsoft Word /maıkrəsɔft wəːrd/ – aplicaţie pentru prelucrare
de texte; word /wəːrd/ = cuvânt;

Microsoft Excel /maıkrəsɔft ıksel/ – aplicaţie pentru realizare şi
prelucrare de tabele; excel /ıksel/ = a excela, a depăşi;

Microsoft Power Point /maıkrəsɔft paʊər pɔınt/ – aplicaţie pentru
prezentări cu elemente grafice; power /paʊər/ = putere, electricitate; point
/pɔınt/ = punct; power point /paʊər pɔınt/ = priză electrică, punct de forţă;

Microsoft Access /maıkrəsɔft ækses/ – aplicaţie pentru baze de
date; access /ækses/ = acces;

Microsoft Outlook /maıkrəsɔft aʊtlʊk/ – aplicaţie de poştă elec-
tronică; outlook /aʊtlʊk/ = perspectivă, privelişte, punct de vedere;

Microsoft Front Page /maıkrəsɔft frʌnt peıdʒ/ – un program
pentru realizarea de pagini de web /web/ pânză de păianjen, reţea;
front /frʌnt/ = frunte, frontispiciu, front; page /peıdʒ/ = pagină; front
page /frʌnt peıdʒ/ = pagina de titlu, prima pagină.

Microsoft Office /maıkrəsɔft ɔfıs/ nu include un program de
navigare pe Internet (i se mai spune şi browser /braʊzər/ explorator
de pagini de web, cel ce parcurge texte sau informaţii), pentru că
Microsoft oferă separat, gratuit, browser-ul său numit Internet
Explorer /ıntərnet ıksplɔːrər/.

Pe lângă aplicaţia de poştă electronică Microsoft Outlook
/maıkrəsɔft aʊtlʊk/, ce face parte din Microsoft Office /maıkrəsɔft ɔfıs/,
compania Microsoft oferă şi o altă aplicaţie de poştă electronică,
numită Outlook Express /aʊtlʊk ıkspres/. Oricare dintre ele este la
fel de bună. Eu lucrez cu Outlook Express /aʊtlʊk ıkspres/ din
obişnuinţă. Tu poţi să le explorezi pe amândouă şi să te opreşti la
cea care îţi place mai mult.

98



Open Office

Există un ansamblu de aplicaţii pentru birouri numit Open
Office /əʊpn ɔfıs/, pe care îl poţi obţine gratuit de pe Internet de la
următoarea adresă: http://www.openoffice.org/. Dacă nu ai bani să
cumperi Microsoft Office /maıkrəsɔft ɔfıs/, descarcă şi instalează
Open Office /əʊpn ɔfıs/. Alege versiunea potrivită pentru sistemul
tău de operare. Atenţie, însă: durează ore să-l descarci printr-o
conectare dial-up /daıəl ʌp/ prin telefon şi s-ar putea să te coste
mult telefonul din cauza aceasta.

Şi acum, să creăm fişierele proprii!

Până acum te-am bombardat cu informaţii despre ce e şi cu
ce se mănâncă un calculator. Ţi-am dat foarte puţine indicaţii
practice – şi anume atunci când te-am pus să vezi, să ştergi, să
copiezi şi să muţi fişiere sau foldere şi când te-am învăţat să creezi
foldere şi sub-foldere. Dar nu ai avut ocazia să creezi niciun fişier
al tău.

Ei bine, a trebuit s-o fac. Am vrut să te ajut să înţelegi ce se
petrece dincolo de ecranul monitorului – şi să nu lucrezi ca legat
la ochi. Dar a venit şi marele moment. Vei învăţa să produci docu-
mente scrise. Vei lucra cu Microsoft Word /maıkrəsɔft wəːrd/.

Dacă înveţi să lucrezi cu o aplicaţie de prelucrare de text,
deprinderile pe care le capeţi te ajută să te adaptezi la toate
aplicaţiile similare. Când nu înţelegi cum se face ceva anume,
există întotdeauna un meniu Help /help/ ajutor sau un manual
tipărit la care te poţi duce – şi vei avea marele avantaj că vei şti
precis ce cauţi.

În Microsoft Word, ai voie să greşeşti

Înainte de a deschide aplicaţia Word şi a tasta primele
caractere, să-ţi spun un mare secret: AI VOIE SĂ GREŞEŞTI!
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La maşina de scris nu prea aveai voie. Dacă băteai un caracter
greşit, era un mare chin să-l corectezi. Scoteai puţin foaia din maşină.
Îţi trebuia pastă corectoare (aşa-zisa hârtie lichidă), pe care o aplicai
cu mare grijă, folosind o pensulă, exact peste caracterul greşit.
Aşteptai un minut-două să se usuce (sau suflai în picătura de hârtie
lichidă ca în lingura cu supă fierbinte). Dacă aveai cópii la indigo,
trebuia să acoperi litera greşită pe toate copiile. Iar aşteptai (sau
suflai). Apoi tot cu mare grijă aduceai hârtia la loc. De multe ori, litera
corectă pica alături... nici nu mai vreau să-mi amintesc! Nu mai spun
că, pe vremea maşinilor de scris, pasta corectoare era în ţara noastră
de negăsit. Şi că însăşi maşina de scris era sub strict control şi
trebuia s-o prezinţi periodic la poliţie, pentru amprente! Numai prin
comparaţie îţi poţi da seama ce libertate de creaţie, de expresie şi de
comunicare îţi aduce azi calculatorul!

În Word: ai greşit, nu-i nimic. Ai mai multe posibilităţi de
corectare. Ţine minte – acum – una dintre ele: combinaţia de taste
Ctrl + Z. Ţii apăsat pe tasta Ctrl şi apeşi pe tasta Z. În acest fel
revii la situaţia de dinaintea ultimei comenzi. Dacă repeţi combi-
naţia, revii la situaţia de dinaintea penultimei comenzi. Şi tot aşa
– un număr de paşi poţi să-i faci înapoi.

Vai, ai făcut prea mulţi paşi înapoi! Ce te faci? Opusul combi-
naţiei Ctrl + Z este Ctrl + Y. Revii pas cu pas spre situaţia care îţi
convine, aplicând combinaţia Ctrl + Y de câte ori este nevoie.

Word-ul nu e greu pentru nimeni. Nici pentru bunici, nici
pentru (pre)şcolari. Totul e să cunoşti literele!

Să deschidem Word-ul

Te aşezi la masa de lucru. Calculatorul este stins. Ce faci?
Desigur, apeşi pe comutatorul de pe unitatea de bază. Apoi

aştepţi. Se instalează sistemul de operare. Peste un minut, două,
apare interfaţa cu utilizatorul (desktopul).

Ai pe desktop o iconiţă a programului Word?
Dacă da, atunci poţi s-o iei pe calea scurtă (iconiţa se cheamă

în engleză shortcut /ʃɔːrtkʌt/ scurtătură); dublu clic pe ea, şi Word-ul
se deschide.

Dacă nu, selectează:

Start > Programs > Microsoft Word.
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Vrei să-ţi faci o scurtătură (o iconiţă) pentru a deschide
Word-ul din prima? Selectează:

Start > Programs > Microsoft Word.

Apasă pe butonul din dreapta mouse-ului. Alege comanda
Create Shortcut /krieıt ʃɔːrtkʌt/ creează scurtătură.

La sfârşitul meniului va apărea iconiţa Microsoft Word
/maıkrəsɔft wəːrd/. Trage-o cu mouse-ul pe desktop. Aceasta e scurtă-
tura ta pentru deschiderea Word-ului.

S-a deschis Word-ul; ce vezi?

Vezi, desigur, fereastra în care rulează Word-ul. Sus e bara de
titlu. Pe ea apar, în stânga, iconiţa Word (un W mare pe o foaie de
hârtie), titlul fişierului – deocamdată titlul generic Document1 şi
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Fereastra ne arată că s-a deschis aplicaţia Microsoft Word. Ea ne prezintă o
pagină albă, pe care putem să scriem pentru a realiza un document nou. Titlul

provizoriu (dat de Word) al acestui document este Document1. Pe pagina albă se
vede cursorul, care indică locul unde va apărea litera tastată de noi.



numele programului – Microsoft Word /maıkrəsɔft wəːrd/. Tot pe
bara de titlu, în dreapta, vezi butonaşele de micşorare, mărire şi
închidere a ferestrei.

Imediat sub bara de titlu se află bara de meniuri:
• File /faıl/ lucru cu fişierele/fişier
• Edit /edıt/ editare/editează
• View /vjuː/ vedere/vezi/înfăţişare
• Insert /ınsəːrt/ inserează
• Format /fɔːrmæt/ formatează
• Tools /tuːlz/ unelte
• Table /teıbl/ tabel
• Window /wındəʊ/ fereastră
• Help /help/ ajutor
Sub bara de meniuri, avem una sau mai multe bare cu

butoane care corespund celor mai frecvente comenzi din meniuri,
astfel încât să le putem accesa direct – şi deci să facem cât mai
puţine mişcări pentru a le folosi.

Sub bara cu butoane apare o riglă orizontală, care ne ajută să
fixăm alineatele după cum dorim noi.

La stânga ferestrei apare rigla verticală, de care ne vom folosi
pentru aranjarea textului în pagină.

În mijloc apare pagina pe care vom scrie. Vedem cursorul.
Dacă tastăm o literă, ea va apărea în locul indicat de cursor – iar
cursorul se va deplasa spre dreapta, ca să indice locul următoarei
litere. Cursorul este o bară verticală care pulsează pe ecran, de
parcă ar spune „aici, aici“.

La baza ferestrei vedem o altă bară. Aceasta ne spune:
• pe ce pagină şi în ce secţiune a documentului ne aflăm:

Page 1 Sec(tion) 1; page /peıdʒ/ pagină, section /sekʃn/ secţiune;
• la ce poziţie faţă de marginea de sus a colii de hârtie se

află cursorul: At /æt/ 25 mm la 25 de milimetri;
• pe ce linie şi pe ce coloană de litere se află cursorul: Ln 1,

Col 1 (linia 1, coloana 1)
• etc.
Deasupra barei cu informaţii privind poziţia cursorului, vedem

bara de poziţionare orizontală. E bara de deplasare orizontală a
paginii. Pe ea apar două butoane cu săgeţi la dreapta şi la stânga.
Trăgând de ele cu mouse-ul (ţine butonul apăsat), mutăm pagina
mai la stânga sau mai la dreapta în cadrul ferestrei.

Pe latura din dreapta a ferestrei apare bara de poziţionare
verticală. Butoanele ei deplasează pagina în sus şi în jos.
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Primele litere; litere mici, litere mari, Shift
şi Caps Lock

Hai să scriem ceva!
Ce vrei să scrii? Îţi plac poeziile? Mie – da, foarte mult. Iar

poetul meu preferat este (ai ghicit, oare?) Petre Ghelmez.
Hai să introducem câteva versuri de Petre Ghelmez. Titlul:

Laudă limbii române (cu poezia aceasta, Ghelmez a luat un pres-
tigios premiu internaţional). Scrie titlul poeziei. Cu ce începi?
Apeşi pe litera L.

Ce se întâmplă? Pe ecran apare l mic, iar ţie îţi trebuie un L
mare, pentru că titlurile se scriu cu iniţială majusculă. Ca să iasă
L mare, precum ai aflat deja la prezentarea tastaturii, ţine apăsat
pe tasta Shift /ʃıft/ schimbă/schimbare şi apasă pe tasta L. Shift
+ L este L mare. Shift + orice literă dă o majusculă.

Dar dacă vrem să scriem tot titlul cu majuscule?
Atunci apăsăm pe Caps Lock /kæps lɔk/ fixează pe majuscule/

tasta pentru majuscule: caps /kæps/ = capitals /kæpıtlz/ = litere ma-
juscule; lock /lɔk/ = lacăt. Se aprinde o luminiţă pe tastatură,
deasupra tastelor, la dreapta. Lângă luminiţă este scris un A
mare. Cât timp luminiţa aceasta stă aprinsă, nu mai e nevoie să
apăsăm pe tasta Shift /ʃıft/: pe orice literă apăsăm, aceasta apare
ca literă majusculă. Mai mult, dacă apăsăm pe Shift + literă,
litera apare de data aceasta mică.

Pentru a reveni la situaţia normală (Shift + literă = literă ma-
jusculă), apăsăm din nou pe Caps Lock /kæps lɔk/ fixează pe ma-
juscule/tasta pentru majuscule. Luminiţa dispare, iar literele apar
ca litere mici.

Literele specifice alfabetului limbii române

Scrie cuvântul Laudă. Ce observi? Litera ă nu apare pe
tastatură. Ce să facem? Cum?!... S-o înlocuim cu a? Dar nu vreau
să scriu Lauda, ci Laudă. Lauda este laudă + articolul hotărât -a.
Pe urmă ce fac cu â? Poezia se numeşte Laudă limbii române, nu
Lauda limbii romane! Limba romanilor (latina) a fost cântată de
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alţi poeţi. Oare calculatorul nu cunoaşte literele cu diacritice
(literele ă, â, ş, ţ, î, Ă, Â, Ş, Ţ, Î)? Sau nu cunoaşte literele cu
accente din franceză şi germană (é, è, ê, ü etc.)?

Ba da. Dar nu întotdeauna sunt ele arătate pe tastatură.
Dacă eşti norocos şi ai o tastatură cu taste corespunzătoare

literelor cu diacritice româneşti, nu ai nicio problemă. Dacă nu, ai
două soluţii (ştii că la calculatoare ai mai mult de o soluţie pentru
majoritatea problemelor!)

Prima, poate mai profesionistă, este să mergi la Start >
Settings > Control Panel > Keyboard (tastatură) > Language, să
urmezi instrucţiunile pentru instalarea tastaturii pentru limba
română şi să schimbi codurile trimise de taste, astfel încât să
adaptezi tastatura ta la scrierea limbii române. Dezavantajul: nu
mai corespund toate tastele cu ceea ce e scris pe ele.

Tasta {[ îţi va produce pe ecran Ă şi ă; tasta }] – Î şi î; tasta |\
– Â şi â; tasta :; – Ş şi ş; tasta „‘ – Ţ şi ţ. Două puncte, punct şi
virgulă, semnul întrebării, linia de pauză şi cratima îşi schimbă şi
ele locurile pe tastatură. Sigur, le găseşti prin butonare!

A doua soluţie, poate mai intuitivă, este să defineşti tu com-
binaţii de taste pentru tastarea literelor cu diacritice.

Eu am adoptat a doua soluţie. Vrei s-o adopţi şi tu? Iată cum
faci:

Pe bara de meniuri, te uiţi după meniul Insert /ınsəːrt/ inse-
rează. Apeşi pe butonul Insert şi selectezi Symbol /sımbl/ simbol.

La versiunile mai noi de Microsoft Word /maıkrəsɔft wəːrd/, de
multe ori, meniurile se afişează sub o formă mai scurtă (se dau
numai comenzile mai importante, nu toate, din acelaşi meniu).
Dacă nu vezi comanda Symbol /sımbl/, fă dublu clic pe butonul
Insert. Aşa apar toate comenzile.

Insert > Symbol îţi oferă o ferestruică numită Symbol /sımbl/
simbol. Apasă pe butonul Symbols /sımblz/ (dacă nu e deja selec-
tat). Uită-te la Subset /səbset/ submulţime; în dreapta sa apare un
buton cu o săgeată în jos. Apasă pe acea săgeată şi selectează (din
lista ce apare în stânga butonului cu săgeată) submulţimea
numită Latin Extended-A /lætın ıkstendıd eı/ litere latine extinse A.

Clic pe litera ă.
Acum apasă pe Shortcut Key /ʃɔːrtkʌt kiː/ tasta de scurtătură.

Evident, se deschide o ferestruică... Poziţionează cursorul (fă un
clic cu mouse-ul) sub Press new shortcut key /pres njuː ʃɔːrtkʌt kiː/
apasă noua tastă de scurtătură. Apasă Alt + A. Apoi apasă buto-
nul Assign /əsaın/ atribuie.
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După ce, în pasul anterior, scrisesem secvenţa Alt + A la Press new shortcut key
(apasă pe noua tastă de scurtătură), acum tocmai am apăsat pe butonul Assign

(atribuie) şi Alt + A a apărut sub Current Keys (tastele curente).

Fereastra Symbol (simbol) ne ajută să inserăm în text litere şi alte semne mai
deosebite. Selectează semnul dorit şi apasă pe Insert.



Continuă să atribui combinaţii de taste semnelor diacritice.
Ca să vezi celelalte semne diacritice româneşti, foloseşte bara de
căutare verticală de pe latura din dreapta a ferestrei Symbol
/sımbl/. În final, vei avea aceste combinaţii (desigur, nu sunt
singurele posibile; dar sunt uşor de ţinut minte):

Ctrl + Alt + A → â
Ctrl + Alt + Shift + A → Â

Alt + I → î
Alt + Shift + I → Î

Alt + A → ă
Alt + Shift + A → Ă

Alt + S → ş
Alt + Shift + S → Ş

Alt + T → ţ
Alt + Shift + T → Ţ

Ţi se pare complicat? La început, este. Dar te vei obişnui
repede. Gândeşte-te la compatrioţii noştri maghiari – sau la vecinii
noştri din Ungaria –, care au în scrierea lor o simfonie de dia-
critice. Scrierea maghiară e foarte frumoasă, ornată cu accente şi
alte semne, dar vei avea nevoie de şi mai multe combinaţii de taste
ca s-o reproduci corect pe calculator. Scrierea cehă de asemenea,
cea slovacă la fel, cea poloneză la fel... Tot Estul Europei e bântuit
de diacritice. Ba chiar toată Europa. Numai pe regina Angliei a
salvat-o Dumnezeu de diacritice – scrierea englezească nu le
foloseşte decât în cuvinte străine (dar nici nu ştii cum să citeşti
cuvintele englezeşti, dacă nu le cauţi în dicţionar). Ba, stai aşa că
mă înşel: nici scrierea italiană nu pune prea mari probleme – şi
nici cea olandeză.

Pentru é cu accent, tastează Ctrl + ’, ia o scurtă pauză şi apoi
tastează e. Iese un é de toată frumuseţea. Pentru É (E mare cu
accent ascuţit) procedezi la fel, numai că după pauză tastezi Shift
+ E.
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Continuă să scrii poezia „Laudă limbii
române“

Ai scris titlul: Laudă limbii române; după titlu nu se pune
punct, iar între titlu şi restul textului trebuie un rând alb. Cum
procedezi? Apeşi pe tasta Enter /entər/ intră/rând nou. Această
tastă indică terminarea rândului de text.

Dacă apeşi din nou pe tasta Enter /entər/ intră/rând nou, ai
creat un rând alb.

Acum scrie numele autorului. De acum poţi să scrii restul
poeziei. În final, vei obţine acest text pe ecran:
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Am scris într-un document Word poezia „Laudă limbii române“ de Petre Ghelmez.



Laudă limbii române

de Petre Ghelmez

Lasă-mă, în patria de cuvinte,
Acum să colind,
În patria de cânturi, de şoapte, de murmure...
Cerul şi pământul,
Într-o rostire de gând,
Cu brâu de aur dulce să le cuprind,
Înţelesuri din veac,
Şi de-acum,
Pe crestele-albite-ale timpului,
Neostenite să drùmure.

Lasă-mă, dragostei mele de tine,
De ţară, de mumă, de frate, de zbor să-i zic dor...
Lasă-mă, răzimat în uşile graiului,
Să plutesc ca pe-un nor,
Dealuri de sunete să urc, să cobor,
Din gura pădurii,
Până la gura câmpului, muntelui, raiului.

Lasă-mă, focul ideii,
Pe plaiul acesta-nstelat, să-l ridic spre cuprindere...
Necuprinsului
Margini să-i fac!
Cuprinsului
Nemărginire şi martor să-i fiu!
O, cât de bogat, cât de sărac
Este sufletul meu în învăpăiata aprindere...
Ce aproape – adevărul din limba vorbită, ce viu!

Piară munţii, piară câmpiile,
Piară stejarii şi apele...
Piară, de vor, ele însele, pietrele!
Nimic, încă, de-ar fi,
Sub privire să nu ne rămână,
Ne-am înălţa, iarăşi – turnuri spre soare – vetrele,
Din puterea aceasta, pururea nouă stăpână,
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Preacurata, biruitoarea-ntru cântec,
Patria din laptele mumei – limba română.

Bravo, arată frumos. Cum ai scris ù din drùmure (cuvânt
inventat de poet)? Ai mers la Insert > Symbol şi l-ai ales de acolo.
Ai apăsat pe butonul Insert, după care ai închis fereastra
Symbol.

Un alt fel de a scrie ù (sau alte litere cu accent grav) este
acesta – în doi paşi:

Apeşi pe Ctrl + `. (Ai grijă, nu confunda ’ cu `. Semnul ` este
în stânga sus pe tastatură.)

Pe urmă eliberezi tastele şi apeşi U. Iese ù. Dacă în loc de U
apeşi E, iese è. Şi aşa mai departe.

Salvează poezia!

Dacă ai în acest moment o pană de curent (Doamne fereşte!),
calculatorul se stinge şi pierzi toată munca! Trebuie să înregistrezi
poezia ca fişier pe un disc dur (sau pe o dischetă). Operaţia se
numeşte salvare – de la un posibil dezastru, nu? De fapt, în acest
caz cuvântul românesc „a salva“ copiază unul dintre sensurile
cuvântului englezesc save /seıv/ a salva / a pune deoparte, a
economisi, a păstra.
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Dacă apeşi pe iconiţa de desktop din coloana de iconiţe din partea stângă a
ferestrei, vei putea apoi să deschizi My Computer (calculatorul meu) pentru

a selecta discul C: şi a face dublu clic pe iconiţa lui.



Vrem să salvăm fişierul Lauda în sub-folderul Ghelmez din
folderul Poezii de pe discul C:.

Pentru crearea folderului, sub-folderului şi salvarea fişierului:
• selectează File > Save sau apasă pe combinaţia de taste

Ctrl + S;
• în fereastra de dialog apărută, mai întâi deschide discul pe

care vrei să înregistrezi (salvezi) fişierul; foloseşte săgeata sau
apasă pe iconiţa Desktop din coloana din stânga ferestrei, apoi pe
iconiţa My Computer /maı kəmpjuːtər/ calculatorul meu; selectează
discul C:; dublu clic, să vezi conţinutul discului C:;

• creează un folder pe discul C: (dacă nu există deja) numit
Poezie; pentru aceasta, apeşi pe iconiţa Create New Folder /krieıt

njuː fəʊldər/ creează folder nou; apare o fereastră de dialog care îţi
cere numele noului folder;
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La dreapta sus poţi vedea iconiţa comenzii Create New Folder (creează folder
nou). Apeşi pe ea pentru a crea folder-ul dorit.

După ce ai apăsat pe Create New
Folder (creează folder nou) şi ai

denumit noul folder Poezii,
folder-ul s-a deschis în fereastra
Save as (salvează ca) şi aşteaptă

să acţionăm în continuare.



• scrie numele noului folder: Poezii; clic pe OK; eşti în
folderul Poezii;

• creează sub-folderul Ghelmez;
• scrie numele fişierului în spaţiul dintre inscripţia File

name /faıl neım/ numele fişierului şi butonul Save /seıv/ salvează;
• apasă pe butonul Save /seıv/.

Putem vedea că s-a salvat fişierul nostru? Avem două căi. Una
este să folosim direct sistemul de operare. Clic pe icoana de desk-
top de pe bara de funcţiuni (lângă butonul Start /stɑːrt/ începe
/început). Apoi My Computer > C:. Vedem folderul Poezii. Dublu
clic pe folderul Poezii. Vedem sub-folderul Ghelmez. Dublu clic pe
sub-folderul Ghelmez. Vedem fişierul Lauda.doc. Extensia fişierelor
create de Microsoft Word /maıkrəsɔft wəːrd/ este doc /dɔk/ (primele
trei litere din cuvântul document).

Altă cale să verificăm că avem deja fişierul – de data aceasta
chiar din fereastra Word-ului:

File > Save as; apare Lauda.doc. Apăsăm pe Cancel /kænsl/
anulează/renunţă.
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Fereastra Save as (salvează ca) ne plasează în sub-folder-ul Ghelmez şi aşteaptă
comanda noastră de salvare a fişierului. Numele fişierului va fi cel scris de noi:

Lauda.doc



Deplasarea cursorului

Recitim textul şi vedem că s-au ivit câteva greşeli de dacti-
lografie. În unele cuvinte ai introdus litere în plus. În altele lipsesc
unele litere. Cum procedezi?

Ei, bine, pentru aceasta trebuie să învăţăm mai întâi să
deplasăm cursorul pe ecran.

Pentru a deplasa cursorul pe ecran, folosim fie mouse-ul – un
clic în locul din text unde dorim să apară cursorul –, fie tastele cu
săgeţi ale tastaturii – dreapta jos.

• Tasta ← duce cursorul cu un caracter (literă sau spaţiu)
mai la stânga.

• Combinaţia Ctrl + ← duce cursorul cu un cuvânt mai la
stânga.

• Tasta → duce cursorul cu un caracter (literă sau spaţiu)
mai la dreapta.

• Combinaţia Ctrl + → duce cursorul cu un cuvânt mai la
dreapta.

• Tasta ↑ duce cursorul vertical pe rândul de mai sus.
• Combinaţia Ctrl + ↑ duce cursorul la începutul para-

grafului de mai sus.
• Tasta ↓ duce cursorul vertical pe rândul de mai jos.
• Combinaţia Ctrl + ↓ duce cursorul la începutul para-

grafului de mai jos.
Ţine minte de asemenea că:
• Tasta Home /həʊm/ acasă/casă duce cursorul la începutul

rândului.
• Tasta End /end/ sfârşit duce cursorul la sfârşitul rândului.

Ce facem dacă am sărit o literă, un cuvânt
sau o secvenţă mai lungă de text

Când am mâncat (sărit) o literă, un cuvânt sau o parte din
text, plasăm cursorul în locul unde trebuie să apară ceea ce s-a
omis şi completăm de la tastatură.
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Ce facem dacă am introdus în plus o literă,
un cuvânt sau o secvenţă mai lungă de text

Când am introdus o literă, un cuvânt sau mai multe cuvinte
în plus, putem folosi fie tasta Delete /dıliːt/ elimină/şterge, fie tasta
Backspace /bækspeıs/ şterge ce e la stânga, astfel:

• Tasta Delete şterge caracterul din dreapta cursorului.
• Combinaţia Ctrl + Delete şterge cuvântul din dreapta

cursorului.
• Tasta Backspace şterge caracterul din stânga cursorului.
• Combinaţia Ctrl + Backspace şterge cuvântul din stânga

cursorului.
Pentru a şterge porţiuni mai lungi de text, e mai rapidă meto-

da selectare + eliminare (tăiere). (Ea se poate folosi şi pentru a
şterge un singur caracter, desigur, dar e mai potrivită pentru por-
ţiuni mai lungi de text.)

Pentru selectare cu ajutorul tastelor, aducem cursorul la
începutul părţii de text pe care dorim s-o selectăm, ţinem apăsat
pe tasta Shift /ʃıft/ schimbă/schimbare şi apăsăm repetat pe tasta
→ , până când partea de text vizată apare scrisă cu litere albe pe
fond negru.

Dacă ţinem apăsat atât pe Shift /ʃıft/, cât şi pe Ctrl şi apăsăm
pe →, selectăm câte un cuvânt întreg la fiecare apăsare pe →.

Operaţiunea de selectare se poate face şi în direcţia opusă
(spre stânga). Pentru aceasta, aducem cursorul la finalul textului
de selectat şi folosim combinaţia Shift + ←. În acest fel, selectăm
caracter după caracter, mergând spre înapoi. Cu combinaţia Shift
+ Ctrl + ←, selectăm spre stânga câte un cuvânt la fiecare
apăsare pe tasta ←.

Când textul de selectat se întinde pe mai multe rânduri sau
paragrafe, putem folosi tastele ↓ (să selectăm de sus în jos) sau ↑
(să selectăm de jos în sus).

Folosind combinaţiile de taste Ctrl + ↓ sau Ctrl + ↑, se
selectează paragrafe întregi la fiecare apăsare pe tasta ↓ sau pe
tasta ↑.

Pentru selectare cu ajutorul mouse-ului, plasăm indicatorul
mouse-ului la începutul părţii de text pe care dorim s-o selectăm,
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apăsăm butonul din stânga şi ţinem apăsat, apoi deplasăm
indicatorul mouse-ului spre dreapta, până terminăm selecţia.

Sau plasăm indicatorul mouse-ului la sfârşitul textului de
selectat şi efectuăm operaţia în direcţie inversă (spre stânga
cursorului).

Pentru eliminarea textului selectat,
• fie apăsăm pe Delete /dıliːt/ elimină/şterge,
• fie apăsăm pe Backspace /bækspeıs/ şterge ce e la stânga,
• fie selectăm Edit /edıt/ editează > Cut /kʌt/ taie,
• fie apăsăm pe Ctrl + X,
• fie plasăm indicatorul mouse-ului peste un punct din

textul selectat, apăsăm pe butonul din dreapta şi alegem comanda
Cut /kʌt/ taie.

Tot ce am selectat dispare.

Cum mutăm porţiuni de text dintr-un loc
într-altul

Când am introdus o îmbinare de cuvinte (sau chiar paragrafe
întregi) într-un loc nepotrivit şi trebuie să le mutăm mai la înce-
putul sau mai la sfârşitul documentului nostru, aplicăm metoda
din doi paşi Taie şi Lipeşte (Cut and Paste /kʌt ənd peıst/).

Pentru primul pas, Cut /kʌt/ taie, întâi selectăm textul de tăiat,
apoi

• fie alegem cu mouse-ul Edit > Cut,
• fie folosim combinaţia de taste Ctrl + X,
• fie ţinem indicatorul mouse-ului pe textul selectat, apă-

săm pe butonul din dreapta şi selectăm Cut /kʌt/.
Pentru pasul al doilea, Paste /peıst/ inserează/lipeşte, plasăm

cursorul unde vrem să intre textul şi
• fie alegem cu mouse-ul Edit > Paste,
• fie folosim combinaţia de taste Ctrl + V,
• fie ţinem indicatorul mouse-ului acolo unde vrem să

introducem text, apăsăm pe butonul din dreapta şi selectăm
Paste /peıst/ inserează /lipeşte.

Textul tăiat din altă parte va fi mutat unde îl inserăm noi.
Atenţie: nu tăia două porţiuni de text una după alta, pentru

că vei putea insera numai ultima porţiune tăiată.
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Cum copiem porţiuni de text dintr-un loc
într-altul

Dacă avem porţiuni de text care se repetă, nu e nevoie să le
introducem de două ori. Aplicăm metoda din doi paşi Copiază şi
Lipeşte (Copy and Paste /kɔpi ənd peıst/ copiază şi inserează).
Seamănă cu metoda Taie şi Lipeşte (Cut and Paste /kʌt ənd peıst/),
dar în loc de comanda Cut /kʌt/ taie, folosim comanda Copy /kɔpi/
copiază. Pasul doi, Paste /peıst/ inserează/lipeşte este identic.

Metodele Taie şi Lipeşte, Copiază şi Lipeşte ne scutesc de mari
eforturi de introducere şi re-introducere de text.

Metoda Găseşte şi Înlocuieşte

Dacă am repetat în mod constant aceeaşi greşeală – de
exemplu, am scris creează cu un singur e, sau am scris creem în
loc de creăm – putem aplica metoda Găseşte şi Înlocuieşte (Find
and Replace /faınd ənd rıpleıs/).

Ca să ne apară fereastra de dialog Find and Replace /faınd ənd
rıpleıs/ găseşte şi înlocuieşte,

• fie selectăm cu mouse-ul Edit > Replace;
• fie folosim combinaţia de taste Ctrl + H.
Fereastra Find and Replace ne dă posibilitatea:
• să găsim, dar nu neapărat să înlocuim: apăsăm pe Find

Next /faınd nekst/ găseşte pe următorul; cuvântul găsit apare
selectat pe ecran;

• să înlocuim pe rând fiecare cuvânt căutat: apăsăm pe
Replace /rıpleıs/ înlocuieşte; vedem şi înlocuim pe rând fiecare
apariţie a cuvântului căutat;

• să facem toate înlocuirile cu o singură comandă: apăsăm
pe Replace All /rıpleıs ɔːl/ înlocuieşte toate apariţiile cuvântului
căutat.

Când nu ne mai trebuie fereastra Find and Replace /faınd ənd
rıpleıs/ găseşte şi înlocuieşte, apăsăm pe Cancel /kænsl/ anulează/
renunţă.
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Găseşte!

Dacă vrem să ajungem la locul din text unde se găseşte un
anumit cuvânt sau o anumită expresie, folosim fereastra Find
/faınd/ găseşte. Ca să ne apară fereastra de dialog Find /faınd/,

• fie selectăm cu mouse-ul Edit > Find;
• fie folosim combinaţia de taste Ctrl + F.
Textul căutat apare scris cu litere albe pe fond negru (adică

este selectat).

Numerotarea paginilor (introducerea
coloncifrului)

Dacă textul nostru are mai mult de o pagină, dorim să nume-
rotăm aceste pagini. Numărul de pagină dintr-un document, de
exemplu, dintr-o carte, se mai numeşte şi coloncifru. Pentru intro-
ducerea coloncifrului, deschidem fereastra Page Numbers /peıdʒ
nʌmbərz/ numerele paginilor. Avem mai multe posibilităţi. Eu aleg
de regulă poziţia Bottom of page /bɔtəm əv peıdʒ/ josul paginii, şi
anume Centered /sentərd/ centrat. Tu poţi să plasezi coloncifrul
unde ţi se pare ţie mai potrivit. Fă mai multe încercări şi vezi ce ţi
se pare că face documentul tău mai atrăgător.
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Fereastra Find and Replace (găseşte şi înlocuieşte) ne ajută să corectăm o
greşeală repetată în cuprinsul textului nostru.



Vrei să vezi cum arată documentul tău pe
hârtie? Imprimă-l!

Mai întâi, deschide imprimanta, apăsând pe comutatorul ei
electric. Apoi, chemi pe desktop fereastra de dialog cu impriman-
ta. Pentru aceasta,

• fie selectezi comanda File > Print /prınt/ imprimă,
• fie foloseşti combinaţia de taste Ctrl + P.
Priveşte fereastra de dialog cu imprimanta. Cele mai impor-

tante elemente ar fi:
• să specifici dacă imprimi toate paginile, numai pagina de

pe ecran sau numai anumite pagini.
• dacă vrei să imprimi toate paginile documentului, atunci

alegi All /ɔːl/ tot.
• dacă vrei să imprimi doar pagina pe care se află cursorul,

atunci alegi Current Page /kʌrənt peıdʒ/ pagina curentă.
• dacă vrei să imprimi numai anumite pagini, atunci scrii

care pagini sunt acelea. Poţi să selectezi secvenţe (3-5) sau pagini
disparate (7, 11, 19).

• să specifici câte exemplare doreşti să imprimi. Dacă do-
reşti un exemplar, nu modifici nimic. Dacă doreşti să imprimi, să
spunem, trei exemplare, ştergi 1 şi scrii 3 la Number of copies
/nʌmbər əv kɔpiz/ numărul exemplarelor.

• apoi apeşi pe butonul OK.
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Folosim această fereastră pentru a indica unde anume pe pagină să fie introdus
coloncifrul (numărul paginii) documentului nostru.
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Imprimanta va „clipi“ şi se va pune în mişcare. Pe bara de
funcţiuni va apărea iconiţa imprimantei. Dacă faci dublu clic pe
ea, poţi urmări şi controla procesul de imprimare. Îl poţi întrerupe
sau anula.

Tehnoredactarea documentelor

A tehnoredacta sau, în limbajul „calculatoriştilor“, a formata
un document înseamnă a-i da forma pe care o considerăm noi cea
mai atractivă.

Până în clipa de faţă, noi am acceptat forma pe care Word-ul
a dat-o implicit documentului nostru.

Oare ce putem schimba?
Putem schimba forma şi mărimea literelor, înfăţişarea

literelor, înfăţişarea paragrafelor, spaţiul dintre rânduri, lăţimea
marginilor albe şi multe altele. Ne vom ocupa de câteva dintre
aceste posibilităţi – cele mai importante.

Ce e un font

Cuvântul font este un neologism pătruns în limbajul de zi cu
zi al celor ce prelucrează texte cu calculatorul. Înseamnă un set
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de litere şi cifre (caractere) care au aceeaşi înfăţişare – acelaşi stil
şi aceeaşi mărime. Fonturile poartă diferite denumiri.

De exemplu, poezia Laudă limbii române ai scris-o în fontul
implicit al Word-ului, numit Times New Roman, la mărimea de
12 puncte. Punctul este o unitate de măsură în tipografie. 1 punct
este egal cu a 72-a parte dintr-un inch (aproximativ 0.3528 mm,
adică ceva mai mult de o treime dintr-un milimetru). Denumirea
fontului şi mărimea lui apar pe una dintre barele din partea de
sus a ferestrei Word-ului.

Să schimbăm mărimea fontului, să-l facem de 16 puncte.
Pentru aceasta:

Selectăm tot textul. Foloseşte Edit > Select All /sılekt ɔːl/
selectează tot, sau combinaţia de taste Ctrl + A.

Mergem cu mouse-ul fie la Format > Font şi modificăm valoa-
rea de la Size /saız/ mărime, scriind sau selectând 16, fie la feres-
truica de sus unde apare cifra 12, pe care o ştergem şi scriem 16
(sau selectăm 16 din meniul ce se deschide când apăsăm pe
săgeata de lângă cifra 12). Dacă modificăm cifra în fereastra de
dialog, facem clic pe OK.

120

De aici poţi alege fontul potrivit documentului tău.



Acum poezia e scrisă cu corpul 16.

Oare cum ar arăta poezia cu alt font? Iarăşi selectăm tot
textul (Ctrl + A sau File > Select All) şi de data aceasta înlocuim
Times New Roman cu alt tip de font. Să spunem – cu Arial.

Vezi diferenţa? Acele litere din Times New Roman care se
scriu cu beţişoare sau linii au nişte liniuţe la capete. Aceste
liniuţe, ca nişte mici înflorituri, se numesc serife. Se spune că
Times New Roman este un font cu serife.
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În contrast, literele fontului Arial nu au acele mici înflorituri.
Arial este un font fără serife.

Dacă apeşi pe săgeata din dreapta numelui fontului, vei vedea
o listă de fonturi, unele cu serife, altele fără serife, fiecare dintre
ele fiind scrise chiar cu literele din setul propriu de caractere. Exa-
minează-le şi alege fontul care îţi place mai mult. Mie îmi place
Bookman Old Style /bʊkmən əʊld staıl/. Dar ţie?

După ce alegi un font pentru un document, păstrează acel
font de la început până la sfârşit. E o dovadă de lipsă de gust să
schimbi fontul de la o pagină la alta, sau de la un paragraf la altul!
Singura excepţie: ziarele şi revistele de format mare. Ele folosesc
adesea câte un font diferit pentru fiecare articol de pe aceeaşi
pagină.

Ca să diferenţiem însă titlurile şi subtitlurile de textul de
bază, putem varia (nu fontul, ci) corpul (adică mărimea) literei. De
exemplu, putem să scriem poezia Laudă limbii române cu corpul
14, iar titlul ei cu corpul 20.

Numele autorului putem să-l scriem cu corpul 16, ca să-l
scoatem în evidenţă.

Nu-i aşa că arată mai bine?
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Cum scoatem în evidenţă unele părţi din
text

Selectăm partea de text (cuvântul sau îmbinarea de cuvinte)
pe care dorim s-o evidenţiem. Apoi:

Putem să scriem partea selectată cu litere aldine (adică litere
mai groase). Pentru aceasta,

• apăsăm pe butonul cu litera B mare de sus (chiar în
dreapta cifrei care arată corpul literei), sau

• folosim combinaţia de taste Ctrl +B, sau
• deschidem fereastra de setare a fontului, selectând

Format > Font, alegem Bold /bəʊld/ aldin.
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Numele poetului este scris cu litere aldine, în timp ce restul textului este scris cu
litere normale – numite litere drepte.



Putem să scriem partea selectată cu litere cursive (adică litere
aplecate). Pentru aceasta,

• apăsăm pe butonul cu litera I mare de sus, sau
• folosim combinaţia de taste Ctrl + I, sau
• deschidem fereastra de setare a fontului, selectând

Format > Font; alegem Italics /ıtælıks/ cursiv.
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Putem să scriem partea selectată cu litere aldine-cursive (adi-
că litere mai groase şi aplecate în acelaşi timp). Pentru aceasta,

• apăsăm pe butonul cu litera B mare de sus şi apoi pe
butonul cu litera I, sau

• folosim combinaţia de taste Ctrl +B, urmată de Ctrl + I
sau

• deschidem fereastra de formatare a fontului, selectând
Format > Font; alegem Bold Italics /bəʊld ıtælıks/ aldine cursive.

Cursivele se mai numesc şi italice în limba română.
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Ca să revenim la literele obişnuite, numite drepte, procedăm
astfel:

Selectăm ce e scris cu litere aldine şi:
• apăsăm pe litera B (din capul paginii) din nou;
• sau folosim din nou combinaţia Ctrl + B;
• sau mergem la Format > Font şi alegem Regular /regjʊlər/

litere drepte.
Selectăm ce e scris cu litere cursive (italice) şi:
• apăsăm pe litera I (din capul paginii) din nou;
• sau folosim din nou combinaţia Ctrl + I;
• sau mergem la Format > Font şi alegem Regular /regjʊlər/

litere drepte.
Selectăm ce e scris cu litere aldine-cursive şi:
• pe rând, apăsăm pe literele B şi I (din capul paginii) din

nou;
• sau folosim din nou combinaţiile Ctrl + B şi Ctrl + I;
• sau mergem la Format > Font şi alegem Regular /regjʊlər/

litere drepte.
Dacă vrem să subliniem ceva în text; selectăm ce vrem să

subliniem şi: apăsăm pe litera U din capul paginii; sau folosim
combinaţia Ctrl + U.

Dacă vrem să renunţăm la subliniere, selectăm ceea ce este
subliniat şi din nou apăsăm pe litera U sau folosim combinaţia
Ctrl + U.
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Filat la dreapta sau filat la stânga

Paragraful următor e filat (= aliniat) la stânga – adică margi-
nea din stânga este dreaptă, iar cea din dreapta este neregulată:

Seara era timpul de joacă, de alergătură, de hârjoană şi
neastâmpăr, cel mai bun pentru Băiat, pentru Mânz şi pentru
Năsturel. Tatăl şi Mama soseau acasă din câmp şi parcă toată
ograda se umplea de viaţă, odată cu venirea lor. Roiba se auzea
din grajd, răscolind fânul proaspăt cu botul, fornăind. Prin
curţile vecinilor se zăreau oamenii, întorşi şi ei de la muncă,
făcând pregătiri pentru plecarea de a doua zi, ascuţind sapele,
punând mâner nou coaselor, legând secerile la un loc, să nu se
piardă. (Petre Ghelmez, Mânzul de Vânt).

Cum l-am formatat astfel? L-am selectat şi am apăsat pe
iconiţa Align Left /əlaın left/ aliniază la stânga (vezi sus, la dreapta
literei U).

Acelaşi text, filat (aliniat) la dreapta – marginea din stânga e
acum neregulată:

Seara era timpul de joacă, de alergătură, de hârjoană şi
neastâmpăr, cel mai bun pentru Băiat, pentru Mânz şi pentru
Năsturel. Tatăl şi Mama soseau acasă din câmp şi parcă toată

ograda se umplea de viaţă, odată cu venirea lor. Roiba se auzea
din grajd, răscolind fânul proaspăt cu botul, fornăind. Prin

curţile vecinilor se zăreau oamenii, întorşi şi ei de la muncă,
făcând pregătiri pentru plecarea de a doua zi, ascuţind sapele,

punând mâner nou coaselor, legând secerile la un loc, să nu se
piardă. (Petre Ghelmez, Mânzul de Vânt).

De data aceasta am ales iconiţa Align Right /əlaın raıt/ aliniază
la dreapta.

Ca să aliniez textul şi la stânga, şi la dreapta, fac clic pe
iconiţa Justify /dʒʌstıfaı/ justifică. Textul meu va arăta astfel:
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Seara era timpul de joacă, de alergătură, de hârjoană şi ne-
astâmpăr, cel mai bun pentru Băiat, pentru Mânz şi pentru
Năsturel. Tatăl şi Mama soseau acasă din câmp şi parcă toată
ograda se umplea de viaţă, odată cu venirea lor. Roiba se auzea
din grajd, răscolind fânul proaspăt cu botul, fornăind. Prin curţile
vecinilor se zăreau oamenii, întorşi şi ei de la muncă, făcând
pregătiri pentru plecarea de a doua zi, ascuţind sapele, punând
mâner nou coaselor, legând secerile la un loc, să nu se piardă.
(Petre Ghelmez, Mânzul de Vânt).

E mai frumos aşa? Poate. Dar tehnoredactarea ziarelor şi a
revistelor de format mai mare câştigă foarte mult în frumuseţe
prin îmbinarea acestor tipuri de aliniere.

Bumbi şi numere...

Ca să pun în evidenţă ideile unui paragraf sau să fac o listă
de idei sau de elemente, mă pot folosi de bumbi şi/sau de numere.
Folosirea bumbilor produce o listă „neordonată“ (dar în niciun caz
– dezordonată! doar ne-numerotată), iar folosirea numerelor pro-
duce o listă ordonată (pentru că fiecare element din listă are un
număr de ordine). De exemplu, dacă din paragraful de mai sus,
din cartea Mânzul de Vânt de Petre Ghelmez, doresc să extrag lista
personajelor, pot s-o evidenţiez grafic în mai multe feluri.

Mai întâi, ca pe o listă neordonată; selectez elementele din
listă şi merg la Format > Bullets and Numbering /bʊlıts ənd
nʌmbərıŋ/ bumbi şi numerotare. Din fereastra de formatare cu
bumbi şi numere, aleg ceva ce îmi place mai mult cum arată. Iată
ce iese:

Paragraful de mai sus numeşte câteva dintre personajele
cărţii, oameni, dar şi animale personificate.

Oameni sunt:
• Băiatul
• Tata
• Mama
• Vecinii
Animale sunt:
• Mânzul
• Năsturel
• Roiba
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Există şi alte feluri de bumbi:

Oameni sunt:
� Băiatul
� Tata
� Mama
� Vecinii
Animale sunt:
� Mânzul
� Năsturel
� Roiba

Pot să prezint acelaşi paragraf ca o listă ordonată (adică
folosind numere). Pentru aceasta, merg la Format > Bullets and
Numbering, apăs pe Numbered /nʌmbərd/ prevăzut cu numere şi
aleg un model. Iată ce obţin:

Oameni sunt:
1) Băiatul
2) Tata
3) Mama
4) Vecinii
Animale sunt:
1. Mânzul
2. Năsturel
3. Roiba

Ţi se pare interesant? Joacă-te şi tu de-a tehnoredactorul cu
cât mai multe texte.

Modificarea marginilor albe

Mergi la File > Page Setup /peıdʒ setʌp/ fixarea elementelor
paginii. Apasă pe Margins /mɑːrdʒınz/ margini. Valorile în milimetri
ce se dau acolo corespund distanţei dintre marginea paginii şi
text, reprezentând lăţimea marginii albe.

Top /tɔp/ sus – fixează marginea de sus.
Bottom /bɔtəm/ jos – fixează marginea de jos.
Left /left/ stânga – fixează marginea din stânga.
Right /raıt/ dreapta – fixează marginea din dreapta.
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Poţi fixa noi margini pentru toate paginile (selectezi Apply to
Whole Document /əplaı tə həʊl dɔkjʊmənt/ aplică la întregul docu-
ment), sau începând din locul unde este cursorul (selectezi Apply
to This Point Forward /əplaı tə ðıs pɔınt fɔːrwɔːrd/ aplică din acest
punct mai departe).

Poţi alege de aici şi mărimea hârtiei. Apasă pe Paper Size
/peıpər saız/ dimensiunile hârtiei. Aici poţi să ai însă probleme cu im-
primanta, dacă nu ai de unde să-i pui în sertare hârtia de mări-
mea setată în această fereastră. Cel mai bine este să alegi mări-
mea A4 (coala de hârtie standard în Europa – 210 x 297 mm).
Mărimea Letter /letər/ scrisoare este standardul american. Spe-
cialiştii americani în drept folosesc standardul numit Legal /liːgl/
legal. (Asta nu transformă însă celelalte standarde în... ilegale!)
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Îmbină textul cu imagini – sau împănează-l
cu tabele

Word-ul te lasă să aduci imagini în pagina ta. Ai un aparat
foto digital? Descarcă fotografiile într-un folder de pe discul dur (le
copiezi de pe un mediu de stocare pe altul) şi ţine minte numele
acelui folder. Apoi deschide Word-ul, deschide documentul dorit
sau creează unul nou, apasă pe Insert > Picture > From File şi
caută folderul cu poze.
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Apoi alege o fotografie şi, una-două, ea îţi va intra în pagină.
Fereastra îţi arată fotografiile – în format foarte mic –, deci poţi alege
în cunoştinţă de cauză. Eu am ales fotografia lui Petre Ghelmez:

Pentru a introduce un tabel, poziţionează cursorul acolo unde
vrei să introduci tabelul şi alege Table > Insert > Table... Se va
deschide o fereastră de dialog, prin care vei seta numărul de
coloane (columns /kɔləmz/) si rânduri (rows /rəʊz/) pe care le va
avea tabelul. Apeşi pe OK şi vei obţine tabelul pe care îl vei
completa cu datele dorite.

Cum închid documentul în care lucrez

Ai terminat de scris şi de formatat; ai salvat; şi acum vrei să
închizi fişierul.

Nu e greu:
• Dacă vrei să ieşi cu totul din program, selectezi File > Exit

sau foloseşti combinaţia de taste Ctrl + W sau combinaţia de taste
Alt + F4.
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• Dacă vrei să rămâi în Word, selectezi File > Close.
• Dacă nu vrei de fapt să închizi fişierul, dar vrei să creezi

altul nou în paralel cu cel curent, selectezi File > New sau apeşi
pe Ctrl + N.

Când selectezi File > New, îţi apare o fereastră de dialog, care
te întreabă ce fel de document vrei să se creeze. Pentru un fişier
normal în Word, alegi Blank Document /blæŋk dɔkjʊmənt/ document
alb/gol/fără conţinut sau formatare specială.

Word-ul are multe altele de oferit, dar deja ai învăţat prea
mult pentru un începător. Oricum, de aici mai departe te poţi
descurca şi singur. Prin încercări repetate, vei descoperi şi
rosturile celorlalte comenzi. E atât de interesant să explorezi
singur un program nou, să-l înveţi prin „butonare“! Mai mult:
nimic nu înlocuieşte „butonarea“, adică experienţa directă cu
tastatura şi mouse-ul.

Succes!
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5. Internetul şi poşta electronică

Vocabularul fundamental cuprinde cuvinte cu o frecvenţă
foarte mare în vorbirea de zi cu zi. Se apreciază că acestea nu sunt
multe, abia dacă depăşesc cifra de 2000. Cele mai multe sunt
vechi, adânc înrădăcinate în limbă, având bogate familii de
cuvinte şi intrând în numeroase expresii.

În timpurile mai recente, au intrat în vocabularul funda-
mental şi cuvinte noi, mai ales dintre acelea ce denumesc obiecte
folosite zilnic în casă: radio, televizor, frigider, aspirator.

Dar nici unul dintre acestea n-a intrat în vorbirea noastră de
zi cu zi atât de repede şi de tumultuos ca foarte recentele vocabule
Internet, poştă electronică, e-mail, virus (electronic), cu expresiile
aferente: pagină de Internet, prezenţa pe Internet, a se conecta la
Internet, a naviga pe Internet, adresa (paginii) de Internet, a căuta
pe Internet, a publica pe Internet, a virusa (ca în „E-mail-ul de la
tine mi-a virusat calculatorul.“), a citi e-mail-ul sau mesajele
e-mail, a trimite un e-mail... Iar din spatele lor presează puternic
un roi agitat de cuvinte din acelaşi domeniu sau din domenii
strâns înrudite – dial-up, port, browser, site, web, website, hacker,
spam, a redirija, Google (ca în „N-ai găsit nimic despre asta pe
Google?“), motor de căutare, Yahoo! (ca în „Eşti şi tu pe Yahoo!?“),
messenger, chat, user, username, patch, service pack, ISDN, DSL,
(TCP/)IP, adresă IP, Ethernet, network, placă de reţea, spaţiu
virtual, cyberspace, ciberfobie, server, joystick, mouse, digital, a
digitiza, fibră optică, protocol de comunicaţii, ISP, MB (megabyte),
GB (gigabyte), GPS, HTML, Java, Perl, Php şi altele încă.

Aceşti termeni de strictă specialitate de origine americană
tind să-şi pună amprenta pe discuţiile românilor în numeroase
situaţii cotidiene.

Desigur, această reînnoire fulgerătoare a vocabularului oglin-
deşte o realitate evidentă: Internetul, cu toate cele legate de el, a
intrat năvalnic în vieţile noastre şi ne obligă să-l includem în
(aproape) tot ce facem şi – ca o consecinţă firească – în (aproape)
tot ce spunem. Dar, ce numim de fapt Internet?
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Ce este Internetul

Internetul este o imensă reţea de calculatoare care cuprinde
întregul glob. Legăturile dintre aceste calculatoare pot fi făcute

• prin linii telefonice,
• prin cabluri metalice,
• prin fibre optice sau
• prin unde radio – prin intermediul sateliţilor de comuni-

caţie.
Încă nu s-au realizat conexiuni prin telepatie, dar, cine ştie...

poate unul dintre noi va inventa şi asta.
Cel care a venit cu ideea unei astfel de reţele a fost omul de

ştiinţă J. C. R. Licklider, de la MIT, Massachusetts, Statele Unite
ale Americii, în august 1962. (Licklider a fost consilierul pe pro-
bleme ştiinţifice al preşedintelui Roosevelt în timpul celui de-al
doilea război mondial.) Savantul american a condus primul pro-
iect legat de calculatoare al Agenţiei pentru Proiecte de Cercetări
Avansate Privind Apărarea (Defense Advanced Research Projects
Agency – DARPA). Această agenţie a Departamentului Apărării
Statelor Unite a iniţiat realizarea Internetului. Prin granturi şi
subvenţii, agenţia a implicat în aceasta numeroase universităţi şi
firme particulare americane. Acest efort comun, la care au contri-
buit şi savanţi din alte ţări, a dus în final la reţeaua gigantică de
astăzi, întinsă pe toate continentele.

Deşi funcţionează pe cu totul alte principii, Internetul se
aseamănă cu sistemul mondial de comunicaţii telefonice. Fiecare
calculator legat la Internet are un număr, ca şi un post telefonic,
numit adresă de internet sau adresă IP. IP înseamnă protocol(ul de
telecomunicaţii prin) Internet; în engleză, Internet Protocol /ıntərnet
prəʊtəkɔl/. Forma unei adrese de Internet este de tipul:
192.168.17.252/24 (patru numere între 0-255 plus un număr
denumit mască de subreţea). Masca – în acest caz, „/24“, ajută la
împărţirea numerelor între cele atribuit reţelei şi cel atribuit
calculatorului din respectiva reţea. În cazul de faţă, adresa IP ne
spune că este vorba de calculatorul cu numărul 252 aflat pe
reţeaua de calculatoare 192.168.17.0.
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Pachete de 0 şi 1

Prin Internet, între calculatoare, circulă date (informaţii) sub
forma unor grupări de combinaţii de 0 şi 1 numite pachete. Micro-
procesoarele ştiu să interpreteze aceste pachete şi să le prezinte
(textele şi imaginile se recompun pe ecran, cuvintele rostite sau
muzica se transmit prin difuzor). Pachetele sunt de fapt
combinaţii de 0 şi 1.

Unele dintre aceste date se adresează celor ce folosesc Inter-
netul (numite în engleză user data /juːzər deıtə/ = datele de la utili-
zator sau pentru utilizator).

Altele sunt date folosite nu de om, ci de calculatoare, precum
şi de un tip de aparate de telecomunicaţii pentru Internet numit
router (engleza americană /raʊtər/, engleza britanică /ruːtə/). Aceste
date se numesc date de rutare şi se folosesc în mod automat de
router-e pentru stabilirea legăturilor între calculatoare şi
transmiterea datelor de utilizator.

Alt tip de date care circulă prin Internet, mai ales între
router-e, este reprezentat de datele de monitorizare. Acestea sunt
folosite de proprietarii căilor fizice de comunicaţie între calcula-
toare, care se numesc furnizori de servicii Internet, pentru a
administra – a menţine şi a controla – router-ele şi legăturile fizice
dintre ele.

Despre furnizorii de servicii Internet

Un cuvânt-cheie pentru orice furnizor de servicii Internet, sau
ISP (ISP /aı es pi:/ = Internet Service Provider /ıntərnet səːrvıs
prəvaıdər/), este lărgimea de bandă (bandwidth /bændwıdθ/). Aceasta
nu are de-a face cu lărgimea de bandă din cadrul transmisiilor
prin unde radio. Lărgimea de bandă în acest caz înseamnă de fapt
viteza cu care se transmit aceste combinaţii complexe de 0 şi 1 în
care sunt exprimate datele care circulă prin Internet.

Un ISP a cărui aparatură poate oferi o lărgime de bandă mică
este un ISP de rangul 3. La ISP-ul de rangul 3 se conectează un
număr relativ restrâns de persoane, ca mine şi ca tine (care au
câte un calculator personal în dormitor, în sufragerie sau în
camera copilului), şcoli sau firme mici, care au o reţea mică de
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calculatoare – numită LAN (nu confunda cu un lan de grâu; LAN
/læn/ = local area network /ləʊkl eərıə netwəːrk/ reţea dintr-o arie
locală).

ISP-ul de rangul 3 acţionează într-o arie geografică limitată –
un sat, un bloc de locuinţe sau un cartier. El primeşte datele de
utilizator prin mai multe porturi cu o anumită lărgime de bandă
aflate pe router-ul său şi le multiplexează– adică le îmbină,
intercalându-le unele cu altele – pentru ca apoi să le transmită
printr-un port (sau mai multe) cu o lărgime de bandă mai mare
(adică o viteză de transmitere mai mare) către un ISP de rangul 2.

ISP-ul de rangul 2 deţine aparatură mai scumpă şi mai
complicată, administrând o lărgime de bandă superioară celei a
ISP-ului de rangul 3. ISP-ul de rangul 2 deserveşte o arie geogra-
fică de mărimea unui oraş sau a unui judeţ. El deţine una sau mai
multe reţele metropolitane (adică de oraş), numite şi MAN (MAN
/mæn/ = Metropolitan Area Network /metrəpɔlıtən eərıə netwəːrk/).
Clienţii lui sunt ISP-uri(le) de rangul 3 din zona sa, precum şi
universităţi şi firme mai mari, care deţin una sau mai multe reţele
LAN într-o singură locaţie sau în mai multe sedii răspândite în
zona de acţiune a ISP-ului de rangul 2 respectiv.

ISP-urile de rangul 2 multiplexează datele primite de la clienţii
săi şi le transmit, prin porturi cu lărgime de bandă şi mai mare,
către ISP-urile de rangul 1.

Un ISP de rangul 1 este o companie foarte mare şi bogată,
care acţionează la nivel naţional sau internaţional şi cooperează
cu alte ISP-uri de rangul 1 pentru a transmite la viteze uluitoare
datele spre toate colţurile globului. ISP-urile de rangul 1 adminis-
trează aşa-zisa coloană vertebrală a Internetului (căile de comuni-
caţii cele mai rapide din Internet; în engleză Internet backbone
/ıntərnet bækbəʊn/; i se mai spune în engleză şi core /kɔːr/ miez, cen-
tru). ISP-urile de rangul 1 deţin şi administrează cabluri între
marile oraşe, între ţări, între continente. Ele sunt adesea pose-
soare de sateliţi de comunicaţie.

De la kilobiţi pe secundă la terabiţi pe
secundă

Ca să ai o vagă idee despre diferenţa dintre viteza de la peri-
feria Internetului şi cea din centrul său, îţi dau câteva valori. Dacă
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te conectezi la ISP-ul tău prin telefonul de acasă, lărgimea de
bandă este (de regulă) de 56.000 biţi pe secundă (un bit, precum
am mai spus, este un semnal electric ce poate fi interpretat ca un
0 sau un 1).

Odată ajunse în centrul Internetului, datele trimise de
calculatorul tău capătă viteza de 1000.000.000 de biţi pe secundă
(bps).

Iar acum se experimentează transmisia de date prin fibre
optice la viteza de 1000.000.000.000 bps (un milion de milioane
de biţi pe secundă).

Compară deci:
• 56.000 bps = 56 Kbps (kilobiţi pe secundă);
• 1.000.000.000 bps = 1000.000 Kbps = 1000 Mbps

(megabiţi pe secundă) = 1 Gbps (gigabit pe secundă);
• 1.000.000.000.000 bps = 1000 Gbps = 1 Tbps (terabit pe

secundă).
(N.B. Americanii pronunţă /gıgə/, adică cu ghi la începutul

cuvântului, românii pronunţă cu gi.)
Impresionant, nu? Iar Internetul are o continuă şi tot mai

accentuată „foame“ de lărgime de bandă. Datele transmise între
calculatoarele sale cresc în volum în fiecare clipă – cu o viteză
uluitoare.

Demultiplexarea

Să presupunem că locuieşti în Suceava şi că ai trimis un
mesaj prin Internet unui prieten din San Francisco. Datele tale au
fost preluate de ISP-ul din cartierul tău şi transferate unui ISP de
rangul 2, care le-a trimis la Bucureşti unui ISP de rangul 1. ISP-
ul din Bucureşti le-a trimis cu viteza maximă, poate prin satelit,
unui ISP de rangul 1 din New York. Acesta le-a transmis, prin
porţiunea nord-americană a coloanei vertebrale a Internetului, la
San Francisco. Acolo le-a preluat un ISP de rangul 2 care admi-
nistrează zona din oraşul San Francisco unde locuieşte prietenul
tău. ISP-ul de rangul 2 le-a predat acelui ISP de rangul 3 la
aparatura căruia este conectat calculatorul prietenului tău. Iar
ISP-ul de rangul 3 le-a transmis calculatorului prietenului tău.
Răspunsul prietenului tău va face cale inversă trecând din nou
prin aceleaşi procese (dar nu neapărat prin exact aceleaşi ISP-uri!)
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Când ISP-ul de rangul 1 din San Francisco a predat mesajul
tău ISP-ului de rangul 2, el a făcut o primă demultiplexare (adică
desfacere a unui grup mare de date de origini diferite în grupuri
mai mici de date de origini diferite, dar care au destinaţie comu-
nă). El nu a predat doar mesajul tău, ci toate mesajele care se
adresau zonei controlate de ISP-ul de rangul 2. Apoi ISP-ul de
rangul 2 a făcut o nouă demultiplexare, împărţind mesajele în
grupuri de mesaje şi mai mici, pe care le-a trimis la diverse ISP-
uri de rangul 3 sau la router-ele unor clienţi cu LAN-uri mai mari.
Iar ISP-ul de rang 3 care comunică direct cu calculatorul prie-
tenului tău a demultiplexat grupul de mesaje şi a trimis fiecare
mesaj pe câte un port diferit; mesajul tău l-a trimis prin portul la
care este conectat calculatorul prietenului tău.

E-mail şi snail mail

Cam tot aşa procedează sistemul poştal clasic. Tu pui o scri-
soare într-o cutie poştală pentru prietenul tău din San Francisco.
În aceeaşi cutie, pun scrisori în aceeaşi zi şi alţi suceveni
(aminteşte-ţi – presupunem că locuieşti în Suceava). La sfârşitul
zilei, poştaşul pune toate aceste scrisori amestecate (să zicem,
metaforic, „multiplexate“) în tolba lui. E prima „multiplexare“ (pun
cuvântul între ghilimele, pentru că acest termen nu se foloseşte în
limbajul poştaşilor).

La poşta respectivă, lucrează mai mulţi poştaşi, care adună
scrisori din cutiile plasate în alte zone ale Sucevei. Toate aceste
scrisori se pun într-un sac mare de poştă (o altă „multiplexare“) şi
se trimit la poşta centrală din Suceava. Aici se „multiplexează sa-
cii“ din toate oficiile poştale ale Sucevei. Apoi se duc la Bucureşti.
Aici se strâng scrisorile din toate judeţele. Şi începe sortarea lor pe
judeţe sau pe ţări de destinaţie (începe „demultiplexarea“) – şi tot
aşa, în ordine inversă, se ajunge ca un singur poştaş să înmâneze
o singură scrisoare unei singure persoane, iar acea persoană să
fie exact prietenul tău din San Francisco...

La poştă, însă, procesul durează multe zile. Prin calculator, tu
ai folosit poşta electronică (e-mail /iːmeıl/ = electronic mail
/ılektrɔnık meıl/), şi totul a luat câteva secunde (sau, dacă traficul a
fost îngreunat, ar fi putut lua câteva minute). De aceea, poşta
clasică mai este poreclită (cu ironie) de către mânuitorii poştei
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electronice snail mail /sneıl meıl/ poşta-melc. Snail mail /sneıl meıl/
poşta-melc este deci (în mintea celor ce se ţin de astfel de glume)
antonimul (sau numele opus) lui e-mail /iːmeıl/ poşta electronică.

Indiferent de platformă

Îţi aminteşti că o anumită combinaţie între tipul de micro-
procesor (creierul calculatorului) şi sistemul de operare (adminis-
tratorul calculatorului) se numeşte platformă. Fiecare platformă
prelucrează datele în chip diferit, după reguli diferite. Marele merit
al celor ce au construit Internetul este acela că oricare platformă
are acces la informaţiile şi celelalte servicii ale sale. Toate calcula-
toarele, mari şi mici, rulând Linux, Macintosh sau Windows, mai
vechi şi mai noi, au drepturi egale când e vorba de folosirea
resurselor şi serviciilor din Internet. Iată o formă de democraţie pe
care nu putem decât să o admirăm.
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documentelor PDF (în format portabil) pe orice platformă

(pe toate tipurile de calculatoare şi/sau sisteme de operare).



Servere...

Trebuie să înţelegi că procesele care au loc în Internet se
bazează pe relaţia client-server. Atât clientul, cât şi serverul sunt
programe. Dar, clientul este construit să ceară, iar serverul este
construit să ofere informaţiile cerute de client.

Dacă pe un calculator din Internet rulează un program-server,
atunci şi calculatorul se numeşte server.

Numărul de servere este mai mic decât numărul de clienţi,
pentru că un server oferă informaţii la mai mulţi clienţi.

Serverele oferă diferite servicii. După tipul de serviciu oferit,
serverele pot fi:

• servere de web – care adăpostesc şi oferă pagini de web
sau situri de web (mai multe pagini de web strâns legate între ele,
formează un sit de web – în engleză website /websaıt/). Pagini de
web înseamnă pagini de prezentare aflate pe Internet.

• servere FTP /ef tiː piː/ = file transfer protocol /faıl trænsfəːr
prəʊtəkɔl/ protocol de transfer de fişiere – care oferă documente şi
aplicaţii.

• servere de e-mail (poştă electronică) – care mijlocesc
schimburile de mesaje e-mail.

Sunt şi alte tipuri de servere, dar ne oprim la acestea.

...şi clienţi

Ca tu să beneficiezi de aceste servicii, îi ceri calculatorului tău
să deschidă aplicaţia-client potrivită. Apoi te foloseşti de această
aplicaţie pentru a obţine informaţii, fişiere, programe sau pentru
a transmite şi primi mesaje de e-mail.

Aplicaţia-client merge la aplicaţia-server şi cere un serviciu (o
pagină de web, un fişier, transmiterea unui mesaj etc.). Aplicaţia-
server răspunde cererii şi oferă exact ce i se cere. Fiecare tip de
aplicaţie-server poate răspunde unui anumit tip de aplicaţie-
client. Aşa că:

• serverele de web răspund clienţilor de web;
• serverele FTP răspund clienţilor FTP;
• serverele de e-mail răspund clienţilor de e-mail.
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Când o să înveţi să creezi propria ta pagină de web şi s-o
publici pe Internet (să sperăm că o vei face folosind una dintre
viitoarele mele cărţi), o să foloseşti o aplicaţie-server de web. În
cartea aceasta ne vom ocupa de un

• client de web – se mai numeşte şi program de navigare pe
Internet sau browser /braʊzər/ explorator de pagini de web – şi
anume de Internet Explorer /ıntərnet ıksplɔːrər/ şi

• de un client de e-mail – şi anume Outlook Express /aʊtlʊk
ıkspres/.

Browser-ul Internet Explorer /ıntərnet ıksplɔːrər/ (ca mai toate
browser-ele serioase – amintim aici Netscape Navigator /netskeıp
nævıgeıtər/) are încorporat şi un client FTP, aşa că poţi să-i ceri
să-ţi aducă pe ecran nu numai o pagină de web (accesabilă prin
protocolul numit HTTP /eıʧ tiː tiː piː/ = hypertext transport
protocol /haıpərtekst trænspɔːrt prəʊtəkɔl/), ci şi liste de fişiere pe care
le vei descărca prin protocolul FTP /ef tiː piː/ = file transfer
protocol /faıl trænsfəːr prəʊtəkɔl/ protocol de transfer de fişiere.

Dar mai întâi – să ne conectăm la Internet.

Cum te conectezi la Internet

Sunt mai multe metode de conectare la Internet:
• Prin linia ta telefonică, folosind o cutiuţă numită modem.

Aceasta este conectarea prin dial-up /daıəl ʌp/ (adică prin formarea
unui număr; dar numărul nu-l formezi tu, ci calculatorul).

• Printr-un LAN (reţea locală de calculatoare), dacă şi calcu-
latorul tău este inclus în acel LAN, folosind o placă de extensie
numită placă de reţea sau (în cazul unui laptop) un PCMCIA /piː
siː em siː aı eı/, adică un card de calculator – are mărimea unui card
bancar, dar e de vreo 4-5 ori mai gros. Aceasta este conectarea
prin reţea.

• Prin cablul TV (în caz că eşti conectat la unul din acei
operatori de televiziune prin cablu care sunt destul de ageri la
minte pentru a oferi şi conectare la Internet), folosind un modem
de cablu. Aceasta este conectarea prin cablu.

Primul tip de conectare (dial-up /daıəl ʌp/) e destul de lent, dar
e cel mai la îndemână.
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Când te conectezi la Internet, calculatorul tău primeşte şi el o
adresă de Internet (o adresă IP). De obicei, la conectarea prin reţea
sau prin cablu, adresa ta e mereu aceeaşi – e o adresă fixă.

Când te conectezi prin dial-up /daıəl ʌp/, primeşti o adresă
nouă de fiecare dată, care este valabilă numai pe perioada de
conectare – e o adresă IP temporară. În acest caz, adresa IP a
calculatorului tău este oferită de un server DHCP (iată deci un alt
tip de server). (DHCP /diː eıʧ siː piː/= dynamic host configuration
protocol /daınæmıc həʊst kənfıgəreıʃn prəʊtəkɔl/ protocol de configurare
dinamică a gazdelor). Când părăseşti legătura cu Internetul,
serverul DHCP „simte“ că adresa ta a devenit nefolosită şi o
atribuie altui calculator care se conectează la Internet după ce te
deconectezi tu.

Conectarea la Internet prin dial-up

Vrei să te conectezi la Internet prin telefonul tău de acasă –
pentru că nu eşti conectat la un LAN şi fie nu ai televiziune prin
cablu, fie operatorul tău de televiziune prin cablu nu oferă servi-
ciul de conectare la Internet, fie îl oferă la un preţ prea mare
pentru tine. De ce ai nevoie?

Ai nevoie de:
• un calculator care să aibă instalat un sistem de operare

(oricare ar fi acela);
• un modem (intern sau extern);
• un cablu de telefon (îl poţi desprinde de la telefonul tău şi

conecta la modem; sau poţi să legi şi modemul şi telefonul în serie;
sau poţi schimba priza de telefon, astfel încât să ai două ieşiri:
una pentru telefon, una pentru modem);

• aplicaţie de dial-up /daıəl ʌp/;
• un contract cu un furnizor de ISP prin care primeşti:

� permisiunea ca tu (de fapt calculatorul tău) să intri în
legătură cu un modem de pe router-ul (sau calculatorul) ISP-ului;

� un număr de telefon la care calculatorul tău va suna;
� un username /juːzər neım/ (nume de utilizator; adică un

fel de poreclă) pe care îl cunoaşte şi ISP-ul, şi care trebuie să fie
unic în cadrul acestui ISP, pentru a nu se confunda cu username-
ul altui client;
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� o parolă (password /pɑːswəːrd/), convenită cu ISP-ul;
� o adresă de e-mail – a ta, oferită de ISP;

• know-how /nəʊhaʊ/ (adică să ştii să operezi aplicaţia de
dial-up /daıəl ʌp/ – pentru conectare, precum şi aplicaţiile-client de
web şi client de e-mail, pentru a putea beneficia de conectare).

Cam multe, nu? Nu te descuraja. O să-ţi dau o soluţie prac-
tică.

ClickNet

Romtelecom ne oferă posibilitatea să ne conectăm la Internet
prin dial-up /daıəl ʌp/ fără contract (informaţii privind acest ser-
viciu – la 930) şi la un preţ destul de bun (numai că trebuie să
avem grijă să nu stăm conectaţi prea mult, pentru că plătim
pentru fiecare minut între 0,7 şi 1,25 cenţi, depinzând de momen-
tul zilei în care ne conectăm). Deci avem un ISP.

Numărul de telefon este 0870 222222.
Username-ul şi parola sunt unice pentru toţi utilizatorii (o

situaţie ce nu se găseşte la un ISP normal, unde ai, cum spu-
neam, propriul tău username şi propria parolă): clicknet /klıknet/.

Romtelecom nu ne dă o adresă de e-mail, deci nu ne oferă
serviciul de poştă electronică – dar există ac şi de cojocul ăsta,
vom vedea mai jos.

Să presupunem că avem o platformă Windows 98 /wındəʊz
naınti eıt/ şi un modem conectat atât la calculator, cât şi la linia
telefonică din casă. (Telefonul nu trebuie să fie parolat pentru a
împiedica formarea numerelor care încep cu 0870...!)

În acest caz,
• Selectăm cu mouse-ul:

Start > Programs > Accessories > Communications > Dial-
Up Networking.

Se deschide o fereastră în care vedem iconiţa Make New
Connection /meık njuː kənekʃn/ fă conecţie nouă.

• Dublu clic pe Make New Connection /meık njuː kənekʃn/ fă
conecţie nouă. Se deschide fereastra programului utilitar Make
New Connection /meık njuː kənekʃn/ fă conecţie nouă.
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• Scriem numele acestei conecţii în locul cuvintelor My
Connection /maı kənekʃn/ conecţia mea. De exemplu: Romtelecom.

• Apăsăm pe Next /nekst/ următorul (pas). Apare o nouă
fereastră.

• La Area code /eərıə kəʊd/ (codul zonal; reprezintă primele
cifre ale numărului telefonic interurban, cum ar fi 021 pentru
Bucureşti, 0243 pentru judeţul Ialomiţa etc.) scriem 087, iar la
telephone number 0222222.

• Apăsăm pe Next /nekst/ următorul (pas).
• Apăsăm pe Finish /fınıʃ/ termină. Se închide fereastra.
• După aceasta, mergem din nou la:

Start > Programs > Accessories > Communications > Dial-
Up Networking.
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De aici pornim pentru realizarea conecţiei prin dial-up.
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Primul pas în realizarea conecţiei este s-o denumim – de exemplu
putem scrie Romtelecom în loc de My Connection (conecţia mea).

Apoi apăsăm pe Next (următorul pas).

Aici scriem numărul de telefon pe care modemul calculatorului nostru îl va apela.
Numărul e format din două părţi: un prefix zonal (primele trei cifre) şi numărul
local (următoarele şapte cifre). 021 este prefixul pentru zona Bucureşti. 087 e

mai degrabă un prefix al unei zone teoretice, decât al uneia geografice (arată că
numărul intră în categoria numerelor speciale).



În fereastra care se deschide, vedem iconiţa conecţiei noastre,
cu numele Romtelecom.

• Dublu clic pe iconiţa Romtelecom. Apare fereastra de
dialog Connect to /kənekt tə/ conectează-te la.

• În dreptul cuvintelor username /juːzər neım/ numele utiliza-
torului, în loc de name /neım/ nume, scriem clicknet /klıknet/.

• În dreptul cuvântului Password /pɑːswəːrd/ parolă, scriem
clicknet /klıknet/. Vai, nu apare parola clicknet /klıknet/ pe ecran!
Apar doar nişte steluţe: ********. Nu te impacienta. Aşa trebuie să
fie. Parola e ascunsă de ochi străini.

• (Dacă facem clic în pătrăţelul din dreptul cuvintelor Save
Password /seıv pɑːswəːrd/ salvează-ţi parola, nu mai trebuie să
introducem parola la viitoarea conectare.)

• Dacă e nevoie, la Phone number /fəʊn nʌmbər/ număr de
telefon, corectăm numărul: trebuie să apară 087 0222222.

Apăsăm pe Connect /kənekt/ conectează(-te). Se deschide o
fereastră care ne dă diverse mesaje. Între timp, dacă modemul nu
e setat pe silent /saılənt/ tăcut/fără sunet, se aude tonul de telefon,
se aude cum se formează numărul, după care vin piuiturile, ţiu-
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Avem fereastra de conectare Romtelecom. Am scris clicknet atât în locul
cuvântului name, cât şi drept parolă. Acum vom apăsa pe Connect (conectează).



iturile şi trosniturile obişnuite la transmisia prin fax. Ce se întâm-
plă?

Calculatorul nostru formează numărul dat de Romtelecom.
Acest număr ascunde în spatele lui zeci de mii sau sute de mii de
alte linii telefonice, fiecare dintre ele fiind cuplată la câte un
modem (sau la un port care are un modem încorporat, acest port
aflându-se pe un router sau pe un comutator telefonic automat
numit switch /swıʧ/).

Modemul nostru vorbeşte cu modemul lor. Îl salută, se
prezintă, îi spune că are ceva de transmis, îi spune care e viteza
lui maximă de transmitere, îl întreabă ce viteză maximă acceptă
el, în fine, ca între doi indivizi care vorbesc la telefon şi schimbă
amabilităţi până când, în sfârşit, modemul Romtelecom-ului
spune, bine, sunt gata să primesc datele la viteza convenită, iar
modemul nostru spune, OK, RTS /ɑː tiː es/ = request to send
/rıkwest tə send/ cerere de a transmite, adică sunt gata să transmit
datele la viteza convenită... Iar datele sunt pachete de control (de
rutare) care ţin dechisă conecţia prin care putem noi să intrăm pe
Internet.

Încă nu s-au primit şi nu s-au trimis pachete de date de
utilizator. Dar suntem conectaţi la un ISP şi, prin el, la Internet.
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Fereastra de conectare ne prezintă diversele stadii ale operaţiunii. Acum sună...

Către finalul stabilirii conexiunii cu Romtelecom, se procedează
la verificarea numelui şi a parolei.



Calculatorul nostru are deja o adresă de Internet, atribuită de un
server DHCP al Romtelecom-ului.

Să navigăm! Toate pânzele sus!

Acum ne uităm pe desktop sau pe bara de funcţiuni. Vedem
undeva un e mic de tipar, scris cu albastru, care are o codiţă în
partea stângă? Vedem! Dublu clic pe el. Se deschide browser-ul
(sau aplicaţia de navigare pe Internet) numit Internet Explorer
/ıntərnet ıksplɔːrər/. Pe calculatorul meu, prima pagină pe care o
aduce se găseşte la adresa de Internet http://www.coresi.net/.
Aşa este el setat să procedeze – să ceară pagina asta înainte de
toate. Pagina aceasta de început se numeşte home page /həʊm
peıdʒ/ pagina casei/pagina de acasă şi se poate seta în fereastra
deschisă de

Tools > Internet Options...

A, te-am prins! vei spune tu. Nu spuneai că adresa de Internet
este un număr ca la telefoane?
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Pe bara de funcţiuni, în dreapta, apare iconiţa conexiunii făcute: sunt două
calculatoare legate prin cablu. Acestea clipesc să ne spună:

conexiunea este activă.

Dacă facem dublu clic pe iconiţa ce arată că avem o conexiune activă vedem
această fereastră.



Ai dreptate, într-un fel. Dar, unele calculatoare poartă şi un
nume – nume de domeniu sau, mai bine zis, au un fel de adresă
exprimată în cuvinte. De fapt, ce se întâmplă? Putem să căutăm
paginile de Internet şi după adresele lor IP exprimate în formă
numerică. Dar oamenii reţin mult mai uşor cuvinte decât numere.
Sunt convins că vei ţine minte mai uşor www.coresi.net decât un
grup de patru numere, fiecare având între 1 şi 3 cifre.

Calculatorul însă nu foloseşte direct numele de domeniu
pentru a se duce să ceară pagina de web căutată de noi. El are
nevoie de forma numerică a adresei de Internet, pentru a găsi
calea spre serverul respectiv. De aceea, el mai întâi merge la un
server DNS /diː en es/ = domain name server /dəʊmeın neım səːrvər/
server de nume de domeniu, unul pe care îl cunoaşte el (în cazul
nostru, a aflat chiar de la Romtelecom la care anume server DNS
să meargă). În Internet sunt foarte multe servere DNS, repartizate
pe zone geografice.

Să căutăm informaţii privind cursuri de telecomunicaţii.
Cineva ne dă o adresă. Caută www.skyline-ats.com. La această
adresă găsim pagina de prezentare a firmei Skyline Advanced
Technology Services. Aceeaşi pagină ne apare şi dacă folosim
adresa IP exprimată în formă numerică: 12.36.115.14. Hai să
căutăm după adresa numerică. În ferestruica precedată de
cuvântul Address /ədres/ adresă scriem http://12.36.115.14/.
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Pagina de web a Editurii Coresi, aflată la adresa: http://www.coresi.net



Apăsăm pe Go /gəʊ/ du-te – pe acelaşi rând, la capătul celălalt.
După un timp, apare pagina de prezentare a firmei. Aceeaşi
pagină o găsim şi căutând după denumire. Să scriem acum
http://www.skyline-ats.com. Go /gəʊ/ du-te. Internet Explorer
/ıntərnet ıksplɔːrər/ ne prezintă aceeaşi pagină.

De fapt, în ambele cazuri, calculatorul a căutat tot după
adresa exprimată numeric. Numai că, în primul caz, s-a dus direct
la calculatorul respectiv şi a cerut pagina de web. În al doilea caz,
n-a ştiut unde să meargă. Aşa că mai întâi a intrat în legătură cu
serverul DNS şi l-a întrebat:

– Ce înseamnă www.skyline-ats.com?
Serverul DNS s-a uitat în listele lui şi a răspuns (de exemplu)

12.36.115.14. Aha, a zis calculatorul tău, mersi, acum închid
conversaţia cu tine şi caut calculatorul cu adresa IP respectivă. Şi
aşa a făcut. Iar când a ajuns la el, i-a cerut: „Trimite-mi pagina ta
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Aici se poate introduce adresa paginii pe care vrei să ţi-o prezinte Internet
Explorer când se deschide. De aici începe navigarea ta pe Internet, de aceea
această pagină e numită casa ta – casa din care porneşti în lumea virtuală.
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Pagină căutată după adresa IP a calculatorului pe care este găzduită.

Aceeaşi pagină, căutată de această dată după URL:
http://www.skyline-ats.com.



de web pentru utilizatorul meu“. Aplicaţia-server de web care
rulează pe acel calculator, l-a întrebat: „– Dar tu ce adresă ai?
Asta? Bine.“ Şi, pe adresa primită, a trimis datele ce s-au trans-
format pe ecranul calculatorului tău în pagina de web a firmei
căutate.

De fapt, adresa exprimată prin cuvinte nu se suprapune total,
ca semnificaţie, peste adresa de Internet sub formă numerică. La
adresa sub formă numerică se găseşte calculatorul cu toate
serviciile sale. La adresa exprimată prin cuvinte, se găseşte şi
răspunde numai un chiriaş al calculatorului respectiv, anume
serverul de web care rulează pe el. De aceea, mai corect este să
numim adresa Internet exprimată prin cuvinte URL /juː ɑː el/ (nu,
n-are nicio legătură cu O.R.L.!), adică Uniform Resource Locator
/juːnıfɔːrm rızɔːrs ləʊkeıtər/ localizator uniform de resurse. I se mai
spune şi Universal Resource Locator /juːnıvəːrsl rızɔːrs ləʊkeıtər/
localizator universal de resurse.

Ce informaţii poţi găsi pe Internet

Pe Internet găseşti de toate pentru toţi! Internetul are miliarde
de pagini de web – şi în fiecare zi se adaugă alte sute de mii.

Şcolile se prezintă, lăudându-se cu profesorii şi elevii lor.
Universităţile publică listele facultăţilor, listează taxele ce sunt de
plătit şi oferă formulare de înscriere. Persoane particulare îşi „cot-
codăcesc“ realizările. Scriitori mai cunoscuţi sau mai puţin cunos-
cuţi îşi publică operele lor mai mult sau mai puţin nemuritoare.
Pictorii îşi deschid expoziţii virtuale. (Virtual, în acest context,
înseamnă plasat pe pagini de web, adică imposibil de atins cu
mâna, ne-material. Dintr-un muzeu virtual n-ai cum s-o furi pe
Mona Lisa!)

Firmele mai mari şi mai mici vând produse şi servicii, pe care
le poţi plăti automat, prin Internet (dacă ai o carte de credit sau
un card bancar). Acest fel de negustorie se numeşte comerţ
electronic (e-commerce /iː kɔməːrs/).

Liniile aeriene îţi vând bilete pentru toate destinaţiile posibile.
Multe Căi Ferate vând şi ele bilete prin Internet. Cinematografele,
teatrele, stadioanele – la fel.

Firmele de soft te invită „să descarci“ (adică să aduci pe
calculatorul tău) produsele lor. Unii îţi cer să plăteşti, alţii ţi le ofe-
ră gratuit. Poţi să mai descarci muzică, filme, jocuri electronice...
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Posturile de radio şi de televiziune îţi oferă emisiuni pe web.
Pe unele le asculţi sau le vezi în timp real, altele se deschid la cere-
rea ta expresă (clic pe diferite butoane din cuprinsul paginilor).

Pe web poţi să înveţi limbi străine, să foloseşti dicţionare, să
citeşti reviste şi ziare.

Poţi să publici poezii (vezi http://www.poetry.com/). Poţi să
vinzi texte de muzică uşoară compuse de tine.

...Un bazar universal în care lucruri foarte serioase şi
preţioase se amestecă cu lucruri triviale, uneori chiar dăunătoare.
Evită lucrurile dăunătoare cu orice preţ! Pornografia, violenţa,
înjurăturile, vânzările de arme sau de droguri – fugi de ele! Evită
siturile care îţi oferă programe soft, cântece sau filme furate de la
producători – aşa-zisele produse-pirat. Nu copia de pe web (prin
metoda Cut and Paste /kʌt ənd peıst/) compuneri gata făcute pentru
orele de engleză!

Link-uri

Paginile de web mai au proprietatea de a ne trimite de la una
la alta prin legături stabilite între ele. O legătură de acest fel se
numeşte hyperlink /haıpərlıŋk/ hiperlegătură sau, mai simplu, link
/lıŋk/. De exemplu, în pagina mea de lăudăroşenie pe web
http://www.geocities.com/melipoe/ găseşti link-urile către
paginile care îmi plac mie: Cisco Systems, Earth Science Picture
of the Day, NYFA şi Astronomy Picture of the Day.

Când ajungi cu indicatorul mouse-ului asupra unui link,
acesta se transformă într-o mânuţă. Dacă faci clic pe link (cum îţi
sună această rimă imperfectă?), pleci de pe pagina pe care eşti şi
ajungi pe pagina la care te trimite link-ul. De exemplu, apeşi pe
Astronomy Picture of the Day şi vezi o poză făcută pentru NASA de
R. Evans şi K. Stapelfeldt. Poza se numeşte „Asteroizi în
depărtare“. Mâine, pe acest sit va fi altă poză, la fel de frumoasă
sau poate şi mai frumoasă. În noua pagină, pe lângă fotografie,
sunt date şi numeroase link-uri. Urmează câteva dintre ele.

Această mutare din pagină în pagină se numeşte navigare sau
surfing. Paginile sunt asemuite cu valurile. Din val în val, te afunzi
tot mai mult în oceanul de informaţii al Internetului.

Dacă o pagină ţi-a plăcut mai mult, vezi că pe rândul de sub
bara de meniuri este un buton mărişor, pătrat, cu o săgeată spre
stânga, pe care scrie Back /bæk/ înapoi. Apasă pe el. De câte ori
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apeşi, tot atâtea pagini vezi – de data asta parcurse în ordinea
inversă. Apoi te reîntorci la alte pagini folosind Forward /fɔːrwərd/
înainte/ înaintează. Săgeata de pe butonul Forward /fɔːrwərd/ este
spre dreapta.

Dar, de unde iei o adresă de pagină de web (un URL), ca punct
de plecare pentru surfing – navigare? Reţine nişte URL-uri care te
duc la aşa-zisele motoare de căutare:

www.google.ro
www.lycos.com
www.metacrawler.com
www.yahoo.com
Dacă mergem la www.metacrawler.com, vedem că într-o

ferestruică putem scrie cuvântul sau cuvintele care au legătură cu
domeniul despre care vrem să ne informăm. Să scriem Ghelmez...
În dreapta acestei ferestruici se găseşte un buton, numit Search
/səːrʧ/ caută. Apăsăm pe el şi... în acest fel am pus motorul de că-
utare în mişcare. El parcurge milioane de pagini de web în câteva
clipe şi se întoarce cu o listă de documente în care a găsit cuvân-
tul. Lista reprezintă link-uri către paginile respective. Clic pe un
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În fiecare zi apare pe acest site o nouă fotografie din cosmos.
Aceasta a fost realizată de R. Evans şi K. Stapelfeldt şi s-a publicat pe Internet

la data de 17 aprilie 2005.
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Pagina unui „motor de căutare“. Dacă scriem unul sau mai multe cuvinte în
spaţiul de sub cuvintele Search the Web (caută în reţea) şi apăsăm pe butonul
Go Get It! (du-te şi adu), primim o listă de pagini web care cuprind cuvântul

sau cuvintele pe care le-am scris noi.

Începutul listei de pagini de web găsite de Metacrawler după numele Ghelmez.
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Am urmărit un link şi am ajuns la pagina de web realizată de poetul Cornel
Armeanu în memoria poetului Petre Ghelmez.

Alt link ne-a purtat spre o altă pagină închinată lui Petre Ghelmez.



link... şi ajungem la http://diligenta.com/petreghelmez/; clic
pe link-ul Intră şi apoi pe link-ul Cărţile copilăriei şi ajungem la
pagina http://diligenta.com/petreghelmez/page4.html, unde
putem citi unele povestiri pentru copii scrise de Petre Ghelmez.
Frumos, nu?

Link-urile sunt scrise de obicei cu albastru, iar după ce le
vizităm îşi schimbă culoarea, ca să ştim că am urmat deja acel
link.

Ce pasiune ai?

Colecţionezi timbre? Vrei să ştii mai multe despre filatelie?
Caută informaţii pe Internet, prin motoare de căutare, după cu-
vintele legate de pasiunea ta. Pe mine, cuvintele „filatelie, Roma-
nia“ mă ajută să găsesc pagina http://www.stamp-collecting-
4u.com/global-stamps-articles/filatelie.htm. Foarte interesan-
tă şi chiar frumoasă! Ce link-uri are ea?

Urmează-ţi pasiunile pe Internet!
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Filateliştii pot găsi şi studia această pagină de web.



Ce-i într-un nume?

Din ce se compune un URL? Să luăm un exemplu:
http://www.coresi.net. Primul „cuvânt“, HTTP, este numele pro-
tocolului prin care se transmit şi se recepţionează paginile de web.
El e despărţit de restul URL-ului prin două puncte urmate de
două linii oblice.

După linii vine formula magică www (dublu ve, dublu ve,
dublu ve; americanii prescurtează la dub-dub-dub /dʌb dʌb dʌb/, iar
românii prescurtează /ve-ve-ve/); parcă ar fi „sesam, deschide-te!“
Aceasta înseamnă world wide web /wəːrld waıd web/ reţeaua (de
documente) largă cât lumea întreagă. E un fel de a spune că docu-
mentul găsit la URL-ul respectiv aparţine categoriei de documente
numite „pagini de web“.

Ce urmează se numeşte numele domeniului. Acesta e despărţit
de www printr-un punct. El însuşi are două (sau mai multe)
cuvinte în compunere.

Ultimul cuvânt e de fapt o prescurtare şi se foloseşte mai ales
pentru a ajuta serverele DNS în munca lor. Prescurtarea aceasta
poate arăta în ce ţară se află pagina de web respectivă (.ro =
România, .uk = Marea Britanie, .it = Italia, .ca = Canada, .us =
Statele Unite ale Americii). Ea mai poate arăta din ce domeniu de
activitate este organizaţia care şi-a ales acel nume: .edu =
educaţie, .com = comercial, .biz = business, .net = Internet. De
obicei URL-urile care au în compoziţia lor prescurtările .edu,
.com, .biz, .net trimit la servere din Statele Unite.

Atenţie la viruşi!

Internetul nu e numai un ocean de informaţii şi poze fru-
moase, de muzică şi filme, de surse de învăţătură, ci şi o junglă în
care se dau bătălii crâncene între cei buni şi cei răi. Printre cei răi
se numără cei ce „pătrund“ în servere (se conectează la ele) şi le
strică, cei ce fură parole şi numere de card de pe Internet şi se dau
drept alţii pentru a fura bani sau cumpăra prin e-commerce
/iː kɔməːrs/ fără să plătească etc.
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Foarte, foarte răi sunt cei ce produc şi distribuie mici aplicaţii
numite „viruşi“ electronici. „Viruşii“ aceştia se autocopiază pe
calculatorul tău şi distrug sistemul de operare sau chiar discul
dur. De aceea, înainte de a te conecta la Internet, trebuie să cum-
peri şi să instalezi una din multele aplicaţii „antivirus“. Programul
antivirus vânează şi distruge viruşii, sau îi împiedică să se insta-
leze pe calculatorul tău. Nu virusa calculatorul! Apără-l cât poţi de
bine! E prietenul tău.

Tot cu programul antivirus poţi să te asiguri că dischetele sau
CD-urile pe care le aduci din altă parte nu poartă şi viruşi, luaţi
de la acele calculatoare. Lasă antivirusul să scaneze discheta sau
CD-ul înainte de a deschide sau copia vreun document!

Îţi place să navighezi pe Internet? Te cred că-ţi place. Peste un
miliard de persoane folosesc cu pasiune Internetul în fiecare zi. E
normal să vrei să-l foloseşti şi tu. Dar ia-ţi măsurile de siguranţă
necesare. Instalează un program antivirus!

Ce este poşta electronică

Odată conectaţi la Internet, putem folosi serviciul de poştă
electronică. Sunt două moduri de a-l folosi. Primul, cel obişnuit,
prin folosirea unui client de e-mail, cum are fi Microsoft Outlook
/maıkrəsɔft aʊtlʊk/, Outlook Express /aʊtlʊk ıkspres/, Eudora /juːdɔrə/ şi
altele.

Pentru a folosi o aplicaţie-client de e-mail, trebuie să avem o
adresă de e-mail cumpărată de la un ISP. Romtelecom prin
ClickNet /klıknet/ nu oferă adrese de e-mail. ISP-ul care ne dă o
adresă de e-mail ne deschide un cont de e-mail pe serverul său.
Contul e o părticică din discul dur al calculatorului pe care este
instalat serverul de e-mail. E ca o căsuţă poştală unde vin şi de
unde pleacă mesajele noastre de e-mail.

Mai putem avea un cont de e-mail deschis pe serverul şcolii.
Aceasta este situaţia ideală, pentru că e gratuit!

Să presupunem că
• avem un cont de e-mail deschis pe serverul şcolii;
• am reţinut adresa noastră de e-mail prin care folosim acel

cont; să presupunem că adresa ar fi bukur@matco.ro
• ştim ce nume de utilizator (username) şi ce parolă avem

(ni le spune profesorul care administrează serverul de e-mail al
şcolii); username: bukur; parola: ********.
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• suntem conectaţi la Internet prin Romtelecom (serviciul
ClickNet /klıknet/).

Cum accesăm contul nostru de e-mail pentru a aduce (des-
cărca) pe calculatorul nostru mesajele trimise de prieteni şi pentru
a le răspunde acelor prieteni?

Să folosim Outlook Express /aʊtlʊk ıkspres/.

Outlook Express

Vom deschide aplicaţia-client de e-mail Outlook Express
/aʊtlʊk ıkspres/:

Dublu clic pe iconiţa de pe desktop sau de pe bara de func-
ţiuni, sau

Start > Programs > Outlook Express.
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S-a deschis aplicaţia-client de e-mail Outlook Express.



Pentru exemplificare, voi folosi următoarele nume/date:
Bucur Poenaru, matco.ro, bukur.

Avem deci de introdus un cont nou (exemplul meu: bukur).
Alegem: Tools /tuːlz/ unelte > Accounts /əkaʊnts/ conturi.

Acum – clic pe Mail /meıl/ poştă (fiind un cont de e-mail).
Clic pe Add /æd/ adaugă > Mail.

Scriem numele nostru: Bucur Poenaru. Apoi clic pe Next
/nekst/ următorul (pas).

Scriem adresa de e-mail: bukur@matco.ro.
Adresa are trei părţi:
Numele de utilizator (username) bukur;
Simbolul @ (care poate fi citit a rond sau coadă de maimuţă

sau pur şi simplu la);
Numele de domeniu, care seamănă cu partea de sfârşit a unui

URL: matco.ro.
Apăsăm pe Next /nekst/ următorul (pas).
Aici scriem denumirile serverelor folosite pentru primirea şi

pentru trimiterea mesajelor; în cazul de faţă: mail.matco.ro în
ambele ferestruici.

Scriem numele noului cont: bukur; de asemenea parola:
********. Clic pe Remember Password /rımembər pɑːswəːrd/ aminteş-
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Apăsăm pe Add (adaugă) şi apoi pe Mail (poştă)
pentru a crea un nou cont de e-mail.



te-ţi parola, dacă nu vrem să introducem parola de fiecare dată
când ne conectăm la serverul de e-mail al şcolii. Apoi clic pe Next
/nekst/ următorul (pas).

Clic pe Finish /fınıʃ/ termină. Am creat noul cont.
Acum intrăm din nou pe contul bukur, pentru a-l verifica:
Clic pe Tools > Accounts. Vedem numele contului, care apare

ca mail.matco.ro.

Vrem să schimbăm acest nume în bukur.
Selectăm mail.matco.ro.
Clic pe Properties /prɔpətiz/ proprietăţi. Ştergem

mail.matco.ro şi scriem bukur.
În aceeaşi fereastră vedem că nu e scris nimic în dreptul

cuvintelor Reply Address /rıplaı ədres/ adresa de răspuns. Scriem
adresa (aceeaşi ca şi la E-mail address): bukur@matco.ro. Apă-
săm pe Apply /əplaı/ aplică.

Pe bara de meniuri a ferestrei căutăm Servers /səːrvərz/
servere. Totul pare OK.

Clic pe Connections /kənekʃnz/ conexiuni. Clic în dreptul cu-
vintelor Always connect to this account using /ɔːlweız kənekt tə ðıs
əkaʊnt juːzıŋ/ mereu conectează-te la acest cont folosind... Apăsăm pe
butonul cu săgeată şi selectăm conexiunea denumită Romtelecom,
pe care am creat-o mai devreme.
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Contul nou creat se numeşte mail.matco.ro.
Apăsăm pe Properties şi putem să urmăm indicaţiile, pentru a-i da un alt nume.



Apăsăm pe OK. Apoi pe Close /kləʊz/ închide.
Acum ne putem controla căsuţa poştală. Apăsăm pe

Send/Receive /send/rısiːv/ trimite/primeşte. O fereastră de dialog ne
spune că Outlook Express /aʊtlʊk ıkspres/ se conectează la serverul
mail.matco.ro, care presupunem că e serverul pe care şcoala ne-
a creat contul de e-mail.

Apăsăm pe Inbox (dacă nu e deja deschis, ca setare implicită).
Vedem mesajele primite. Unul dintre ele e selectat. Pe acela îl
putem citi. Apoi, cu mouse-ul sau cu tastele ↓ sau ↑ selectăm pe
rând fiecare mesaj şi îl citim. Vrem să răspundem unui mesaj?
Selectăm mesajul şi facem clic pe butonul Reply /rıplaı/ răspunde.
Dacă mesajul pe care l-am primit este în acelaşi timp trimis şi
altei persoane sau altor persoane şi vrem să afle toţi cei implicaţi
răspunsul nostru, facem clic pe butonul Reply All /rıplaı ɔːl/ răs-
punde-le tuturor. Se deschide o fereastră în care sunt deja scrise
adresa noastră, adresa celui căruia îi răspundem şi (dacă este
cazul) adresele celorlalte persoane care au primit mesajul original.
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Outlook Express caută să vadă dacă există mesaje noi
pe serverul mail.matco.ro.



De regulă, textul mesajului original se reproduce în spaţiul
unde vom scrie răspunsul nostru. Plasăm cursorul deasupra
textului şi scriem răspunsul. Apoi apăsăm pe butonul Send /send/
trimite. De rest – se ocupă Outlook Express /aʊtlʊk ıkspres/. El sta-
bileşte din nou legătura cu serverul de e-mail şi trimite răspunsul
nostru.

Dar dacă vrem să scriem unui cunoscut care nu ne-a scris el
întâi? Îi cerem adresa de e-mail. Apoi, clic pe Create mail /krieıt
meıl/ creează mesaj e-mail. De data aceasta, trebuie să introduci tu
adresa cunoscutului tău. Să zicem că-mi scrii mie, la adresa
melipoe@yahoo.com. (E adresa pe care o folosesc cel mai des.)
Îmi propui să introduc modificări la ediţia a doua a cărţii. Scrii
textul, apoi apeşi pe Send /send/ trimite. Iar eu voi primi mesajul
tău.

La Sent Items /sent aıtəmz/ articole trimise vei găsi còpii ale
mesajelor pe care le trimiţi tu.
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Când apăsăm pe Reply (răspunde), textul primit se reia în fereastra unde vom
scrie noi răspunsul. Vom scrie deasupra acestui text, iar când vom termina

mesajul, vom apăsa pe Send (trimite).



Mesajele care nu-ţi mai trebuie le poţi şterge. Le selectezi (pe
rând; sau pe toate deodată cu Ctrl + A) şi apeşi pe butonul Delete
/dıliːt/ elimină/şterge. Confirmi comanda – şi ele trec în folderul
Deleted Items /dıliːtıd aıtəmz/ articole şterse. Trebuie să intri în
acest folder şi să repeţi şi acolo operaţiunea ca să le ştergi de tot
(altminteri continuă să-ţi înghită spaţiul de pe discul dur).

Dacă ai primit un mesaj pe care vrei să-l trimiţi mai departe,
altei persoane sau altor persoane, în loc de a apăsa pe butonul
Reply /rıplaı/ răspunde, apeşi pe butonul Forward /fɔːrwərd/ dă mai
departe. Apoi scrii adresa celeilalte persoane – sau scrii mai multe
adrese, separate prin virgulă. Poţi să faci adnotări sau comentarii
pe marginea mesajului pe care îl trimiţi mai departe. Apoi apeşi pe
Send...

Când scrii un mesaj, observi că în partea de sus a ferestrei ai
mai multe rubrici de completat. Una este Subject /sʌbdʒıkt/
subiectul: acolo îi dai un titlu mesajului tău. Alta este rubrica CC
/siː siː/= carbon copy /kɑːrbən kɔpi/ copie la indigo. Acolo scrii adresa
unei persoane care nu e vizată direct de mesaj, dar care vrei tu să
fie martor al corespondenţei tale. Mai e şi rubrica BCC (dacă nu o
vezi pe fereastra de creare a unui nou mesaj, de răspuns sau de
retransmitere, selectează View > All Headers /ɔːl hedərz/ toate
rubricile). Aceasta înseamnă blind carbon copy /blaınd kɑːrbən kɔpi/
copie la indigo oarbă. Prin urmare, persoana a cărei adresă o pui
aici va primi o copie, dar adevăratul destinatar nu va vedea că şi
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În această fereastră scriem un mesaj nou.



acea persoană a primit mesajul. La ce foloseşte BCC? Singura
situaţie la care m-aş putea gândi ar fi necesitatea de a avea un
martor al corespondenţei mele cu o persoană incomodă sau
rău-intenţionată.

Outlook Express /aʊtlʊk ıkspres/ are şi un carneţel de adrese,
care poate fi foarte util... Scrii adresele de e-mail în carneţel şi le
extragi când ai nevoie de ele. Uneori vrei să anunţi schimbarea
telefonului tău mobil. Atunci trimiţi acelaşi mesaj la toate adresele
din carneţelul de adrese.

„Butonând“, mai descoperi încă multe altele despre Outlook
Express /aʊtlʊk ıkspres/. Curaj – şi succes!

Ce facem când nu avem un cont de e-mail?

Nu avem cont de e-mail, dar putem accesa Internetul (prin
Romtelecom, de exemplu). Atunci ne facem cont de e-mail pe o
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Presupusa scrisoare electronică (mesaj e-mail) a unui cititor
către autorul acestei cărţi.



pagină de web care oferă acest serviciu în mod gratuit. Cele mai
populare sunt

• http://www.yahoo.com/ şi
• http://www.hotmail.com/.
Fiecare are avantajele sale. Eu m-am obişnuit cu Yahoo!

/jəhuː/ sau /jɑː huː/.

Cum procedezi? Cu ajutorul browser-ului tău (de exemplu,
Internet Explorer /ıntərnet ıksplɔːrər/), ajungi pe una dintre aceste
pagini. Acolo primeşti instrucţiuni pas cu pas pentru realizarea
contului tău de e-mail.

Pe pagina Yahoo! /jəhuː/, găseşti cuvintele: free e-mail /friː
iːmeıl/ e-mail gratuit, iar lângă ele un link numit Sign Up /saın ʌp/
înregistrează-te. Clic pe Sign Up /saın ʌp/. Apoi clic pe Sign Up for
Yahoo! Mail /saın ʌp fər jəhuː meıl/ şi înregistrează-te pentru un cont
de e-mail pe Yahoo! /jəhuː/. Apare un formular. Completează acel
formular. Rubricile cu asterisc sunt obligatorii. Vei avea de sem-
nat un contract – clic pe I Agree /aı əgriː/ sunt de acord.

Îţi vei inventa un username şi o parolă... în final vei primi
acceptul şi adresa ta de e-mail.
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Pornind de aici, îţi poţi face, fără să plăteşti,
un cont de poştă electronică pe Yahoo!.



Ca să poţi folosi contul tău de e-mail de pe Yahoo! /jəhuː/, paşii
sunt următorii:

Mergi la www.yahoo.com.
Clic pe meniul Mail /meıl/. Vine o nouă pagină.
Scrii username-ul ales şi acceptat de Yahoo! /jəhuː/. Acesta

mai e numit şi Yahoo! ID /jəhuː aı diː/ = identitatea pentru Yahoo!
Scrii parola acceptată de Yahoo! /jəhuː/.
Apeşi pe Sign In /saın ın/ semnează să poţi intra.
Apeşi pe Inbox /ınbɔks/ căsuţa poştală.
Ca să poţi citi un mesaj, apeşi pe titlul său.
Apoi poţi să mergi la mesajele următoare cu butonul Next

/nekst/ următor sau la mesajele precedente cu butonul Previous
/priːvıəs/ precedent, de dinainte.

Ca să răspunzi, apeşi pe Reply /rıplaı/ răspunde. Ca să trimiţi
răspunsul la toate persoanele numite în capul mesajului, apeşi pe
săgeata din dreapta butonului Reply /rıplaı/ şi alegi Reply to
Everyone /rıplaı tu evriwʌn/ răspunde tuturor.

Ca să retransmiţi mesajul, apeşi pe Forward /fɔːrwərd/ înainte/
dă mai departe.

Ca să scrii un mesaj nou, apasă pe Compose /kəmpəʊz/
compune.

Poţi să creezi foldere în care să muţi mesajele, ca să ţi le
clasifici, să ţi le pui în ordine. Pentru aceasta, selectează mesajul
(sau mesajele ce se pot grupa laolaltă) de mutat şi apasă pe buto-
nul Move /muːv/ mută... Alege New Folder /njuː fəʊldər/ dosar nou.
Vei scrie numele folderului într-un formular micuţ – şi folderul se
va crea, preluând mesajul selectat. Folderul va apărea în coloana
din stânga (dacă nu apare, clic pe butonul Show /ʃəʊ/ arată, de
lângă My Folders /maı fəʊldərz/ folderele mele). Apropo: selectarea
mesajului se face printr-un clic pe pătrăţelul alb din faţa numelui
celui ce a expediat mesajul.

Ai şi aici un carneţel de adrese pe care poţi să-l foloseşti.
Succes!

Hotmail

Dacă preferi un cont de e-mail pe www.hotmail.com, e foarte
bine. Clic pe butonul Sign Up /saın ʌp/ de pe pagina lor:

http://login.passport.net/uilogin.srf?id=2/

170



Apoi urmează instrucţiunile. Se aseamănă cu cele de pe
Yahoo! /jəhuː/. Apoi „butonează“... şi trăieşte bucuria marilor
descoperiri geografice în spaţiul virtual.

Messenger

Atât Yahoo! /jəhuː/, cât şi Hotmail /hɔtmeil/ oferă câte o apli-
caţie numită Messenger /mesndʒər/. Cu Messenger /mesndʒər/ poţi
să „discuţi“ în timp real în scris – ba chiar şi prin viu grai – cu alţi
utilizatori ai acestor aplicaţii.

Pentru Yahoo! Messenger /jəhuː mesndʒər/, mergi la
www.yahoo.com şi fă clic pe Messenger /mesndʒər/ (aproape de
colţul din dreapta sus). Ţi se vor da instrucţiuni de descărcare a
programului şi de instalare a lui. Alege Open /əʊpn/, când vei fi
întrebat dacă vrei să deschizi sau să copiezi aplicaţia. În acest fel
instalarea va fi automată.

După instalare, probabil va trebui să restartezi calculatorul.
După restartare, pe bara de funcţiuni îţi va apărea iconiţa lui
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De aici porneşti să-ţi faci un cont gratuit de poştă electronică pe Hotmail.



Yahoo! Messenger /jəhuː mesndʒər/. Clic pe ea! Completezi cu ace-
laşi username şi aceeaşi parolă ca şi pentru contul tău de e-mail
pe Yahoo! /jəhuː/. Apoi apeşi pe butonul Sign In /saın ın/.

Ţi se va spune dacă ai mesaje noi (necitite) în contul tău de pe
Yahoo! /jəhuː/. Clic OK. Apoi alege Contacts > Add a Contact /æd
ə kɔntækt/ adaugă o persoană pe care o poţi contacta. Scrie adresa
de e-mail pe Yahoo! /jəhuː/ a unei cunoştinţe. Apoi Next /nekst/
următorul (pas). Yahoo! /jəhuː/ va trimite un mesaj acestei per-
soane, invitând-o să discute cu tine pe Yahoo! Messenger /jəhuː
mesndʒər/. Dacă persoana acceptă, atunci numele ei va apărea în
lista ta de contacte Messenger /mesndʒər/.
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În fereastra de dialog pentru conectare la Yahoo! Messenger introduci aceleaşi
informaţii de conectare ca şi pentru contul tău de e-mail de pe Yahoo!

Dacă ai mesaje noi în contul tău de e-mail de pe Yahoo!,
Yahoo! Messenger te avertizează.



Când vrei să vorbeşti cu cineva, apeşi pe numele de pe lista
ferestrei de Messenger /mesndʒər/. Se deschide o fereastră de
dialog. Jos ai un dreptunghi în care scrii prima replică. Apeşi pe
tasta Enter /entər/ intră/rând nou sau faci clic pe butonul Send
/send/ trimite. Mesajul tău va apărea în partea de sus a ferestrei de
dialog. Răspunsul va veni sub el. Apoi scrii din nou. Replicile tale
şi ale partenerului de discuţie se vor intercala şi va apărea un
dialog ca în piesele de teatru tipărite pe hârtie. Poţi să salvezi acest
dialog pe discul dur la sfârşit (sau oricând în timpul conversaţiei).
Poţi să copiezi anumite replici – numere de telefon, adrese etc. şi
să le inserezi în alte documente. Şi poţi să-ţi inviţi partenerul la o
discuţie telefonică transmisă tot prin Internet – cu ajutorul
aceluiaşi protocol IP. Dar parcă ce nu poţi să faci cu Messenger
/mesndʒər/! Poţi discuta în doi, în trei, în câte câţi vrei... vorba
marelui Arghezi.
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Fereastra prin care dialoghezi cu prietenul tău.
În fereastra de jos, unde apare cursorul, scrii replicile tale.

În fereastra mai mare se împletesc replicile tale cu ale celui cu care vorbeşti,
ca într-o piesă de teatru.



Hotmail Messenger

Messenger-ul oferit de Hotmail /hɔtmeil/ e la fel de ghiduş, dar
eu nu l-am folosit prea mult. Chestie de obişnuinţă. Curiozitatea
ta însă trebuie să te ducă şi la Hotmail Messenger. Cu cât încerci
mai multe aplicaţii, cu atât gradul tău de alfabetizare informatică
va creşte. Vei deveni, din novice, expert. Din ucenic, maestru.

Şi apoi vei trece la programare...

...şi promit să fiu alături de tine cu următoarea mea carte,
Programarea pentru toţi...

Până atunci, toate cele bune!
Nu lua vacanţă – nu acum. Ai voie, într-adevăr, să faci pauze

– pauze – pauze dese. (Dese, dar nu lungi.) Însă nu ai voie să
întrerupi munca la calculator o dată cu parcurgerea cărţii. Ia-o de
la capăt, repetă ce nu ai înţeles din prima. „Butonează“, „buto-
nează“... Ca să-ţi fixezi deprinderile nou create şi să-ţi lărgeşti
orizontul de cunoştinţe. Trebuie să atingi cursivitatea informatică
– treapta care vine după alfabetizarea informatică. Oare nu tot aşa
s-a întâmplat şi când ai învăţat să citeşti?
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